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Intended Audience
Welcome to Release 11i of the Oracle Financial Consolidation Hub User’s Guide.

See Related Information Sources on page xii for more Oracle Applications product
information.

TTY Access to Oracle Support Services

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services
within the United States of America 24 hours a day, seven days a week. For TTY
support, call 800.446.2398.

Documentation Accessibility

Our goal is to make Oracle products, services, and supporting documentation
accessible, with good usability, to the disabled community. To that end, our
documentation includes features that make information available to users of assistive
technology. This documentation is available in HTML format, and contains markup to
facilitate access by the disabled community. Accessibility standards will continue to
evolve over time, and Oracle is actively engaged with other market-leading technology
vendors to address technical obstacles so that our documentation can be accessible to all
of our customers. For more information, visit the Oracle Accessibility Program Web site
at http://www.oracle.com/accessibility/ .

Accessibility of Code Examples in Documentation

Screen readers may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an otherwise
empty line; however, some screen readers may not always read a line of text that
consists solely of a bracket or brace.
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Related Information Sources

xii

You can choose from many sources of information, including online documentation,
training, and support services, to increase your knowledge and understanding of
Financial Consolidation Hub. If this guide refers you to other Oracle Applications
documentation, use only the Release 11i versions of those guides.

Online Documentation
All Oracle Applications documentation is available online (HTML or PDF).
1. Online Help — Online help patches (HTML) are available on OracleMetaLink.

2. About Documents — Refer to the About Document for the mini—pack or family pack



that you have installed to learn about new documentation or documentation
patches that you can download. About Documents are available on OracleMetaLink.

User Guides Related to this Product

Oracle General Ledger User Guide: This guide contains the information you need
to implement and set up Oracle General Ledger. Also included in the guide is
descriptive information on the following areas: entering and posting journal entries,
creating budgets, performing inquiries, using reporting tools, using Global
Consolidation System to consolidate multiple companies, using multi-currency and
encumbrance accounting, using average balance processing features, using
standard reports and listings, and performing maintenance tasks.

Oracle Enterprise Performance Foundation User's Guide: This guide helps you
understand and use Oracle Enterprise Performance Foundation. It describes how to
use the dimension and hierarchy management features available through Oracle
Enterprise Performance Foundation and describes the tasks related to schema
administration in Oracle Enterprise Performance Foundation. Additionally, the x
guide introduces the Oracle Enterprise Performance Foundation interface
architecture and its use of external data loaders.

Oracle XML Publisher User's Guide: This guide instructs users on how to use
Oracle XML Publisher to create customized reports from the Oracle E-Business
Suite.

Oracle Web Applications Desktop Integrator User Guide: ADI is an integral part
of the Oracle General Ledger application. ADI is a spreadsheet-based extension of
General Ledger. and Oracle Assets, that offers full-cycle accounting within the
comfort and familiarity of a spreadsheet. This guide describes how to use
Applications Desktop Integrator's (ADI) Budget, Journal, Create Assets, Reconcile
Physical Inventory, Import Assets, and Report Wizards. You can use these
spreadsheet-based tools for entering journals, entering and revising budgets,
maintaining your asset inventory, and creating financial reports. The guide also
describes how to use the Request Center to submit and monitor concurrent
requests, then download the report output for publishing to a spreadsheet or a web

page.

Oracle Applications Flexfields Guide: This manual provides flexfields planning,
setup, and reference information for the General Ledger implementation team, as
well as for users responsible for the ongoing maintenance of Oracle Applications
product data. This manual also provides information on creating custom reports on
flexfields data.

User Guides Related to all Products

Oracle Applications User's Guide: This guide explains how to enter data, query,
run reports, and navigate using the graphical user interface (GUI) available with
this release of Financial Consolidation Hub (and any other Oracle Applications

xiii



xiv

products). This guide also includes information on setting user profiles, as well as
running and reviewing reports and concurrent processes. You can access this user's
guide online by choosing Getting Started with Oracle Applications from any Oracle
Applications help file.

Installation and System Administration

Oracle Applications Concepts: This guide provides an introduction to the concepts,
features, technology stack, architecture, and terminology for Oracle Applications
Release 11i. It provides a useful first book to read before installing Oracle
Applications. This guide also introduces the concepts behind Applications—wide
features such as Business Intelligence (BIS), languages and character sets, and Self-
Service Web Applications.

Installing Oracle Applications: This guide provides instructions for managing the
installation of Oracle Applications products. In Release 11i, much of the installation
process is handled using Oracle Rapid Install, which minimizes the time to install
Oracle Applications and the technology stack by automating many of the required
steps. This guide contains instructions for using Oracle Rapid Install and lists the
tasks you need to perform to finish your installation. You should use this guide in
conjunction with individual product users' guides and implementation guides.

Upgrading Oracle Applications: Refer to this guide if you are upgrading your
Oracle Applications Release 10.7 or Release 11.0 products to Release 11i. This guide
describes the upgrade process and lists database and product-specific upgrade xi
tasks. You must be either at Release 10.7 (NCA, SmartClient, or character mode) or
Release 11.0, to upgrade to Release 11i. You cannot upgrade to Release 11i directly
from releases prior to 10.7.

Maintaining Oracle Applications: Use this guide to help you run the various AD
utilities, such as AutoUpgrade, AutoPatch, AD Administration, AD Controller, AD
Relink, License Manager, and others. It contains how—to steps, screenshots, and
other information that you need to run the AD utilities. This guide also provides
information on maintaining the Oracle Applications file system and database.

Oracle Applications System Administrator's Guide: This guide provides planning
and reference information for the Oracle Applications System Administrator. It
contains information on how to define security, customize menus and online help,
and manage concurrent processing.

Oracle Alert User's Guide: This guide explains how to define periodic and event
alerts to monitor the status of your Oracle Applications data.

Oracle Applications Developer's Guide: This guide contains the coding standards
followed by the Oracle Applications development staff. It describes the Oracle
Application Object Library components needed to implement the Oracle
Applications user interface described in the Oracle Applications User Interface



Standards for Forms—Based Products. It also provides information to help you build
your custom Oracle Forms Developer 6i forms so that they integrate with Oracle
Applications.

Other Implementation Documentation

Oracle Workflow Administrator's Guide: This guide explains how to complete the
setup steps necessary for any Oracle Applications product that includes workflow—
enabled processes, as well as how to monitor the progress of runtime workflow
processes.

Oracle Workflow Developer's Guide: This guide explains how to define new
workflow business processes and customize existing Oracle Applications—
embedded workflow processes. It also describes how to define and customize
business events and event subscriptions.

Oracle Workflow User's Guide: This guide describes how Oracle Applications
users can view and respond to workflow notifications and monitor the progress of
their workflow processes.

Oracle Workflow API Reference: This guide describes the APIs provided for
developers and administrators to access Oracle Workflow.

Oracle eTechnical Reference Manuals: Each eTechnical Reference Manual (eTRM)
contains database diagrams and a detailed description of database tables, forms,
reports, and programs for a specific Oracle Applications product. This information
helps you convert data from your existing applications and integrate Oracle
Applications data with non—Oracle applications, and write custom reports for
Oracle Applications products. Oracle eTRM is available on OracleMetaLink.

Oracle Applications Message Reference Manual: This manual describes all Oracle
Applications messages. This manual is available in HTML format on the
documentation CD-ROM for Release 11i.

Do Not Use Database Tools to Modify Oracle Applications Data

Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data
Browser, database triggers, or any other tool to modify Oracle Applications data unless
otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and
maintain information in an Oracle database. But if you use Oracle tools such as

SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of your
data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using an
Oracle Applications form can update many tables at once. But when you modify Oracle
Applications data using anything other than Oracle Applications, you may change a
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row in one table without making corresponding changes in related tables. If your tables
get out of synchronization with each other, you risk retrieving erroneous information
and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications
automatically checks that your changes are valid. Oracle Applications also keeps track
of who changes information. If you enter information into database tables using
database tools, you may store invalid information. You also lose the ability to track who
has changed your information because SQL*Plus and other database tools do not keep a
record of changes.
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About Oracle Financial Consolidation Hub

Oracle Financial Consolidation Hub Overview

Oracle Financial Consolidation Hub brings together financial data from disparate
sources to create a single, global view of financial information across the entire
enterprise. By providing one consistent view of your enterprise's financial position
across complex organizational boundaries, it enables you to confidently comply with
financial reporting requirements, adapt to changing business conditions, and establish a
basis for ongoing, enterprise-wide performance management. Financial Consolidation
Hub is a key component of Oracle's Corporate Performance Management Suite, a
comprehensive solution for improving performance across all facets of your business.

Complies with Financial Reporting Requirements

Enterprises today are under constant pressure to speed the process of closing their
books, striving to comply with more stringent financial reporting requirements while
seeking faster access to critical business information. Compounding these pressures are
disparate financial systems; complex ownership structures; and multiple business units,
cost centers, or consolidation structures that make consolidating financial data a
manual, time consuming, and resource-intensive process. Financial Consolidation Hub
provides faster processing and deeper visibility into a single source of consolidated
results to significantly help with accelerated reporting, expanded disclosures, and
certified internal controls.

Adapts to Dynamic and Complex Business Conditions

After spending the last decade cutting costs and missing revenue targets, executive
offices worldwide are now pursuing a diversified and sustainable mix of top-line
growth initiatives. Strategies such as tapping into expanding markets or market
segments, moving into adjacent markets, or investing in completely new markets
require flexible, adaptable systems that can keep pace with a business environment
unprecedented in its rate of change. Financial Consolidation Hub is built to adapt to

About Oracle Financial Consolidation Hub  1-1



changing business requirements, offering an open architecture that rationalizes data
from disparate systems into a single, actionable source of truth.

Provides a Basis for Enterprise-Wide Performance Management

Today's financial organizations are being called upon to achieve both strategic and
operational excellence. After all, the best plans in the world are futile without effective
execution; likewise, effective execution is wasted if it's based on flawed strategy.
Achieving such corporate alignment requires a single, enterprise view of the firm's
financial position. Financial Consolidation Hub creates this view by integrating
multiple subsidiaries and investments from a variety of countries with disparate
accounting systems, ownership structures, charts of accounts, and currencies. By
providing accurate, timely, and enterprise-wide information, Financial Consolidation
Hub provides a foundation, upon which financial organizations can establish and
evaluate business strategies.

1-2 Oracle Financial Consolidation Hub User's Guide
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The Oracle Financial Consolidation Hub

Solution

Quick Reference

Data Submission

This chapter provides a quick reference to the common issues encountered in the
implementation of a consolidation system. It is a starting point where you can review
the issues, gain a high level understanding of how Financial Consolidation Hub handles
the issues, and find a reference to the section in this user's guide where you can obtain
further information. For ease of presentation the issues are organized in the following
tables into three categories: data submission, consolidation processing, and reporting
and analysis.

Issue

Functionality Reference

Use data from
Oracle General
Ledger.

Load data from
other systems.

Provides direct access to datain ~ ® Setting up Enterprise Performance Foundation,
Oracle General Ledger. page 5-1

See: Processing Keys, page 5-4

Submitting Data for Oracle Entities, page 14-6

Supports spreadsheet-based ° Spreadsheet Loader, page 14-11
uploads over the Web.

The Oracle Financial Consolidation Hub Solution 2-1



Issue

Functionality

Reference

Standardize data.

Enforce security.

Includes complete
transformation, validation, and
chart of accounts
standardization capabilities.

Ability to secure who is
authorized to load data.

Submitting Data, page 14-1
Submitting Data for External Entities, page 14-11
Transformation Rule Sets, page 14-10

Validation Rule Sets, page 14-10

Setting up Enterprise Performance Foundation,
page 5-1

Task 4: Value Sets, page 5-8

Task 8: Value Set Maps, page 5-12

Secure by Role, page 6-4
Specifying Security Options, page 13-4

Role-Based Security, page 21-1

Consolidation Processing

Issue

Functionality

Reference

Consolidate based
upon different
structures and
accounting methods.

Support
date-effective
structures.

Automatically track
changes.

Consolidation hierarchies model
different structures and methods.

Consolidation hierarchies are date
effective.

If Oracle General Ledger data
changes, consolidation informs the
user. Hierarchy changes display
impact on screen and in
notifications.

Setting Up Consolidation Methods, page 8-1

Consolidation Rule Steps, page 9-2

Updating Consolidation Hierarchies, page 13-7

Oracle Entities Example, page 14-8

Updating Consolidation Hierarchies, page 13-7

Process Status, page 15-2

2-2 Oracle Financial Consolidation Hub User's Guide



Issue Functionality Reference

Incremental Incremental consolidation ° Submitting Consolidations, page 15-4
consolidation processes areas impacted by

processing. changes.

Monitor Icons display up to the minute ®  Process Status, page 15-2

consolidation in real
time.

Compare and audit
results.

Allow adjustments.

Automate
intercompany
eliminations.

Automatically create

consolidation entries.

Perform currency
standardization.

Reconcile legal and
management results.

Lock results.

Enforce security.

Certify financial
statements.

status for all subsidiary and
consolidation points.

Store details for every
consolidation run and you can

audit this using drill-down reports.

Provides spreadsheet uploads for
consolidation and operating
adjustments.

Intercompany rules automate both
intercompany and intracompany
eliminations.

You can automatically create
entries using consolidation rules.

Automatically performed any time
an entity's currency differs from
that of its parent.

Creates both results as part of a
single consolidation.

Locks results against changes at
any level.

Provides ability to secure
consolidation processing and
results by hierarchy.

Certifies financial statements and
business processes.

Process History, page 15-4

Adjustments, page 16-5

Matching, page 10-1

Consolidation Rule Steps, page 9-2

Overview, page 12-1

Creating and Sharing Reports, page 19-11

Locking Results, page 15-4

Role-Based Security, page 21-1

Locking Results, page 15-4

Integrating with Internal Controls Manager,
page 22-1

The Oracle Financial Consolidation Hub Solution



Reporting and Analysis

Issue

Functionality

Reference

Distribute

consolidation results.

Allow ad-hoc
analysis and
drill-down.

Align budgets and
actuals.

Support
date-effective
reorganizations.

Enable time series
and variance
analysis.

Provide alerts.

Export to common
formats.

Security

Includes automatic distribution of
online reports containing
consolidation results.

Integrated multi-dimensional
reporting provides online
drill-down, select, rotate, and graph
capabilities.

Both sets of data reside in the same
database, use the same dimensions,
and you can view in the same
report.

Easily edit and view multiple
organization hierarchies in the
same data model.

Administrators or end users can
define and save formulas for use in
reports.

Notifications can be sent based
upon performance triggers.

Reports can be exported to Excel,
HTML, XML, and Oracle reports
formats.

Detailed security settings can be
applied to each reporting user.

Defining a Notify Task, Oracle Enterprise
Planning and Budgeting User’s Guide

Working with Crosstabs, Oracle Enterprise
Planning and Budgeting User’s Guide

Task 1: Processing Keys, page 5-4
Creating and Sharing Reports, page 19-11

About Business Process Administration, Oracle
Enterprise Planning and Budgeting User’s Guide

Dimension Hierarchies, page 5-11

Working with Calculations, Oracle Enterprise
Planning and Budgeting User’s Guide

Defining an Exception Alert Task, Oracle
Enterprise Planning and Budgeting User’s Guide

Exporting Data from Crosstabs, Oracle
Enterprise Planning and Budgeting User’s Guide

Administering Security, Oracle Enterprise
Planning and Budgeting User’s Guide
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Setting Up Oracle Financial Consolidation

Oracle Financial Consolidation Hub Setup Overview

Hub

The following table shows the Oracle Financial Consolidation Hub setup checklist.

Complete all required steps in the sequence indicated.

Financial Consolidation Hub Setup Checklist

Step Number Setup Step Step Type Description

Oracle Applications

System

Administrator or

Oracle User

Management

1. Set Up Roles, page Required Used for notifications
21-1 and security

Oracle Financial

Consolidation Hub

2. Set Up Enterprise Required Used to define
Performance dimensionality and
Foundation, page 5- reference data
1

3. Set Up Entities, page  Required Used to hold general
6-1 ledger data
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Step Number Setup Step Step Type Description
4. Set Up Categories, Optional Used to designate
page 7-1 business processes
within consolidation
5. Set Up Consolidation = Optional Used to group
Methods, page 8-1 consolidation rules
together
6. Set Up Consolidation = Optional Used to automate
Rules, page 9-1 consolidation entries
7. Set Up Intercompany Optional Used for
Rules, page 10-1 intercompany and
intracompany
eliminations
8. Set Up Calendar Optional Used to designate the
Maps, page 11-1 consolidation
calendar and
standardize other
calendars
9. Set Up Translation, Optional Used to translate or
page 12-1 remeasure data to a
parent's currency.
Skip this step if are
implementing a single
currency.
10. Set Up Consolidation Required Used to organize

Hierarchies, page 13-
1

entities for
consolidation
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Overview

Setting Up Users

To implement Oracle Financial Consolidation Hub, define users and assign them

responsibilities. Each responsibility offers access to a different functionality in different
products. This chapter lists the common responsibilities required to implement

Financial Consolidation Hub.

For details on the security surrounding users and responsibilities, see Security, page 21-

1.

To implement Financial Consolidation Hub, you may require access to the following
products or functionality as listed in the following table.

Responsibility

Product

Functionality

Consolidation Manager

Legal Entity Controller

Enterprise Performance
Foundation Administrator

Financial Consolidation Hub

Financial Consolidation Hub

Enterprise Performance
Foundation

Set up Financial
Consolidation Hub, perform
data submissions, and run
consolidation

Perform data submissions

Manage meta-data and ledger
setup in the Enterprise
Performance Foundation
architecture, and integration
with Oracle General Ledger
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Responsibility

Product

Functionality

Enterprise Planning and
Budgeting Controller

Enterprise Planning and
Budgeting Security
Administrator

System Administrator

XML Publisher Administrator

General Ledger Super User

Enterprise Planning and
Budgeting

Enterprise Planning and
Budgeting

XML Publisher

Oracle General Ledger

Pull consolidation data into
Enterprise Planning and
Budgeting and create
analytical reports

Set security settings to give
your user access to Enterprise
Planning and Budgeting
components

Manage system configuration
such as profile options, users
and responsibilities

Create new report templates

Super User access to Oracle
General Ledger (only
necessary if you are
consolidating operating
balances in Oracle General
Ledger)

Note: This is only a list of the typical responsibilities needed to
implement Financial Consolidation Hub. It does not take into account
any security considerations that you may have. Use your security
model to determine which users will have access to which
responsibilities. For responsibilities outside of Financial Consolidation
Hub, please refer to the corresponding user guides to determine a

complete list of available responsibilities and security considerations.
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Setting Up Oracle Enterprise Performance

Overview

Foundation

Oracle's Corporate Performance Management applications, including Financial
Consolidation Hub, share a common data model called Oracle Enterprise Performance
Foundation. Enterprise Performance Foundation provides a storage area for managing
reference data that contains dimensions, dimension members, hierarchies, and business
data. Financial Consolidation Hub, Enterprise Planning and Budgeting, and
Profitability Manager use this reference data. Oracle General Ledger users can transfer
their reference and financial data into Enterprise Performance Foundation. Other
customers can load reference and transactional data from third party systems using
spreadsheet loaders and open interfaces.

EPF comes with a set of pre-defined fact tables; a table called FEM_BALANCES
(Balances table) that is used to store financial balances loaded from Oracle General
Ledger or any other financial system, and 20 tables called FEM_DATALI to
FEM_DATAZ20 to be used for other purposes. Financial Consolidation Hub uses the
Balances table in two key ways:

® Reads from the table to access the financial data from an enterprise's subsidiaries.
®  Writes consolidated results back to the table.

This provides you with a single data source when you perform any financial or
management reporting.

Each fact table includes a number of dimension columns. These dimensions are used to
model your business and are analogous to the segments of an Oracle General Ledger
chart of accounts. Since Oracle's analytical applications share a common data model,
some of these dimensions may be relevant to Financial Consolidation Hub while others
may not.
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Required Dimensions for Financial Consolidation Hub

1.

Entity - Used to represent the legal entities or business units that you want to
consolidate.

See: Setting Up Entities, page 6-1

Company Cost Center Organization - The main organizational dimension by which
you record accounting data. Company cost center organizations are subsets of
entities.

Intercompany - Used to identify and eliminate intercompany activity. It shares the
same values as the company cost center organization dimension. Financial

Consolidation Hub uses the intercompany dimension, together with the company
cost center organization dimension, to identify balances that should be eliminated.

Line Item - Used to categorize the type of financial balance. Oracle General Ledger
users specify a natural account segment in their chart of accounts. The line item
dimension is analogous to this segment. Most consolidation eliminations, such as
intercompany and minority interest, are based on this dimension and most financial
reporting is also based on this dimension.

Calendar Period - Based on the accounting calendar for your organization.

Currency - Identifies the currency for each balance. Each entity typically has one
base currency and the financial data loaded for that entity is denominated in that
currency. If an entity is consolidated to a higher-level entity with a different
currency, Financial Consolidation Hub automatically translates from one currency
to the other.

Optional Dimensions for Financial Consolidation Hub

1.

Channel - Used to identify the channel associated with a financial balance.
Customer - Used to identify the customer associated with a financial balance.

Financial Element - Used to identify the type of financial balance such as ending
balance, average balance, and statistical balance. It is widely used in the financial
services industry and in Oracle Financial Services Applications that share the
Enterprise Performance Foundation data model. If you consolidate average
balances, or statistics, or both, you must enable this dimension. These types of
balances are identified by the financial element.

Natural Account - This is similar to the line item dimension. It is available in
addition to line item because you may need to track two different types of natural
account. For example, one for legal reporting and one for management, or one for
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local GAAP and one for corporate GAAP. This dimension can be used in
conjunction with line item for these purposes.

Product - Used to identify the product associated with a financial balance.
Project - Used to identify the project associated with a financial balance.

User Dimension 1 to 10 - These dimensions can be enabled for any purposes not
addressed by the above mentioned dimensions.

Dimensions Used Internally by Financial Consolidation Hub

1.

Created by Object - Used to identify the category in the consolidation process that
produced a given consolidated balance. Examples of categories include
intercompany, minority interest, and aggregation. You can use the object dimension
to view this granularity during reporting, but for consolidation processing, the
object dimension is handled internally.

See: Setting Up Categories, page 7-1.

Currency Type - Used to distinguish financial data that is entered in a specific
currency from balances that are translated to a specific currency.

Data Set - Used to group different types of data. Financial Consolidation Hub
automatically creates a data set for each hierarchy and balance type.

Ledger - Used to identify the set of books or ledger from which a financial balance
was loaded.

Dimensions not Used by Financial Consolidation Hub

Tasks

1.

2.

1.

Financial Consolidation Hub does not support the following dimensions. Do not enable
them for Financial Consolidation Hub processing.

Activity

Cost Object

Before proceeding with consolidation-specific setup steps, you must complete all
required tasks outlined on the Foundation page. These tasks perform the following two
functions.

Provides a streamlined setup of Enterprise Performance Foundation for Financial
Consolidation Hub purposes. You can perform the same setup from the Enterprise
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Performance Foundation user interface; however, the Foundation tasks hide much
of the complexity that is not relevant for using Financial Consolidation Hub.

2. Provides some initial configuration for Financial Consolidation Hub.

Note: Some tasks may not be necessary depending on your specific
implementation of Financial Consolidation Hub. In such cases, update
the status of the task to Complete.

Initial Setup Tasks for Enterprise Performance Foundation

Perform the following initial steps before you perform the task in Foundation. The
following steps are recommended for the implementation of Financial Consolidation
Hub. Select the Enterprise Performance Foundation Administrator responsibility:

1. Set signage to Standard GAAP. Using the System Administrator responsibility,
navigate to Profile > System. Set the FEM: Signage profile option to Standard
General Accounting Principles. Using the EPF Administrator responsibility,
navigate to Processes Management > Requests > Submit Request. Run the Sign
Extended Account Types concurrent program .

2. Set negative format to using a negative sign. Using the System Administrator
responsibility, navigate to Profile > System. Set the Currency:Negative Format
profile option to —-XXX. FCH reports will now represent negative numbers using the
negative sign. If any other options are selected, negative numbers in the Excel
reports in Financial Consolidation Hub will not properly be read as numbers.

3. Grant the Enterprise Performance Foundation access to your users. Using the
Enterprise Performance Foundation Administrator responsibility, navigate to
Administration > Security. Grant read/write access to the Default and Data
Integration folders to your users.

Task 1: Processing Keys

Task 1 must be the first thing you do in Financial Consolidation Hub. For Task 1,
identify the dimensions that you will use.

Note: If you are using other Oracle products that sit on top of
Enterprise Performance Foundation, you must consider all of the
dimensions that must be enabled for Enterprise Performance
Foundation for all the products.
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Column

Select the dimensions that you want to set as active in Enterprise Performance
Foundation. These dimensions will be the superset of the dimensions used by Financial
Consolidation Hub and any other Oracle products that you use on top of Enterprise
Performance Foundation. For Financial Consolidation Hub purposes, this will be the set
of dimensions that are used for loading source data.

See: Required Dimensions for Financial Consolidation Hub, page 5-2.

To set a dimension active in Enterprise Performance Foundation, add the dimension to
the table of active dimensions.

Used By Processing

From the active set of dimensions, you must then specify those to be used for
consolidation processing. It is possible that you may load financial data by a dimension
that you are not interested in for consolidation purposes. For example, your general
ledger data may contain product-level information, and it may be used in other
Enterprise Performance Foundation applications. However, including product-specific
information in your consolidation process may be unnecessary. In this case, Financial
Consolidation Hub aggregates across all values of this dimension during processing. To
set a dimension active for consolidation processing, select the Used by Processing
column for the dimension.

Used By Analytical Reporting

From the set of processing dimensions, you must then specify those to be used for
analytical reporting. Again, it is possible that you may consolidate by a dimension, but
not need to report against it. By disabling a dimension for reporting, you can reduce the
size of the analytical workspaces and make reports easier to understand. To set a
dimension active for analytical reporting, select the Used by Analytical Reporting
column for the dimension.

See: Setting Up Analytical Reports, page 19-1.

Note: The Used by Analytical Reporting does not affect the
dimensionality of the static reports in Financial Consolidation Hub.
These reports will use the selected dimensions in Enterprise
Performance Foundation or Used by Processing where appropriate.

See: Viewing Reports, page 18-1

Caution: Before completing Task 1, review your dimension column
selections. After creating entities and performing data submission, you
cannot change these selections.
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Used By Historical Rates

You can define the dimensions that should be used in the historical rates definition. The
dimensions you can choose are a subset of those you selected for Used by Processing.
The dimensionality for Historical rates is specified in the Used by Historical Rates
column. This column cannot be updated if Historical Rates already exist in the system.

See: Historical Rates, page 12-4

Task 2: FEM Balances Index

Task 2 must be the second step you do in Financial Consolidation Hub after completing
Task 1. For Task 2, System Administrators must manually create a unique index on the
Balances table and Financial Consolidation Hub interface table. You must recreate
FEM_BALANCES_P and create a unique index for FEM_BAL_INTERFACE_T that
contains all the dimension columns selected in Task 1. To see details on the SQL script
needed to recreate FEM_BALANCES_P based on your selected dimensions, click
Preview Index Definition. The preview provides the recommended ordering of columns
for optimal performance for Financial Consolidation Hub. Your database administrator
may further refine the index definition if other applications are being leveraged.

See: Oracle Enterprise Performance Foundation User Guide

Task 3: Data Types

Task 3 must be the third step you do in Financial Consolidation Hub after completing
Task 2. For Task 2, you will be specifying the dataset to use for Actual and Average
balances, as well as optionally defining other balance types.

For Task 3, you can do the following:

* Create any additional data types that you need such as budgets.
* View or update any existing data types.
For a given entity or consolidation hierarchy, you can perform data submission and

consolidation for each data type.

For each data type that you create, you must specify a data set. You can create and
manage data sets using the Enterprise Performance Foundation Administrator
responsibility, Configuration Rules > Dimension.

The Actual and Average balance types are seeded in Financial Consolidation Hub, and
require you to specify an Actual data set. The following table shows the attributes
required for actual data sets.
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Data Sets Attributes

Dataset Balance Type Code Actual

Dataset Update Flag Yes

Dataset Production Flag Yes

Dataset System Code <User specified>

Note: You can not create additional Actual balance types. You may
only use the seeded ones.

The following table shows attributes required for Encumbrance data sets.

Data Sets Attributes
Dataset Balance Type Code Encumbrance
Dataset Encumbrance Type ID <User specified>
Dataset Update Flag Yes

Dataset Production Flag Yes

Dataset System Code <User specified>

Note: You can only create one data type per Dataset Encumbrance Type
ID.

Budget data sets require the following attributes:

Data Sets Attributes
Dataset Balance Type Code Budget
Dataset Budget Type ID <User specified>
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Data Sets Attributes

Dataset Update Flag Yes
Dataset Production Flag Yes
Dataset System Code <User specified>

Note: You can only create one data type per Dataset Budget Type ID.

Note: You cannot create additional data types for Actual balances.

Additionally, set the following three parameters for data types:

¢ Enforce Balancing - When you perform consolidation on this data type, the
application uses suspense handling to enforce balancing.

¢ Apply Elimination Rules - When you perform consolidation on this data type, the
application performs intercompany eliminations.

e Apply Consolidation Rules - When you perform consolidation on this data type, the
application applies consolidation rules.

Task 4: Value Sets

Task 4 is only necessary if you need to define additional value sets in Enterprise
Performance Foundation. For Task 4, you can do the following:

* Create value sets for dimensions
e Search for and view any existing value sets

A value set is a list of dimension members that belong to a particular dimension. Value
Sets are used to separate dimension members into meaningful sets. For example, a
company may perform accounting according to local and corporate standards. It can
create a value set for each, such that natural account 1110 may correspond to Cash in
the local value set, whereas it corresponds to Accounts Receivable in the corporate
value set.

Financial Consolidation Hub offers a default value set for each dimension. Additionally,
if you use Oracle General Ledger, all the value sets associated with your chart of
accounts structures will automatically be synchronized with Enterprise Performance
Foundation. Therefore, you only need to create additional value sets in Enterprise
Performance Foundation if you are loading data from third party financial systems that

5-8 Oracle Financial Consolidation Hub User's Guide



use different sets of values. If all financial data brought in through external systems is
based on a single chart of accounts, or is transferred from Oracle General Ledger, you
can omit this step.

To transfer data from Oracle General Ledger to Enterprise Performance Foundation, see
Using Oracle General Ledger with Enterprise Performance Foundation, page 5-17.

Task 5: Consolidation Global Value Set Combination

Perform Task 5 before creating any setup elements in Financial Consolidation Hub such
as entities and consolidation hierarchies. For Task 5, select a single global value set
combination for the system to use for consolidated results that represents your
corporate account structure. The global value set combination in Enterprise
Performance Foundation is analogous to a chart of accounts. This determines the value
set used for consolidation for each dimension. Any data that is loaded from external
systems using different value sets must be mapped to the global value set combination.
Financial Consolidation Hub automatically maps this in the Data Preparation step of
the Consolidation process based on mappings defined by the user in Task 8: Value Set
Maps.

You can select the seeded default global value set combination or you can create a
global value set combination if needed. Once you click Complete, Financial
Consolidation Hub will launch the FCH: Module Initialization concurrent program.
Monitor this concurrent program and verify that it completes successfully.

You can create a global value set combination in Enterprise Performance Foundation
using the Enterprise Performance Foundation Administrator responsibility,
Administration > Registration > Global Value Set Combination.

Note: The Consolidation Global Value Set Combination must have the
entity dimension set to the default value set, Entity .

If you are using Oracle General Ledger, a global value set combination is automatically
created for each chart of accounts that you transfer to Enterprise Performance
Foundation.

To transfer data from Oracle General Ledger to Enterprise Performance Foundation, see
Using Oracle General Ledger with Enterprise Performance Foundation, page 5-17.

Caution: Before completing Task 5, review your selection. After
creating consolidation hierarchies and entities, you cannot change your
global value set combination selection.

Task 6: Dimension Members

Task 6 is only necessary if are creating additional dimension members. For Task 6, you
can do the following:
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* Add dimension members to dimensions
e Search for, view, and update any existing members

A dimension is a classification scheme used to categorize or group business data. For
example, data can be grouped by the line item, product, geographical area, customer,
natural account, and time. A dimension contains dimension members. For example, the
Line Item dimension might have dimension members of Total Assets and Fixed Assets.

If you use Oracle General Ledger, then the segment values for the relevant charts of
accounts are automatically synchronized with Enterprise Performance Foundation as
dimension members. For more information on transferring segment values from Oracle
General Ledger, see Using Oracle General Ledger with Enterprise Performance
Foundation, page 5-17. If you do not use Oracle General Ledger, or if you need
additional dimension members for analytical or consolidation purposes, you can create
them using WebADI spreadsheet loaders. In addition, you can update existing
dimension members through the spreadsheet loaders.

See: WebADI Spreadsheets, page A-1

The spreadsheet loaders include columns for display code, name, description, and value
set. If you are working with the following dimensions, the spreadsheet loaders include
additional columns:

* Line Item - An additional column is available to select the account type
e Natural Account - An additional column is available to select the account type

* Company Cost Center Organization - Additional columns are available to enter the
company and cost center associated with each organization. Company is required
but cost center is optional.

This task cannot be used for the following situations:

* Creating, viewing, and updating members for the entity dimension. Entities are
handled through a separate Entity user interface.

See: Setting Up Entities, page 6-1

* Updating or creating members pulled through the Oracle General Ledger
integration. If a dimension member was created through the Oracle General Ledger
integration, do not update it. Also do not create new dimension members for a
value set that was created through Oracle General Ledger integration. Instead,
create the new values in Oracle General Ledger and rerun Oracle General Ledger
integration.

See: Using Oracle General Ledger with Oracle Enterprise Performance Foundation,
page 5-17

Some attributes for dimension members do not appear in the spreadsheet loader.
Financial Consolidation Hub automatically populates these attributes . To view the full
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list of attributes for a dimension member, use the Enterprise Performance Foundation
Administrator responsibility, navigate to Configuration Rules > Dimension > Members.
Here, you can use the Enterprise Performance Foundation user interface to view,
update, and create dimension members. You can also use the WebADI spreadsheet
loader.

Note: The Enterprise Performance Foundation user interface will access
dimension members from the ledger specified in Application
Preference, set the Ledger to the ledger you want to view. See: Initial
Setup in Enterprise Performance Foundation, page 5-4 .

Note: Although the Financial Consolidation Hub user interface does
not allow you to disable dimension members, Financial Consolidation
Hub enforces disabling for any dimension members you disable in
Enterprise Performance Foundation. For example, you cannot run data
submission on a calendar period that is disabled in Enterprise
Performance Foundation.

Task 7: Dimension Hierarchies

Task 7 is only necessary if you need to create additional dimension hierarchies. For Task
7, you can do the following;:

® Create dimension hierarchies for processing and reporting
® Search and view, and search and update any existing dimension hierarchies

A dimension hierarchy is a structure of dimension members that is organized by
parent/child relationships. Dimension hierarchies can have multiple versions, all of
which have an effective date range.

If you are using Oracle General Ledger, then the segment value hierarchies for the
relevant charts of accounts are automatically synchronized with Enterprise Performance
Foundation as dimension hierarchies.

For information on transferring dimension hierarchies from Oracle General Ledger to
Enterprise Performance Foundation, see Using Oracle General Ledger with Enterprise
Performance Foundation, page 5-17.

If you do not use Oracle General Ledger or if you need additional hierarchies for
analytical or consolidation purposes, you can create them using WebADI spreadsheet
loaders. You can also use the spreadsheet loaders to update any existing hierarchies.
The spreadsheet loaders enable you to enter hierarchies as an unlimited number of
parent-child pairs. You can version hierarchies, for example, to take reorganizations
into account. When you run consolidation, Financial Consolidation Hub uses the
appropriate version based on the effective date for which you are consolidating.
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See: WebADI spreadsheets, page A-1

Note: In the spreadsheet loader, you must enter top parents in a row
with its value entered for the Parent and Child columns.

Note: Creating consolidation hierarchies for the Entity dimension is
done through a separate Consolidation Hierarchy user interface.

See: Setting Up Consolidation Hierarchies, page 13-2

Task 8: Value Set Maps

Task 8 is only necessary if you have multiple chart of accounts and need to create value
set maps. For Task 8, you can do the following:

® Create value set maps
¢ Update the current value set map for a dimension

A value set map specifies the relationship between dimension members in child value
sets to dimension members in the consolidation value set. Each dimension can have
only one value set map, but each value set map can have multiple date effective
versions. You create Value set maps so the system can convert data in multiple value
sets to the single global value set combination you selected in Task 5.

Standardizing on a single chart of accounts is one of the challenges you encounter when
you load data from subsidiaries running different accounting systems in different
regions of the world. Financial Consolidation Hub enables you to standardize on a chart
of accounts using value set mapping capabilities.

Value set maps enable Financial Consolidation Hub to automate the standardization of
data from multiple charts of accounts to a single consolidated chart of accounts. If your
organization uses a single global chart of accounts, you have one value set per
Enterprise Performance Foundation dimension and you do not need to create value set
maps. However, if you have multiple charts of accounts and consequently have
multiple Enterprise Performance Foundation dimension value sets, you must create
value set maps for each dimension that contains more than one Enterprise Performance
Foundation value set.

To create a value set map, use a WebADI spreadsheet loader to map the child display
code values to the values in the consolidation value set. You can also use the
spreadsheet loader to update existing value set maps. Mappings can only be within the
same dimension; you cannot map a value in one dimension to a value in another.
Therefore, you can only map values from a subsidiary's natural account dimension to
the parent's natural account dimension. You cannot map the subsidiary's natural
account dimension to the parent's line item dimension.

See: WebADI spreadsheets, page A-1
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During the Data Preparation step of the consolidation process, Financial Consolidation
Hub maps the source values into the specified parent values.

You can version value set mappings, for example to take reorganizations into account.
When you run consolidation, Financial Consolidation Hub applies the appropriate
version based on the effective date for which you are consolidating.

When you create a value set map, it creates a multi-value set dimension hierarchy in
Enterprise Performance Foundation. The dimension members in the consolidation
value set are the parents in the hierarchy and the members in the local value sets are
children under the member they map to.

Task 9: Line Item Intercompany Maps

Task 9 is only necessary if your source systems record intercompany transactions using
Line Item or Account dimensions. For Task 9, you can do the following:

® Create Line Item Intercompany Maps
¢ Update existing Line Item Intercompany Maps

You use these maps where you track some of your intercompany balances according to
particular line item values. A Line Item Intercompany Map specifies the relationship
between a line item value and an intercompany value in the consolidation chart of
accounts. You can map each line item value to an intercompany value or no value at all.

When you run consolidation, the application applies these mappings. During the Data
Preparation step of consolidation, if Financial Consolidation Hub finds any line items
for which there are line item intercompany maps, it will use the maps to repopulate the
intercompany value.

For example, a company can use the following line items to specify intercompany
transactions.

Account Intercompany Partner
I/C Accounts Payable None

I/C Accounts Payable - Canada Canada

I/C Accounts Payable - Mexico Mexico

You can define the following intercompany maps.
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Line Item Dimension Intercompany

I/C Accounts Payable - Canada Canada

I/C Accounts Payable - Mexico Mexico

And the company has the following balances.

Company Line Item Intercompany Balance
Canada I/C Accounts Payable None 100
Canada I/C Accounts Payable None 200

- Canada
Canada I/C Accounts Payable None 300

- Mexico
Canada Cash None -600

When you run consolidation, the process will identify any matches for the line item
intercompany maps. It will then change the Intercompany value based on the maps.

Company Line Item Intercompany Balance
Canada I/C Accounts Payable None 100
Canada I/C Accounts Payable Canada 200

- Canada
Canada I/C Accounts Payable Mexico 300

- Mexico
Canada Cash None -600

You can create or update Line Item Intercompany Maps one at a time through the user
interface, or more than one at a time through a WebADI spreadsheet loader.

See: WebADI Spreadsheets, page A-1
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Task 10: Data Transformation and Validation

Task 10 is only necessary if you perform transformation or validation on your data
submissions and need to register additional tables and functions for the transformation
and validation rules. For Task 10, you can register any tables or functions you want to
use in Transformation Rule Sets and Validation Rule Sets. You can use these rules sets
to perform automated transformation and validation of balances during data
submission. You can register interface tables, lookup tables, and PL/SQL functions.

See: Transformation Rule Sets, page 14-10

See: Validation Rules Sets, page 14-10

Task 11: XML Publisher Templates

Task 11 is only necessary if you are changing the formats of the static reports you see in
Financial Consolidation Hub, or if those reports are very large.

For Task 11, set a maximum file size for synchronous publishing for the Consolidation
Trial Balance and Data Submission Trial Balance reports. If the report's file size is larger
than the designated maximum size, Financial Consolidation Hub launches the FCH:
Publishing Utility concurrent request to produce the report. You can then view the
output of the request to see the report. This prevents the Financial Consolidation Hub
user interface from timing out when the application production produces a large report.

You can also specify the XML Publisher templates you want to use for formatting
reports. Financial Consolidation Hub uses XML Publisher for ad-hoc reporting. XML
Publisher enables you to change the formatting of your reports by modifying them
using common desktop applications like Microsoft Word. For detailed information on
using XML Publisher, see Creating an RTF Template in the Oracle XML Publisher User's
Guide.

Financial Consolidation Hub provides the following report templates.
¢ A&D Trial Balance Template - To view the trial balance loaded for acquisition or

disposal purposes.

e Consolidation Entries Template - To view manual adjustments, consolidation
entries, and notifications.

¢ Consolidation Trial Balance Template - To view detailed consolidation worksheet
reports.

¢ Data Submission Data Loaded Template - To view each data loaded by each
submission.

¢ Data Submission Impacted Balances Template - To view balances in Enterprise

Performance Foundation that are impacted by new balances in Oracle General
Ledger.
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® Data Submission Trial Balance Template - To view the current data in Enterprise
Performance Foundation for an entity. This may differ from the Data Submission
Load Data Template because it represents the cumulative effect of all data
submissions for a given entity in a given period.

¢ Hierarchy Listing Template - To view a consolidation hierarchy.

* Intercompany Matching Template - To view intercompany balances eliminated
during a consolidation run.

¢ Value Set Map Validation Template: To view the values mapped in an entity's local
chart of accounts to the consolidation chart of accounts.

*  Write back to General Ledger Template: To view the balances of an adjustment
written back to Oracle General Ledger.

Note: You can use the default report templates as a baseline to create
reports with customized formatting, but you cannot modify the default
report templates.

See: Viewing Reports, page 18-1

Task 12: Setting Up Analytical Reporting

You must complete Task 12 before using analytical reporting. Task 12 enables you to
use and view your consolidated results in an OLAP environment.

Specify a data table in Enterprise Performance Foundation. This table is used as an
interface table to move consolidation results into analytical reporting. When you run
consolidation, the results are pushed into the data table. Analytical reporting can then
pull the consolidation results from the table.

Note: Ensure that the data table is not being used by any other
applications.

Optionally specify a line item hierarchy in Enterprise Performance Foundation. If you
have Internal Controls Manager integration enabled, it will use this line item hierarchy.

See:Integrating with Internal Controls Manager, page 22-1.

You may also have to provide mappings between Financial Consolidation Hub and
analytical reporting. The Created by Object dimension is not supported in analytical
reporting. Thus, in Task 1, if you selected Created by Object column to be available as a
reporting dimension, you must now map to use for these columns. For example, map
the Object dimension to User-Defined Dimension 1 hierarchies should be created on the
user defined dimensions selected.

See: Setting Up Analytical Reporting, page 19-1.
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When you click Complete, Financial Consolidation Hub launches the FCH: Module
Initialization concurrent program. Monitor the concurrent program and verify that it
completes successfully.

Additional Setup Tasks

Once you complete Tasks 1-12, perform the following additional setup tasks.

1.

Set default values in Enterprise Performance Foundation. Using the Enterprise
Performance Foundation Administrator responsibility, navigate to Configuration
Rules > Dimension > Definition. For each dimension that you set active in
Enterprise Performance Foundation in Task 1, assign a default member in each
value set of the consolidation chart of accounts.

Initialize Financial Consolidation Hub. Using the Consolidation Manager
Responsibility, navigate to Requests > Schedule Requests. Run the FCH: Module
Initialization concurrent program.

Using Oracle General Ledger with Oracle Enterprise Performance

Foundation

Financial Consolidation Hub facilitates the synchronization of data from Oracle General
Ledger. This comprises the following setup components: ledger assignments, dimension
rules, hierarchy rules, and balances rules. For information on balances rules, see Setting

Up Data Submission for Oracle Entities, page 14-4.

To use Oracle General Ledger with Financial Consolidation Hub, you must perform the
following setup steps:

1.

Configure the FEM_BALANCES table to be compatible with Oracle General Ledger
integration

Assign ledgers for analytic processing in Enterprise Performance Foundation
Define and run dimension rules

Define and run calendar integration

Define and run hierarchy rules

Define and run balances rules

To access the setup steps, select the Enterprise Performance Foundation Administrator
responsibility and navigate to the Data Rules tab.

Note: For more information see the Oracle Enterprise Performance
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Foundation User’s Guide.

Financial Consolidation Hub recommends the following setup when leveraging the
Oracle General Ledger integration.

Configuring FEM_BALANCES for Oracle General Ledger Integration

To utilize integration with Oracle General Ledger, you must first configure and register
the FEM_BALANCES table in Enterprise Performance Foundation to be used for
integration.

1. In the Enterprise Performance Foundation responsibility, navigate to
Administration>Registration>Tables and Columns. Query for the table
FEM_BALANCES and click Update.

2. Click Save and Next multiple times to reach the step Table Classification.

3. Move Oracle General Ledger from the Available Classifications region to the
Selected Classifications region.

Note: If you do not see Oracle General Ledger in either region, click
Other Classifications. Expand Oracle General Ledger and have
your System Administrator perform the actions listed in the
expansion. After your System Administrator performs the actions,
Oracle General ledger should appear in one of the regions.

Ledger Assignments

To use a ledger from Oracle General Ledger in Enterprise Performance Foundation,
assign the ledger.

Defining Dimension Rules

Dimension rules define how General Ledger charts of accounts relate to Enterprise
Performance Foundation dimensions.

The General Ledger chart of accounts structure is segment based, whereas all data
stored in Enterprise Performance Foundation is dimension based. Before you transfer
General Ledger balances to Enterprise Performance Foundation, define all applicable
dimension values within the Enterprise Performance Foundation architecture using
account-based dimension and dimension hierarchy rules. These dimension rules map
the General Ledger chart of accounts segments to Enterprise Performance Foundation
dimensions. An account-based dimension rule specifies how a particular dimension in
Enterprise Performance Foundation is derived from the segments of a General Ledger
Chart of Accounts. Specifically, the account-based dimension rule specifies how
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dimension members are derived from segment values.

Setting Up Dimension Rules

Map each chart of accounts that you selected to be transferred to Enterprise
Performance Foundation to Enterprise Performance Foundation dimensions. You can
then synchronize segment values and hierarchies into Enterprise Performance
Foundation as dimension members and hierarchies. For each dimension within
Enterprise Performance Foundation, define and execute a mapping option. The
dimension mapping has the following options for each dimension:

* Copy Values from Single Segment
¢ Assign a Default Value
¢ Concatenate Values from Multiple Segments

Financial Consolidation Hub recommends particular consideration be given to the
mapping options for the dimensions listed in the following table.

Setting Up Oracle Enterprise Performance Foundation 5-19



Selected General Ledger Dimensions with Mapping Option Requirements

Dimension Description Financial Consolidation Hub
Requirements and
Recommendations

Company Cost Center The Organization You must map at least one

Organization dimension enables you to segment to the Organization

copy values from a single
segment, either Company or
Cost Center, or the
combination.

dimension. Although you can
combine the company and cost
center segments with the
Organization dimension.
Financial Consolidation Hub
recommends that you map the
company segment to the
Organization dimension and the
cost center segment to a
user-defined dimension for
reporting purposes.

Note: For Financial
Consolidation Hub purposes,
you must include the
company segment in the

mapping.

See: Setting Up Analytical
Reporting, page 19-1
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Dimension

Description

Financial Consolidation Hub
Requirements and
Recommendations

Intercompany

Line Item

Natural Account

The Intercompany mapping
depends upon the
Organization mapping.

The Line Item mapping can
copy values from a single
segment or concatenate up
to three segments.

The Natural Account
mapping can copy a single
segment or concatenate up
to three segments.

If your chart of accounts has an
intercompany segment, assign
the intercompany segment to
the Intercompany dimension.

If you do not have a qualified
intercompany segment, then
assign a specific value.

Note: The intercompany
dimension can be populated
within Financial
Consolidation Hub using the
Line Item Intercompany
Maps functionality.

See: Task 9: Line Item
Intercompany Maps, page 5-13

Map the natural account
segment to the Line Item
dimension. Financial
Consolidation Hub
recommends concatenation of
segments to the Line Item
dimension only if you have
dependent segments on the
natural account segment.

Map the natural account
segment to the Natural Account
dimension. Financial
Consolidation Hub
recommends concatenation of
segments to the Natural
Account dimension only if you
have dependent segments on
the natural account segment.
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Dimension Description Financial Consolidation Hub
Requirements and
Recommendations

Entity You can assign the Entity Assign the Entity dimension to
dimension to a single value  a single value if you want the
or a single segment copy of  chart of accounts to be the
the balancing segment consolidation global value set
value. combination in Financial

Consolidation Hub.
Note: If you are on

FEM.D.1, this dimension
will not be available for

mapping.

Running Dimension Rules
After you define the dimension rules for a chart of accounts, run dimension rules to
automatically generate dimension values and value sets. To run the rules, click Submit
All Rules. It will launch the concurrent request Program- Enterprise Performance
Foundation General Ledger Dimension Rule Engine. The request will be run for each of
the dimensions in Enterprise Performance Foundation, including inactive ones.

If a dimension copies from one segment, the new value set is in the <OGL value
set>:DIM:<number> format. If a dimension copies from multiple segment, the new
value set is in the <OGL value setl> - <OGL value set 2>:DIM:<number> format .

After you run the dimension rules, you can transfer dimension hierarchies and balances
to Enterprise Performance Foundation.

You can also undo dimension integration. Delete or undo any associated dimension
hierarchies or balance transfers before you can undo dimension integration.

Note: Add the users running dimension member rules to the Default
and Data Integration folders.

Defining Dimension Hierarchy Rules

After segment values are linked to dimension members, you can transfer segment
hierarchies used in Oracle General Ledger to Enterprise Performance Foundation by
defining and running dimension hierarchy rules. Dimension hierarchy rules define
dimension hierarchies in Enterprise Performance Foundation, based on General Ledger
segment value hierarchies. Hierarchy rules apply only to dimensions that are related to
the General Ledger chart of accounts structure. Each hierarchy rule is based on a
particular dimension rule so the system can use the correct list of dimension members
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to construct the dimension hierarchy.

Financial Consolidation Hub enables you to define new hierarchy rules and new
dimension hierarchy rule versions. Definition of a new rule creates a new hierarchy
definition within Enterprise Performance Foundation. Creating a new version of the
rule creates a new hierarchy version within Enterprise Performance Foundation. When
you define the hierarchy rule, specify the top segment value. A hierarchy is available in
Enterprise Performance Foundation with the top segment values and all of its children.

Running Dimension Hierarchy Rules

Run dimension hierarchy rule versions to automatically generate dimension hierarchies
based on General Ledger segment value hierarchies. The selected hierarchy rule version
creates a dimension member hierarchy. The hierarchy name is in the format Hierarchy
for Rule <Hierarchy Rule>. To keep a version of the previous dimension hierarchy,
define a new dimension hierarchy rule version.

Note: Add the users running dimension hierarchy rules to the Default
and Data Integration folders.

Note: In Enterprise Performance Foundation Dimension hierarchies, a
value cannot have multiple parents. However, Oracle General Ledger
does not have this restriction in its hierarchies. Ensure that your
hierarchies in Oracle General Ledger do not have multiple parents
otherwise the dimension hierarchy integration will fail.

Calendar Period

You can synchronize your calendar definitions in Enterprise Performance Foundation
with Oracle General Ledger.
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Setting Up Entities

Overview

Entities are designed to provide a flexible framework to separate and organize
operational data, consolidation processing, and consolidation results. Entities are the
building blocks used to construct consolidation hierarchies.

See: Setting Up Consolidation Hierarchies, page 13-2

The following entities are designed to easily organize operating, elimination, and
aggregation data for analysis and consolidated financial reporting:

* Operating entity
¢ Consolidation entity

¢ Elimination entity

Operating Entity

This entity contains operating balances that are loaded from General Ledger or other
financial systems using a data submission.

See: Submitting Data for Oracle Entities, page 14-6

Controlling Entity

This entity is an operating entity associated with a consolidation entity. The
consolidation entity-controlling entity relationship is not one of ownership; instead it
separates the consolidated data of a company from the operational data.

Consolidation Entity

This entity contains consolidated balances. A consolidation entity can own other
consolidation or operating entities, and aggregates its immediate children. Each
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consolidation entity includes a unique elimination entity and optionally a unique
controlling operating entity.

Elimination Entity

This entity holds entries and adjustments produced during the consolidation process. A
unique elimination entity is automatically created for each consolidation entity.

Note: To create an elimination entity, create a consolidation entity and
specify the elimination entity's name during the creation process.

Example

In the following hierarchy, APAC and Subsidiaries is a consolidation entity. It has a
controlling entity, APAC HQ. The associated elimination entity is APAC Eliminations.
Japan is an operating entity.
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Sample Consolidation Hierarchy
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Entity in Enterprise Performance Foundation

When you create an entity in Financial Consolidation Hub, corresponding Enterprise
Performance Foundation structures are automatically created. An entity in Financial
Consolidation Hub corresponds to the same-named dimension member in the default

value set for the Entity dimension.

Note: An entity created in Financial Consolidation Hub has specific
parameters attached to it that you can view in Enterprise Performance
Foundation, but not vice versa.

Aledger is also created for the entity, with the name in the format <entity name> ledger.

Note: A ledger is not created for an entity in the case where the entity is
an operating entity that sources from Oracle General Ledger. In this
case, you will select an existing ledger to assign to the entity.
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Selected User Interface Elements for Setting Up Entities

The following sections describe Selected user interface elements.

Contact

The selected contact is the recipient of Workflow notifications related to the entity. This
leverages the role based model available in the Oracle User Management.

See: Oracle Applications System Administrator's Guide - Security

See: Impact Analysis, page 15-2

Secure by Role

If you select to secure by role, only the roles that you specify can access and update the
entity. If the entity is an operating entity, only the assigned roles can submit data and
adjustments for that entity. If the entity is a consolidation entity, only the assigned roles
can submit consolidations for that entity.

See: Role-Based Security, page 21-1

Image File

You can upload an image file to represent the entity. The image file must be in GIF
format and be no larger than 16 x 16 pixels.

Enable Entity

If you disable an entity, you cannot include the entity in new hierarchies. Disabling an
entity has no effect on an existing hierarchy where the entity is already included.

Note: If you disable a consolidation entity's controlling entity, the
consolidation entity is treated as though it were disabled.

Note: Once you disable an entity, you will not be able to re-enable it.

Source System

Select a source system for the operating entity. This is the system used for managing the
entity's operational activity and account balances throughout the accounting period.
Whether you select an Oracle General Ledger or a third party data source system, it
determines some of the fields that must be entered for the entity.

If you specify any additional data types, each additional data type can have a different
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source system.

Note: If the source system for actuals is not Oracle General Ledger, the
source systems for any additional data types cannot be Oracle General
Ledger.

Ledger

To create an operating entity with an Oracle General Ledger source system, you must
select a ledger in Oracle General Ledger from which to pull balances.

Balances Rule

To create an operating entity with an Oracle General Ledger source system, you must
select a Balances Rule to specify which balances are pulled from the ledger selected for
the entity.

If you specify additional data types, each additional data type can have a different
balances rule.

See: Setting Up Data Submission for Oracle Entities, page 14-4

Value Set Combination

To create an operating entity with a third party General Ledger source system, you
must select a value set combination based on the chart of accounts used in that source
system.

See: Task 4: Value Sets, page 5-8

If you specify additional data types, they will all use the same value set combination as
the one you specify for actuals.

Calendar Hierarchy

To create an operating entity with a third party General Ledger source system, you
must select a calendar hierarchy. The calendar hierarchy describes the periodicity of
data that you will load for the operating entity.

If you specify additional data types, they will all use the same calendar hierarchy as the
one you specify for actuals.

Functional Currency

To create an operating entity with a third party General Ledger source system, you
must select a functional currency for the entity. When you include an entity in a
hierarchy, it automatically defaults to this currency, but you can change the currency
within the hierarchy. The same defaulting behavior occurs for data submission.
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If you specify additional data types, they will all use the same functional currency as the
one you specify for actuals.

Note: You can load data in a currency that is different from the
functional currency, in case you are running translation on an external
system.

Transformation Rule Set

To create an operating entity with a third party General Ledger source system, you can
select a transformation rule set. A transformation rule set transforms the data when you
submit it.

If you specify additional data types, each additional data type can have a different
transformation rule set.

See: Transformation Rule Sets, page 14-10

Validation Rule Set

To create an operating entity with a third party General Ledger source system, you can
select a validation rule set. A validation rule set checks the data when you submit it.

If you specify additional data types, each additional data type can have a different
validation rule set.

See: Validation Rule Sets, page 14-10

Additional Data Types

To create an operating entity, set it up for actuals and averages data types. You can also
assign additional data types to an operating entity such as budgets. Additional data
types are set up in a similar manner to actuals and averages. You can run data
submission and consolidation for any data type assigned to an entity.

See: Task 4: Data Types, page 5-6

Company Values

To create an operating entity, select company values that the entity will represent. This
serves as the linkage between the company segment of General Ledger operational
balances and Financial Consolidation Hub entities.

Note: You can use a company value in only one enabled entity. In order
to free a company value, you can remove it from an entity or disable
the entity or run the concurrent request FCH: Update Entity
Organizations.
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Each company can own multiple organizations that are used in account balances for the
entity.

Note: If you create an organization for an entity after the entity is
created, you must synchronize the organization assignments. To
synchronize, click Update for the entity.

Base Organization

To create an operating entity, select a base organization for the entity. The base
organization must be one of the organizations of the selected companies. The base
organization is used during consolidation processing as a default for automatic creation
of consolidation entries.

Note: If you do not see any organizations when you try to select a base
organization, verify that you have assigned companies to the entity and
that those companies have organizations assigned to them.

See: Minority Interest, page 7-3

Elimination Entity

To create a consolidation entity, you must enter a unique name for the elimination
entity. The elimination entity is automatically created with that name.

Controlling Entity

To create a controlling entity, you can select an existing operating entity to be the
controlling entity for the consolidation entity.

Note: An operating entity can be the controlling entity of only one
consolidation entity.

Spreadsheet Loader

The spreadsheet loader enables you to create multiple entities at the same time.
Download a spreadsheet template, fill it out, and then upload it.

Note: The entity spreadsheet loader is not a WebADI spreadsheet.

The first worksheet of the workbook corresponds to operating entities with third party
General Ledger source systems. The second sheet corresponds to operating entities with
Oracle General Ledger source systems. The third sheet corresponds to consolidation
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entities.

Note: You can create an operating entity and assign as a controlling
entity to a consolidation entity at the same time within the spreadsheet.

Note: The spreadsheet loader does not support adding additional data
types to entities. To add additional data types, update the entity
through the application.

If there are errors in the spreadsheet, the spreadsheet is rejected. All errors must be
corrected before you run spreadsheet loader. If the spreadsheet has no errors, it
launches the FCH: Load Entities concurrent request.
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7

Overview

Setting Up Categories

Categories control how a consolidation is processed and reported. They provide a
means of grouping process logic and specifying parameters impacting the output of
such logic. Customers can leverage categories to track and analyze their consolidated
results.

The following table shows seeded categories in a default sequence.

Seeded Categories

Default Sequence Category

1. Data Preparation

2. Intracompany

3. Translation

4. Intercompany

5. Acquisition and Disposal
6. Minority Interest

7. Aggregation
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User-Defined Categories

You can define categories as needed. The following situations illustrate scenarios where
you may choose to define categories:

* You need to adjust your investment in subsidiary accounts through the equity
method of accounting. In this case, for example, you can create a category called
Equity Pickup after the Translation category. If you need to reverse those
adjustments, you can create an additional category called Equity Pickup
Elimination and insert it after Minority Interest.

* You want to keep your adjustments separate from the operating balances imported
into Financial Consolidation Hub. In this case, for example, you might create a
category called Operating Adjustments after the Data Preparation category.

Category Definitions

This section describes the seeded categories.

Data Preparation

Data Preparation is the first category executed in the consolidation process. It prepares
operating data for consolidation by transforming the data to a standard consolidation
chart of accounts and calendar. Additionally, it aggregates data to the consolidation
processing dimensions in cases where consolidation processing does not use all the
dimensions of the submitted data.

During Data Preparation, if Financial Consolidation Hub determines that an operating
entity is using a global value set combination that is different from the consolidation
value set combination, it converts the entity's dimension values into its counterparts in
the consolidation value set combination. This conversion or mapping occurs
automatically.

See: Task 8: Value Set Maps, page 5-12

Intracompany

The Intracompany category eliminates balances from transactions that occur between
different organizations within an entity. The Intracompany category is always
sequenced before Translation.

To specify how intracompany balances are identified, select Yes or No in the Identify
Intracompany Transactions When They Differ From a Specific Value drop-down list.

The following table shows an example of how the option selected impacts
Intracompany. Assume that 00 is the constant value.
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Impact of the Selected Option on Intracompany Balance Identification

Option Selected Organizatio Line ltem Intercompany Intracompany
n Organization Transaction

Only intercompany when 01 2300 01 No

organization and Intercompany

are different.

Differ from Specific Value "00" 01 2300 01 Yes

Translation

Intercompany

Translation occurs after all categories that affect the child's balances are executed. The
Translation category picks up all data from a child entity and translates it to the parent's
currency. Translation only runs at points in the consolidation hierarchy where a child's
currency differs from that of its parent.

See: Translation Method, page 12-1

The Intercompany category eliminates balances from transactions that occur between
entities in the consolidation hierarchy. Eliminations are written to the elimination entity
of the first common parent in the consolidation hierarchy. The Intercompany category
can be placed anywhere after Translation.

See: Intercompany Rule, page 10-1

Acquisition and Disposal

The Acquisition and Disposal category enables users to automate accounting entries or
input manual entries as a result of acquisition and disposals.

See: Creating Consolidation Entries, page 17-4

Minority Interest

The Minority Interest category holds the consolidation accounting entries needed to
recognize non-controlling interest on consolidated financial statements. You can create
entries in the Minority Interest category by entering adjustments or by using
consolidation rules. The Minority Interest category can be placed anywhere after
Translation.

See: Consolidation Rule Steps, page 9-2
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Aggregation
The Aggregation category creates consolidated financial results for each consolidation

entity. It writes to the consolidation entity the summation of data for all children across
all categories. The Aggregation category always occurs last.

Selected User Interface Elements for Setting Up Categories

The following sections describes selected user interface elements for the Set Up
Category functionality.

Output Entity

An output entity is the target entity where the results of a consolidation rule or a
manual adjustment are written. The output entity can be the source entity, the parent
entity, or the elimination entity as follows:

® Source entity - The adjustment or entry updates the balances of the originating
entity. For example, operational adjustments that should be reflected on the entity's
operational books, but to be expedient, they are done in consolidation.

* DParent entity - The adjustment or entry updates the balances of the parent entity.
For example, equity pickup. The parent entity needs to write up or down its
investment in a subsidiary based on the subsidiary's profitability.

¢ Elimination entity - The adjustment or entry updates the balances of the elimination
entity, which does not affect the operational balances of any of the operating
entities. This is the case for most consolidation-only adjustments such as
intercompany eliminations and minority interest.

Note: Regardless of the output entity, balances are still segregated by
the Created By Object ID for auditing purposes.

All categories having the Output Entity field specified as source entity, must be placed
before the Translation category. This enables the Translation category to pick up all
operating entity data when it runs. All categories that have the Output Entity field
specified as elimination entity or associated parent must be placed after the Translation
category.

Track Each Child Separately

The Track Each Child Separately feature determines the granularity of a consolidation
rule output. If you select Yes, see the organization level granularity in the calculations.

See: Minority Interest, page 7-3
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Net to Retained Earnings at Year-End

The Net to Retained Earnings at Year-End feature determines whether year-end
processing should be applied to manual adjustments and consolidation rule entries for
this category. The default setting is No. If you select Yes for the Net to Retained
Earnings in the Year-End drop-down list, any income statement adjustments or
consolidation rule entries for the applicable category are closed to retained earnings
when crossing the fiscal year. This balance is added to the retained earnings balance for
all future periods. This balance is in addition to the balance determined by operating
balances and calculations.

Note: When the translation category nets to retained earnings at
year-end, it adds the balance to the retained earnings balance of the first
period of the next year, but not subsequent periods. Too propagate the
balance to future periods, you must include the balance in the
operating balances or calculations.

Reprocess for Multiple Parents

Certain formulas need to be recalculated each time the overall effective ownership of a
child changes. This occurs when a child is partially owned by multiple parents within a
consolidation hierarchy. Minority interest is a common example. A consolidation entity
may own 70% of a subsidiary, but the remaining 30% is owned by another entity within
the same hierarchy. While it is customary to recognize minority interest for the
consolidation entity which owns 70%, this minority interest needs to be backed out at
higher levels of the hierarchy in which the effective ownership of the subsidiary is
100%. For information on using this attribute for the multiple-parent scenario, see
Setting Up Consolidation Hierarchies, page 13-2.

Oracle General Ledger Category

Specify a category in Oracle General Ledger. If you perform write back to Oracle
General Ledger during an adjustment, it will write to the Oracle General Ledger
category specified in the Financial Consolidation Hub category of the adjustment.

See: Write back to General Ledger, page 16-6

Note: You only need to specify an Oracle General Ledger category if
you plan to use the category for write back purposes. If you attempt to
write back and there is no Oracle General Ledger category specified,
write back will fail.
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Setting Up Consolidation Methods

Overview
A consolidation method is a mechanism that defines the accounting method applied
during consolidation. Consolidation rules are assigned to each consolidation method. A
consolidation method is assigned to each parent child/relationship within the
Consolidation Hierarchy user interface.

Related Topics

Setting Up Consolidation Hierarchies, page 13-2

Selected User Interface Elements for Setting Up Consolidation Methods, page 8-1

Selected User Interface Elements for Setting Up Consolidation Methods

Selected user interface elements are described below.

Consolidation Types

Consolidation types specify the method of consolidation. Financial Consolidation Hub
provides the following consolidation types:

e  Full consolidation
¢ Proportional consolidation
e None consolidation

Full Consolidation - A consolidation method where 100% of the subsidiary's balances
are brought into the consolidated statements.

Proportional Consolidation - A consolidation method where a proportionate share of
the entity's balances are brought into the consolidated statements based on the
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ownership percentage.

None Consolidation - A consolidation method where an entity's balances can be used as
input into a consolidation rule, but the entity's balances are not brought into the
consolidated statements.

Enable Consolidation Method

If you disable a consolidation method, you cannot use it to create new relationships in a
consolidation hierarchy but prior existing relationships are not affected.

Consolidation Rules Table

The consolidation rules table enables you to view all the consolidation rules assigned to
the consolidation method.

See: Setting Up Consolidation Rules, page 9-1

From Ownership (%)/To Ownership Percentage (%)

You can optionally specify an ownership percentage range for the consolidation
method. The consolidation method is automatically defaulted when the ownership
percentage falls within the range in creating a consolidation hierarchy. For example,
you can set up rules such that, by default, full consolidation is used for entities which
are majority owned and proportional consolidation is used for entities which are
20-50% owned. You can then override this, in specific cases, as needed. An example
would be where an entity is 45% owned, but you have effective control over it.
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Overview

Setting Up Consolidation Rules

A consolidation rule is a user-defined mechanism that enables you to automate the
creation of consolidation entries during consolidation processing. Typical examples of
entries generated by consolidation rules include the following:

* Minority interest
* Equity accounting

You can also use consolidation rules to calculate acquisition and disposal entries. This
chapter will focus on rules in the Minority Interest and User-Defined categories.
Acquisition and Disposal rules will be discussed in a later chapter. See: Creating
Consolidation Entries, page 17-4

Selected User Interface Elements for Setting Up Consolidation Rules

Category

The following are selected user interface elements for setting up consolidation rules.

Financial Consolidation Hub assigns a consolidation rule to a category. This determines
when to run the rule and where to write the results. The application runs consolidation
rules in the same category simultaneously. You can apply consolidation rules to the
Acquisition and Disposal, Minority Interest, and User-Defined categories.

See: Category Definitions, page 7-2

This section will focus on Minority Interest and User Defined categories. For
information on the Acquisition and Disposal category, see Creating Consolidation
Entries, page 17-4.
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Enabled

If you disable a consolidation rule, the application does not apply the consolidation rule
during consolidation processing.

Consolidation Method

A consolidation rule is assigned to consolidation methods.
See: Overview, page 8-1

See: Selected User Interface Elements for Setting Up Consolidation Methods, page 8-1

From Method/To Method

If the consolidation rule is in the Acquisition and Disposal category, specify the original
and new consolidation methods. For information on acquisitions and disposals, see
Creating Consolidation Entries, page 17-4.

Consolidation Rule Steps

A consolidation rule contains one or more consolidation rule steps. A consolidation rule
step comprises a formula and a formula scope.

Note: The sequencing of rule steps does not impact processing.

Formulas

A formula is a combination of tokens and mathematical operators used to calculate the
balance of the consolidation entry. Tokens are variables whose values are resolved
during consolidation processing based upon the consolidation hierarchy. To create
formulas, you use the add (+), substract (-), multiply (*), divide (/), and parentheses [( )]
mathematical operators to group calculations in combination with tokens.

Financial Consolidation Hub provides 11 tokens. The tokens available for a
consolidation rule are determined by the category to which the rule is assigned. The
table below shows available tokens for the Minority Interest and User Defined
categories.
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Seeded Tokens Used with the Minority Interest and User-Defined Categories

Token Description

ELIMTB Elimination Entity Balances

CHILDTB Child Entity Balances

%OWN Ownership Percentage at Consolidation
%MI Minority Interest Ownership Percentage

Formula Scope

The formula scope identifies the source and target accounts for the formula.

Source
You can restrict source values by dimension. You can specify valid values from a list of
all possible values or from a hierarchy. Each account that meets the source requirements
is used in the calculation.

Target
You specify the dimension values of the account to which the consolidation entry is
written. For each dimension, the user specifies a specific value, otherwise the system
uses the same value as the source account.

Offset

You can specify an offset account if you did not specify the same as source option for
any target values. If you specify an offset account, then an offset balance is written to
the offset account to balance any consolidation entries created by the rule step.

Balancing a Consolidation Rule

Each consolidation rule is checked to see if it produces balanced entries. You can design

consolidation entries to balance or optionally use the offset functionality to
automatically balance the consolidation rule for you. If the consolidation rule is not
balanced, Financial Consolidation Hub uses the suspense handling defined for the
applicable consolidation hierarchy.

See: Setting Up Consolidation Hierarchies, page 13-2

See: Creating Consolidation Hierarchy Structures, page 13-6

Setting Up Consolidation Rules

9-3



Additional Data Types

By default, you can run consolidations on actuals and averages. In addition, you can
also run consolidations on any additional data type defined. During consolidation,
consolidation rules may or may not be executed depending on the definition of the data

type.

Related Topics
Task 4: Data Types, page 5-6

Examples of How Consolidation Rules Work

The following examples illustrates how consolidation rules are applied during a
consolidation process. The figure below illustrates the hierarchy for the examples.

The examples focus on Vision Consolidation Subsidiary and its subsidiary, Japan.
APAC and Subsidiaries has complete control over Japan, and so is fully consolidated.
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Sample Consolidation Hierarchy

Entity
=88 ciobal and Subsidiaries
= Wl sPac snd Subsidiaries
W irac o
E Japan
' Tabhwan
& Thailarst

APAC Eliminatiors
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En.s.n bution

ESE'UI:E'B

8l cperations
=Pm jct Manusfackring
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Corporation Eliminations
= BB emEs and Subsidiaries
I]Fr.‘l’l'-"
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l]Jtal'F

Eneter s
B2 swed=n
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EMEA Eliminations
= '| ati America
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Latin America Eliminations
Global Eliminations
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Entity Type
Consolidation Entiy

Consolidation Ertity 100
Operating Entity

Operating Entity 20
Operating Entity 85

Confrolling

Operating Entity 72
Elirninaticn Entity
Consolidation Eritity 100
Operating Entity 85
Operating Entity 92
Operating Entity 100
Consolidation Ertity 100
Operating Entity  Confrolling
Operating Entity 98
Elirmnation Entity

Elimination Entity
Conzolidation Brtity 100
Operatiog Entity 998
Operating Entity 91
Operating Entity 99,78
Operating Entity 100
Operating Entity 94
Oiperating Entity 100
Elirnination Entity

Consolidation Entity 100
Ciperating Entity Controlling
Operating Entity 100
Operating Entity 200

Elimination Entity
Elirnination Entity

Usn
LIED

LED
L=]
GEP

SGO

ELR

ELR

LED

Owmership (") Currency Code Consolidation Method

“Wision Consolidation Full

Vigion Consolidation Subsidiary
‘Wision Consolidation Subsidiary

“fision Consolidation Subsidisry

Wigion Consoldation Full
“ision Consolidation Full
“ision Consalidation Full
“ision Consolidation Full

“ision Consolidation Full

Wision Consalidation Subsidiary

“ision Consalidation Full

Wigion Congobdation Full
“ision Consaldation Full
“ision Consnlidation Full
“ision Consalidation Full
“ision Consolidation Full

“ision Consolidation Full

Wigion Conaolidation Full

“ision Consolidation Subsidiary

“ision Consolidation Subsidisry

Translation Method I

Trareslation
Translation

Translstion

Translstion

Trarslation

Tranglation

Trar letion
Translstion
Translstion
Tranlation
Translation

Translstion

Translation

Translation

Minority Interest

You want to calculate the minority interest for the relationship between APAC and
Subsidiaries and Japan. Since the relationship is a Full consolidation type, 100% of the
balances in Japan are aggregated to APAC and Subsidiaries. However, since APAC and
Subsidiaries only owns 80% of Japan, you want a resulting entry that removes 20% of

the profit of Japan.

Assume that the minority interest consolidation rule is in the minority interest category
that enables you to track each child separately functionality and writes to the
elimination entity. The following figure displays the rule.
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Minority Interest Consolidation Rule
-D'E:'ACLE' Financial Consolidation Hub

Home Logout Help Preferences Diagriostice
ation | Dusta Submission | Acoueisition and Disposal | Setup | Reguests
Entity Auchtable Unt Hisrarchy | Mathed Rule | Calerdar | Rolk | Rate | Foundation
Setup: Rule: Conzalidation Ruls =
Interco Rule
bt View Consolidation Ruks
Rula Hame  Minority Interest Dazription  Minority Interest
Catagory Caegory  Minority Interest Endoled Yes
Consolidation Method Description
Wiston Consalidation Ful Wision Corsobdaton Full
Wision Consalidation Subsidiary Vision Corsoldaton Subsidiary
. -
Rude Steps
HShie availabile Fornls Tobars
Sededt * Name *Formala
& Minority Interest Caloulation WML * (CHILDTE+ELIMTE)
Formula Scope
<TIP I the Target field is left blank, e Tanget vahue s set i be the same as the Sourcs vale
Dimension SOUrCe Target Difset
Lire Itzm 8 S 3650 = Miror ity Interest BfS 5450 - Minoriy Interest PA
Eeham o Saarch
- | ] -

Note: The User Interface does not show all of the Source values. The
Source values chosen for Line Item are 4000 - Revenue and 5000 -
Expense.

The minority interest consolidation rule finds any balances in the source and
elimination entity whose Line Item is 4000-Revenue or 5000-Expense and creates a
consolidation entry that is equal to Minority Interest Ownership multiplied by those
balances. The consolidation entry is written to the specified account combination in the
elimination entity and an offset entry is written to balance the consolidation entry.

The company cost center organizations 11.100 and 11.200 are assigned to Japan and
11.100 is its base organization. APAC HQ, the controlling entity of APAC and
Subsidiaries has the base organization 12.100. Japan has the balances in the following
table. Assume these balances have already been translated into the parent currency,
usD.

Japan's Balances

Company Cost Center Line Item Balance
Organization

11.100 1100-Cash 500
11.100 2100-Debt -200
11.200 3000-Equity -100
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Company Cost Center Line Item Balance
Organization

11.200 4000-Revenue -500

11.100 5000-Expense 300

During consolidation, the consolidation rule produces the entry in the following table:

Entry Produced by Consolidation Rule

Company Cost Center Line Item Balance
Organization

11.100 3600- Minority Interest B/S -40

11.100 5450- Minority Interest P/L 40

The consolidation rule identifies the balances with line items 4000-Revenue and
5000-Expense as source balances. The other balances in Japan are not identified as
sources because their line items are not included in the consolidation rule formula
scope. The consolidation rule produces a consolidation entry with Line Item
3650-Minority Interest B/S for the sources, whose value is: 0.2 * (-500 + 300)= -40.
Additionally, the consolidation rule produces an offset entry with Line Item
5345-Minority Interest P/L to balance the consolidation entry. The company cost center
organization of the entry is set to the base organization of the source entity, 11.100.

If Track Each Child separately was set to No for the category of the consolidation rule,
the consolidation entry would then use the base organization of the controlling entity,
12.100.

Track Each Child Set to No

Company Cost Center Line Item Balance
Organization

12.100 3600-MI (Balance Sheet) -40

12.100 5300-MI (Profit and Loss) 40

In this case, you cannot tell if the source entity of the consolidation entry was Japan or
any other child entity of APAC and Subsidiaries
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Eliminate Investment in Subsidiary

You want to eliminate APAC and Subsidiaries' Investment in Subsidiary for Japan.
Since the relationship is a Full consolidation type, 100% of the balances in Japan are
aggregated to APAC and Subsidiaries. However, since APAC and Subsidiaries already
records its Investment in Subsidiary for Japan, you want to reduce that investment
against Japan's equity in order to avoid double counting. Since APAC and Subsidiaries
only owns 80% of Japan, you only want to eliminate the portion of equity owned.

Assume that the equity accounting consolidation rule is in the equity accounting
category that enables you to track each child separately functionality and writes to the
elimination entity. The consolidation rule will have three steps.

Step 1: Eliminate Investment in Subsidiary

=
ORACLE" Financial Consolidation Hub

Home Logout Halp Prefe
Consolidation | Data Submission | Acquisition and Disposal | Setup | Requests
Enity Avditable Lnit Hierarchy Mathod Rk Calendar Fale Rater Foundation
Selup. Rule: Corsolidstion Rule =
Irfarcampany Ruls <
Wiew Consolidation Bule
Rule Hame  Elimnate meestments in Subsidiary ascripbon  Eiminate Investments in Saubrsidiary
Cateqory Calegory  Mimority Interest Enabled Yes
Consolidation Method Description
Yigion Proportiona | Corso lidation Yizion Proportiona| Consolidation
Vision Corgobdation Subsidiary Yizion Consolidation Subsidiary
. Rl Steps o
H Ehow Available Formula Tokens
Select *Mame *Formula
#  Elimnat Irvestments in Subsidiary CHILDTE* S0AWH
[ pe SLibaidiary Equity CHILDTE®-1
= Derme MBS Sl * CHILDTE
Formiila Sonpe
“TIP If the Target fizld & el blank, e Target value & 2@l o be he same a5 the Source vale
Dimension Source Target DOffset
Ling [tsm I ' 1620 - Irvastment n Subsidianes
¥
| | | |

For simplicity, assume that APAC and Subsidiaries paid the market value for Japan.
Therefore, its investment in Japan is equal to Japan's equity times its ownership
percentage. To eliminate Investment in Subsidiary, we reduce APAC HQ's Investment
in Subsidiary by the amount of equity owned in Japan.

The rule step finds any balances in the source entity whose Line Item is 3000 - Equity
and creates a consolidation entry that is equal to the Percent Ownership multiplied by
those balances. The consolidation entry is written to the line item 1820 - Investment in
Subsidiaries.
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Step 2: Eliminate Subsidiary Equity
ORACLE" rinancial Consolidation Hub

Homa Logowi Melp Preferences [Nagnosbcs

Consolidation | Data Submission | Acquisition and Disposal | Setup | Requests

Ertity | sAuditablelnit | Hiersrchy | Method | Rule | Cakndar | Role | Rate | Foundstion
Setupe Rule: Consolidalion Rule >

Wiew Consolidation Ruile

Iraercompany Rul

Rule Hame  Eliminate investments in Subsidary Desoription Eliminate irvestments in Subsidiary
Cateqory Category  Minority Interest Enahled Yes
Conslidation Metiod De:
Wighon Proportional Consalidation Wigon Froportional Consalidation
Vision Coreolidation Subsidiary Wision Corenlidation Subsidiary
Rule Steps
(3 Showy Availainle For rula Tokens
Select = Nanme “Formula
' Elminate Invesiments in Subsidiary CHILDTE* %06
Elminate Subsidiary Equity CHILDTE*-1
T Derme MBS bl “CHILDTE
Formula Scope
“TIP If the Target fizld is left blark, the Targat value i Sat o be e same a5 he Source value,
Drimweresion Source Target Difset
Line [k

Reiurm to Seanch

In step 2, the Japan's equity is eliminated. Since Japan is not fully owned, the portion of
equity not owned will be calculated in step 3. The rule step finds any balances in the
source entity whose Line Item is 3000 - Equity and creates a consolidation entry that is
equal to those balances. Since a target line item is not specified, the consolidation entry
is written to the same line item as the source, 3000 - Equity.
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Step 3: Add Back Minority Equity
ORACLE

Financial Consolidation Hub

Cconsolidation | Data Submission | Acquisithon and Disposal | Sebup | Requests
Enarty suditshle Unit | Hierarchy Metod | Rule Calerdsr | Role | Rate
Selup: Rule: Conzolidation Rule >
View Consolidation Rule
HMame Eliminate Investments in Subsidiary
Category  Minority Interest
Consolidation Method
Y150 Priopaortional Corsolidation
Y ieion Consolidation Subsidiary
Rule Steps
H Shere yailahle Formuls TokenS
Select *Name
€ Eliminate kwestments n Subskiary
" Eliminate Subsidiary Equity
@ Darwe M85

Intercarnpeny Fule
Consolidation Rule
Categary

Formiila Soope
#TIP If ®& Target field & R blark, the Target value

Démension Source

Line Ierm 1

Rghan o Sgach

Home Logout Halp Pr

Descrpbon Eliminate Investments in Subsidiary
Enanied  Yes
Description
YI5i0n Propartional Consobidation
Yizion Consolidation Subsidiary

*Formuls
CHILDTE™ %lfeh
CHLOTE®-1
Sl *CHILDTE

& sel 1o be the same & the Source vake

Target ffset

3550 - Minority [tersst By'S

In step 2, all of Japan's equity was eliminated. Since Japan is not fully owned by APAC
and Subsidiaries, step 3 reduces that amount by the portion of equity not owned.

The rule step finds any balances in the source entity
and creates a consolidation entry that is equal to the

whose Line Item is 3000 - Equity
Minority Interest Ownership

multiplied by those balances. The consolidation entry is written to the line item 3650 -

Minority Interest (B/S) in the elimination entity.

The company cost center organizations 11.100 and 11.200 are assigned to Japan and
13.100 is its base organization. APAC HQ has the company cost center organizations
12.100 and 12.200 and has the base organization 12.100.

APAC HQ has the balances in the following table.

APAC HQ Balances
Company Cost Center Organization Line Item Balance
12.100 1100-Cash 400
12.100 1820 - Investment in 400
Subsidiaries
12.100 3000-Equity -700
12.100 4000-Revenue -500
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Company Cost Center Organization Line Item Balance

12.100 5000-Expense 400

Japan has the balances in the following table. Assume these balances have already been
translated into the parent currency, USD.

Japan's Balances

Company Cost Center Organization Line Item Balance
11.100 1100-Cash 500
11.100 2100-Debt -200
11.200 3000-Equity -500
11.200 4000-Revenue -100
11.100 5000-Expense 300

During consolidation, the consolidation rule will produce a consolidation entry in each
step.

Step 1: Eliminate Investment in Subsidiary

Company Cost Center Line Item Balance
Organization

11.100 1820 - Investment in -400
Subsidiaries

The step identifies the balance in Japan with line item 3000 - Equity as the source
balance. It produces a consolidation entry with Line Item 1820 - Investment in
Subsidiaries, whose value is: 0.8 * (-500) = -400. The company cost center organization of
the entry is set to the base organization of the source entity, 11.100.

Step 2: Eliminate Subsidiary Equity
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Company Cost Center Line Item Balance
Organization

11.100 3000 - Equity 500

The step identifies the balance in Japan with line item 3000 - Equity as the source
balance. It produces a consolidation entry with Line Item 3000 - Equity, whose value is:
-1*(-500) = 500. The company cost center organization of the entry is set to the base
organization of the source entity, 11.100.

Step 3: Add Back Minority Equity

Company Cost Center Line Item Balance
Organization

11.100 3650 — Minority Interest B/S -100

The step identifies the balance in Japan with line item 3000 - Equity as the source
balance. It produces a consolidation entry with Line Item 3650 — Minority Interest B/S,
whose value is: 0.2 * (-500) = -100. The company cost center organization of the entry is
set to the base organization of the source entity, 11.100.

The three consolidation entries produced have a total balance of: (-400) + 500 + (-100) =
0. They are thus balanced, and no suspense needs to be added.
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Overview

Setting Up Intercompany Rules

An intercompany rule is a mechanism that identifies intercompany activity to be
matched and eliminated. Intercompany rules are applied during both intercompany
and intracompany processing. During intracompany processing, rules eliminate activity
within an operating entity. During intercompany processing, the rules eliminate activity
between two entities.

You use intercompany rules to specify the following:

* Line items to match and eliminate
® Accounts to use when creating suspense entries for unbalanced eliminations
* A suspense threshold tolerance for unbalanced eliminations

An intercompany rule applies to all the consolidation hierarchies defined for your
instance. This eliminates the need to repeatedly define and assign identical
intercompany elimination rules to multiple hierarchies.

If an entity records intercompany balances through line item values rather than an
intercompany dimension, see Task 9: Line Item Intercompany Maps, page 5-13.

Related Topics

Matching

Intercompany Example, page 10-3
Matching, page 10-1
Suspense Handling, page 10-2

Matching is the process of grouping intercompany balances together to consider
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whether the balances offset completely and therefore require a suspense entry for
balancing. You can do matching by Company pair or by Organization pair, as specified
in the Match Intercompany By drop-down list of the hierarchy.

Intercompany Elimination Entry

Intercompany elimination entries eliminate balances between entities to ensure that
they are not included in consolidated results. When matching balances are found, the
appropriate entries are created to eliminate the intercompany balances. The resulting
entry is made to the elimination entity of the first common parent entity of the two
entities.

To eliminate a balance under intercompany processing, entries must satisfy the
following:

e Contain a line item that is in an enabled intercompany rule

¢ Originate from an entity and counterparty entity, each of which have a path to a
common parent entity that does not include a consolidation type of None

Intracompany Elimination Entry

Intracompany elimination entries offset balances occurring between different business
units or companies within the same operating entity.

To eliminate a balance under intracompany processing, entries must be the following:

e Aline item that is in an enabled intercompany rule

¢ From the same operating entity

Note: Identification of balances for elimination during intracompany
processing is determined by an intracompany category setting.

See: Intracompany, page 7-2

Suspense Handling

When you define an intercompany rule, you specify a suspense account and a threshold
amount for suspense handling. Suspense handling refers to a balancing entry made to
the suspense account when balances to be eliminated do not offset completely.
Suspense handling writes to the suspense account of the receivables side entity.

Note: A balancing entry is written to the suspense account for any out
of balance amounts, whether or not they exceed the user-specified
threshold amount.
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If the out of balance amount exceeds the threshold amount specified in the
intercompany elimination rule, a warning is generated, but the consolidation is allowed
to continue. You can inspect the entries in the Consolidation Process Status page and
make appropriate adjustments if necessary.

Additional Data Types

By default, you can run consolidations on actuals and averages. In addition, you can
also run consolidations on any additional data type defined. During consolidation,
intercompany eliminations may or may not be executed depending on the definition of
the data type.

See: Task 4: Data Types, page 5-6

Example of How an Intercompany Rule Works

The following example illustrates how intercompany rules are applied during a
consolidation process. The following figure illustrates the hierarchy for the example.

The following figure illustrates a consolidation hierarchy with its various entities.
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Sample Consolidation Hierarchy

Entity Entity Type Owmership (") Currency Code Consolidation Method Translation Method
=88 ciobal and Subrsidiaries Consolidation Ertity (1=ix]
3 .ﬁP-‘\C and Subsidiaries Consolidation Ertity 100 ush “ision Consolidation Full
.ﬁ.l—':\f.' HY Operating Entity  Confrolling (=]
E Japan Ciperating Entity =1 P Wigion Consolidation Subsidiary Translation
- Tabwan Operating Entity 85 TWD Wision Consolidation Subsidiary Translation
E Thailard Ciperating Entity iz THE “izion Consohdation Subsidisry Translstion
APAC Eliminations Elirminatice Entity LED
= ECU'pUlehu-l and Subsidiaries  Consolidation Ertity 100 (L=x] Wigion Consoldation Full
Cu'puranun Operating Entity 25 GEP “ision Consolidation Full Translstion
El‘.ns.h ution Dperating Entity = SGD Wigion Consolidation Full Translation
Bservices Operating Entity 100 ush “ision Consolidation Full
= E(Jperaticrs and Subsidisries Consolidation Entity 100 LEED Vision Consolidation Full
8 cerations Cperating Entity  Confrolling ush
=Pr:1r:rl Marufachring  Operating Entity 52 ELR Wigion Consolidation Subsidiary Tranglation
Cperations Eliminations Elirmnation Entity Ush
Corporation Eliminations Elirnination Entity (1i=n]
= Er-.'Eh and Subsidiaries Conzalidation Ertity 100 (1= ] “ision Consolidation Full
I]Fr.‘rr-" Ciperating Entity .8 ELR Wiion Consolidation Full Trarslation
!Ge'ma’r_.' Operating Entiy 91 ELR “ision Consolidation Full Translation
l:'JtawI Cperating Entity  99.78 EUR “ision Consolidation Full Translstion
Enetheriards Operating Entity 100 ELR: Wigion Consolidation Full Translation
Rl s weden Operating Entity 94 == “ision Consolidation Full Translation
Ur’ Ciper ating Entity 100 GEP Vigion Consolidation Full Translation
EMEA, Eliminations Elimination Entity usn
= B Latn America Conzolidation Entity 100 LIED Wigion Consolidation Full
uE\: azil Operating Entity  Confralling LISD
E.&rgsntma Operating Entity 100 ARS “Wision Consolidation Subsidiary Translation
ECUInrrt El Ciperating Entity 100 Cop “izion Consohdation Subsidiary Translstion
Latin America Eliminations Elirnination Entity LED
Global Eliminations Elirminaticn Entity (=]

Eliminate Receivables Against Payables

You want to eliminate intercompany transactions between accounts payable and
accounts receivable.

This example focuses on transactions between Services and UK. Assume the conversion
rate from GBP to USD is 2.

Note: Intercompany eliminations always occur in the currency of the
common parent.

The following intercompany rule eliminates intercompany transactions between
Accounts Receivable and Accounts Payable. Assume the hierarchy option, Match
Intercompany by, is Company. Also assume the intracompany option, Identify Balances
When They Differ from a Specific Value, is set to Yes, 00.
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ORACLE Financial Consolidation Hub

Home Logout Help Prefemnces

Consolidation | Data Submission | Acquisition and Nsposal | Setup | Requests:
Entity | suditsble Unit | Hierachy |« Method | Rede | Calendar | Rok | Rale | Foundstion

Selup. Rule: Intércormpany Rule »
Intercompany Rule 2
View Intercompany Ruke
Consaldation Fule Hame  Eliminate Recetvable Against Payables
Calegany Cescription  Ellminate Recetvables Agalnst Paybles
Enable Yes
Intercompany Balancing
Elimirakion enfies are genersted for inercompany balances of sach e fem member and cormespanding counsr Ine ien member
Intercompany Receivables Intercompany Payables
Line Item  Description Line ftem  Description
1210 - Accourits Recehvah e 2200 - Accounts Payable
AOCOLE ACCOurts
Recemable Puyainle:
2210 SOCoUntE Payable Discounts
Ancounts
Payatle
Discourts
Suspense Hamling

If imfmrcompany eniries are out of balance, a balarcing entry will be stored in e suspense account during consclidation, IF the imbalance
excmeds e hreshald, & warmning will be gererahed

Thrashold Amount 100 Threshold Currency U5 dollar
Fnarcial Element  End Balance Description End Balance
Procluct (DD Desoription  No Product
Line [term 3201 - ARSAP Susperrce Description. AR/ AP Suspense
Dapartment 151 - General Corporate Desrption  General Corporate

Bahrm T0 Search

The intercompany rule looks for balances that contain the line items 1200 — Accounts
Receivable, 2200 — Accounts Payable or 2210 — Accounts Payable Discounts, and whose
intercompany value differs from 00.

Services is assigned to the companies 3 and 4, which are assigned to the organizations
3.100, 3.200, 4.100 and 4.200. UK is assigned to company 9, which is assigned to the
organizations 9.100 and 9.200.

Services has the following balances in USD.

Submitted Balances

Balance Organization Line Item Intercompany Debits Credits

S1 3.100 1100 — Cash and Cash 9.100 2350
Equivalents

S2 3.100 2200 — Accounts Payable 00 100

S3 3.100 2200 - Accounts Payable 9.100 300

S4 3.200 2210 — Accounts Payable 9.100 1500
Discounts
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Balance Organization Line Iltem Intercompany Debits Credits
S5 4.100 2200 — Accounts Payable 9.100 450
UK has the following balances in GBP.
Balance Organization Line Item Intercompany Debits Credits
U1 9.100 2200 — Accounts Payable 00 1100
U2 9.100 1200 — Accounts 3.100 900
Receivable
U3 9.100 1200 — Accounts 4.100 200
Receivable
Services and UK have the intercompany eliminations performed at the level of the
common parent, Global and Subsidiaries. The entities' balances are converted to the
common parent currency, USD.
Services' balances are already in USD. UK's balances are converted to USD. As specified
before, the conversion rate is 2.
Balance Organization Line Item Intercompan  Debits Credits
y
U1l 9.100 2200 — Accounts 00 2200
Payable
U2 9.100 1200 — Accounts 3.100 1800
Receivable
U3 9.100 1200 — Accounts 4.100 400
Receivable

Intercompany eliminations will only be performed for balances whose line items are
1200 — Accounts Receivable, 2200 — Accounts Payable or 2210 — Accounts Payable
Discounts, and whose intercompany value differs from 00. Balances S3, 54, S5, U2, and
U3 meet this criteria.

The eliminations will be written to the elimination entity of the common parent. The
eliminations will write to the same account, except reverse the debits and credits. The
eliminations will also be grouped according to company pairs. In this example, the pairs
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are 3 —9 and 4 - 9. Each grouping is balanced using the suspense account.

Here are the intercompany entries produced.

Intercompany entry: Companies 3 and 9

Organization Line Iltem Intercompany Debits Credits
3.100 2200 — Accounts 9.100 300

Payable
3.200 2210 — Accounts 9.100 1500

Payable Discounts

9.100 1200 — Accounts 3.100 1800
Receivable

The entry is balanced, so no balance is written to the suspense account.

Intercompany entry: Companies 4 and 9

Organization Line Iltem Intercompany Debits Credits

4.100 2200 — Accounts 9.100 450
Payable

9.100 1200 — Accounts 4.100 400
Receivable

9.100 3201 - AR/AP 4.100 50
Suspense

The entry is balanced by writing -50 USD to the designated suspense account in the
organization of the receivables entity. Since the suspense balance is below the threshold
amount of 100 USD, the entry will not produce a warning during consolidation.

Match by Organization

If the consolidation hierarchy option Match by Org was set to Organization instead of
Company, the intercompany elimination entries produced would be different. In this
case, the eliminations would be grouped according to organization pairs: 3.100 —9.100,
3.200 - 9.100, 4.100 - 9.100.
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Intercompany entry: Organizations 3.100 and 9.100

Organizatio Line Item Intercompany
n

3.100 2200 — Accounts Payable 9.100

9.100 1200 — Accounts Receivable  3.100

9.100 3201 — AR/AP Suspense 3.100

Debits Credits
300

1800
1500

The entry is balanced by writing 1500 USD to the designated suspense account in the
organization of the receivables entity. Since the suspense balance is above the threshold
amount of 100 USD, the entry will produce a warning during consolidation.

Intercompany entry: Organizations 3.200 and 9.100

Organization Line Iltem Intercompany Debits Credits
3.200 2210 — Accounts 9.100 1500

Payable Discounts
3.200 3201 - AR/AP 9.100 1500

Suspense

A suspense of -1500 USD is written to the organization of the receivables entity. The
suspense is above the threshold value and will cause a warning during consolidation.

Note: An Intercompany elimination is performed even if balances are
not found on one side of the transaction. Also, in the event that there
are no balances on the receivables side, suspense is written to the

payables entity.

Intercompany entry: Organizations 4.100 and 9.100

Organization Line Iltem Intercompany

Debits Credits

4.100 2200 — Accounts 9.100
Payable

450
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Organization Line Iltem Intercompany Debits Credits

9.100 1200 — Accounts 4.100 400
Receivable

9.100 3201 - AR/AP 4.100 50
Suspense

The entry is balanced by writing -50 USD to the designated suspense account in the
organization of the receivables entity. Since the suspense balance is below the threshold
amount of 100 USD, the entry will not produce a warning during consolidation.
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Overview

Setting Up Calendar Maps

A calendar map is a user-defined mechanism that defines the relationship between the
periods of two different calendars. The calendar map is used during consolidation
processing when the operating entity calendar is different from the consolidation
hierarchy calendar.

You assign each consolidation hierarchy a consolidation calendar. If an operational
entity has trial balances based on a different calendar, you define a calendar map to
relate the two calendars.

You define a calendar map between the periods in a source calendar and a target
calendar. A period represents a range of time, such as month, quarter, or year. A
calendar map is defined for the first year and then used for all subsequent years. You
can map multiple source periods into the same target period.

You define a calendar map for the first year and Financial Consolidation Hub
extrapolates the appropriate mapping for subsequent years.

Mapping Example

Suppose that an operating entity uses a 13 period monthly fiscal calendar, while
consolidation results are in a standard 12 period monthly accounting calendar. You can
define a calendar map to convert the fiscal calendar to the accounting calendar.

The fiscal calendar, Fiscal, has the following format for 2004. Each year follows the same
pattern.

Period Name Data Range

Apr-04 Apr 2, 2003 to Apr 30, 2003
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Period Name Data Range

May-04 May 1, 2003 to May 31, 2003

Jun-04 June 1, 2003 to June 30, 2003

Jul-04 July 1, 2003 to July 31, 2003

Aug-04 August 1, 2003 to August 31, 2003
Sep-04 September 1, 2003 to September 30, 2003
Oct-04 October 1, 2003 to October 31, 2003
Nov-04 November 1, 2003 to November 30, 2003
Dec-04 December 1, 2003 to December 31, 2003
Jan-04 January 1, 2004 to January 31, 2004
Feb-04 February 1, 2004 to February 28, 2004
Mar-04 March 1, 2004 to March 31, 2004

Adj-04 March 31, 2004 to March 31, 2004

The accounting calendar, Accounting, has the following format for 2004. Each year
follows the same pattern.

Period Name Data Range

Jan-04 January 1, 2004 to January 31, 2004
Feb-04 February 1, 2004 to February 28, 2004
Mar-04 March 1, 2004 to March 31, 2004
Apr-04 Apr 1, 2004 to Apr 30, 2004

May-04 May 1, 2004 to May 31, 2004
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Period Name Data Range

Jun-04 June 1, 2004 to June 30, 2004

Jul-04 July 1, 2004 to July 31, 2004

Aug-04 August 1, 2004 to August 31, 2004
Sep-04 September 1, 2004 to September 30, 2004
Oct-04 October 1, 2004 to October 31, 2004
Nov-04 November 1, 2004 to November 30, 2004
Dec-04 December 1, 2004 to December 31, 2004

In Financial Consolidation Hub, the calendar map would look like the following figure.

ORACLE" Financial Consolidation Hub

Home Logoul Hely Prefesences [eagnostcs

Consolidation | Data Submission | Acquisition and Disposal | Setug | Requests
Entity | Auditsbls Unit | Hierarchy Method | Rule | Colemdar | Rok | Rae | Fourdation
Calendar Map Details

Cancel I Finish Resaw

Spurce Cakerdar  Fiscal Target Calendy Accounting
Sowrce Calendar Group  General Ledger Aiscal Month Targat Calendar Group  General Ledger Month
Period Mappings
Source Period Target Period

Name Date Range Year  Name I Year Date Range
ApriHE 01 - Apr 1630 - Apr 2004 Bpr-03 = Frior = 01 - Apr 1030 - Apr
May-04 01 - May o 31 - May 2004 pd=y-03 = Frior "I 01 - May o 31 - May
Aune-04 01 - un to 30 - un 2004 b3 b Frior = 01 - unto 30 - Jun
by o1 -l w31 - L 2004 -3 a Frior -l o1 -l 31 -
-4 01 - Aug o 31 - sug 2004 Bug-03 .t Friof 'I 01 - Aug o 21 - Aug
Sep-04 01 - Sap o 30 - Sap 2004 EilE - Frior 'I 0 - Sap to 30 - Sap
Oct-04 01 - Oct bo 31 - Oct 2004 Eoiats] b Frio 'I D - Oct o 31 - Ock
o34 011 - Maw o 30 - Ko 2004 hlav-03 a, Frior = 001 - Maw o 30 - Now
D4 01l - Dec o 31 - Dec 2004 Cec-03 ., Frior "I 0l - Doeec to 31 - D
Jareld 01 = Jan to 31 = Jan 2004 1504 ! Curmert "I 01 = Jan to 31 = Jan
Fabrd 01 - Feb o 29 - Fab 2004 Feb-04 = urent "I 01 - Feb ko 29 - Fel
Mar-04 01 - Mar o 31 - Mar 2004 pdar-04 a Currerit 'I i1 - Mar to 31 - Mar
adi-04 21 - Mar 1o 31 - Mar 2004 flar-04 .t Current "I 01 - Mar 10 31 - Mar

Cancel | Finish Review

The periods are mapped according to their date ranges. For example, Apr-04 in the
fiscal calendar and Apr-03 in the accounting calendar both represent the date range Apr
01, 2003 to Apr 30, 2003. Also notice that the fiscal calendar periods Mar-04 and Adj-04
(the adjustment period) have both been mapped to Mar-04 in the accounting calendar.
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Setting Up Translation

Overview

Different entities can operate in different currencies, but for consolidation purposes, it is
critical to standardize to a common currency. During consolidation processing,
Financial Consolidation Hub automatically translates any entity's balances from the
child's currency to the parent's currency if the two currencies are different.

Translation is applied according to the rules specified in a translation method. You can
define as many translation methods as needed due to differences in translation practices
across different industries, countries, or ownership relationships.

Note: Financial Consolidation Hub translation methods address both
translation and remeasurement in accordance with FAS 52 and IAS 21.

Translation Method

A translation method is a collection of settings that determines the currency processing
that is applied to a parent/child relationship during consolidation.

Translation methods include settings for the following:

¢ Equity translation method

* Income statement translation method
e Translation adjustment account

¢ Ending rate type

* Average rate type
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Assigning Translation Methods

You assign translation methods at the level of the relationship between two entities.
When you create or update a consolidation hierarchy, specify a translation method for
any child entity whose currency differs from its parent's currency.

See: Creating Consolidation Hierarchy Structures, page 13-6

Note: Once a relationship is part of a consolidation process, the
translation method can no longer be updated.

Selected User Interface Elements for Setting Up Translation Methods

Selected user interface elements are described below.

Ending Rate Type and Average Rate Type

Equity Mode

Ending rates are generally used to translate balance sheet accounts. Average rates are
generally used to translate income statement accounts. Since Oracle Applications offer
the ability to enter multiple conversion rates for a given currency pair, specify which
conversion rate type to use for ending rates and which types to use for average rates.
Common examples of rate types are Corporate and Spot, though you can define
additional rate types as needed. You should have rate types which represent the ending
and average rates needed for translation.

See: Currency Rates Manager, Oracle General Ledger User Guide

You can specify whether you want Financial Consolidation Hub to use the Year-to-Date
(YTD) balances or period activity (PTD) to translate equity accounts, such as retained
earnings and other equity accounts.

A YTD specification translates ending balances using the ending rate. The period
activity is then calculated from the difference between the current period's ending
balance and prior period's ending balance.

A PTD specification translates current period activity using the average rate. The
ending balance is then calculated by summing the translated period activity and the
prior period's ending translated balance.

The most common option in accordance with FAS 52 and IAS 21 is to use the YTD
option for equity accounts.

Note: Regardless of the equity mode you choose, if you enter an
historical rate or amount for a given equity account, Financial
Consolidation Hub translates that account using the historical rate or
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amount. Historical rates or amounts thus override ending and average
rates.

Income Statement Mode

Use as Default

You can specify whether you want Financial Consolidation Hub to use the YID or PTD
to translate income statement account balances.

A YTD specification translates ending balances using the ending rate. The period
activity is then calculated from the difference between the current period's ending
balance and the prior period's ending balance

A PTD specification translates current period activity using the average rate. The
ending balance is then calculated by summing the translated period activity and the
prior period's translated ending balance.

The most common option in accordance with FAS 52 and IAS 21 is to use the PTD
option for income statement accounts.

Note: Regardless of the income statement mode you choose, if you
enter an historical rate or amount for a given income statement account,
Financial Consolidation Hub translates that account using the historical
rate or amount. Historical rates or amounts thus override ending and
average rates.

You can designate a translation method as the default by selecting an option from the
Use as Default drop-down list in the Create Translation Method page.

When you construct a consolidation hierarchy, the default translation method is
automatically assigned to the relationship attributes between a consolidation entity and
its child operating entities. You can change the default translation method.

Enable Translation Method

If you select No from the Enable Translation Method drop-down list in the Create
Translation Method page, the translation method you defined is unavailable when you
create a consolidation hierarchy. If a translation method is disabled, it can no longer be
used in the construction of a new consolidation hierarchy.

Note: A disabled translation method will continue to be used in
existing consolidation hierarchies that already include it and will
continue to be processed during the Consolidation Process.
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Entering Ending and Average Rates

Ending and average rates are exchange rates expressed in decimal form that are used to
translate the balances in one currency into another. Typically, ending rates apply to
balance sheet accounts. Average rates typically apply to income and expense accounts.

Note: Currency Rates Manager stores daily rates. When you run a
consolidation, Financial Consolidation Hub uses the rate assigned to
the last day of the period being processed.

You enter ending and average rates using Currency Rates Manager. To access Currency
Rates Manager, select the General Ledger SuperUser responsibility or have your System
Administrator add this functionality to any other responsibility. Navigate as follows:
Setup > Currencies > Currency Rates Manager.

To define rate types, select Rate Types from the menu to open the Rate Types page. To
define ending or average rates, select Daily Rates from the menu to open the Daily
Rates page.

See: Currency Rates Manager, Oracle General Ledger User Guide

Related Topics
Historical Rates, page 12-4

Historical Rates

Historical rates or historical amounts apply to a specific account and, if they exist, are
automatically used by Financial Consolidation Hub instead of the ending or average
rate. The historical rate or amount assignment is specific to an account associated with
an entity that is assigned to a consolidation hierarchy. Historical rates and amounts are
user-defined rates or amounts, generally for the following:

¢ Non-monetary assets

* Non-monetary liabilities

¢ Owner's equity accounts

¢ Revenues or expenses associated with non-monetary assets or liabilities

Non-monetary assets include both tangible items, such as land, and intangible items,
such as rights. They can also be associated with income statement accounts with a
non-monetary basis, such as Cost of Goods Sold and Depreciation. Non-monetary items
are not readily convertible to cash, hence their values are associated with their historical
worth.
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Defining Historical Rates

Before you run a consolidation process that uses historical rates, define historical rates
where applicable. You enter historical rates or amounts for specific combinations of
dimension values. The Historical Rates spreadsheet will show only the dimensions to be
used for Historical Rates. For example, you may have a line item called Land, which
you use to track the investment in land for each organization and/or entity. The
historical amount for land will likely vary from organization to organization based on
the value of the land, when it was acquired, and so on. You therefore enter a specific
historical rate for land for each relevant organization. During translation, Financial
Consolidation uses historical rates or amounts wherever they are defined. Thus,
historical rates or amounts override ending and average rates.

Selected User Interface Elements for Defining Historical Rates

Financial Consolidation Hub provides a WebADI spreadsheet loader for calculating
and entering historical rates. This interface is accessible from the Translation Rate Page.

Note: You can upload rates for multiple entities in a single workbook.

See: Appendix B: WebADI Spreadsheets, page A-1

For each combination of dimension members, enter either a historical rate or amount.
Historical rates are multiplied by the base currency balances to calculate translated
balances. Historical amounts are not multiplied; they are used as is. Rate Type defaults
to Historical and you should not change this when you are entering historical rates.

Note: If you enter in a historical amount, the amount will be considered
a credit, not a debit.

If you enter a historical rate for an asset or liability account in one period, it is rolled
forward automatically to the next period with a rate type of Prior. Historical rates for
equity accounts are also rolled forward if the YTD specification is specified for the
Equity Mode. Thus, if you use the same historical rate throughout a year, you only need
to enter it once.

Financial Consolidation Hub automatically calculates a historical rate for retained
earnings accounts in the first period of each new year, based on the prior year's
profitability when you use the YTD specification for your equity accounts. These rates
are created with rate type Calculated.

You can update historical rates using the spreadsheet loader.

When you define a consolidation hierarchy, you define a specific dimension member
combination to use as the Retained Earnings account. Therefore, when you create
Historical Rates for the retained earnings of a consolidation hierarchy, the values you
can select for each dimension are limited by the Retained Earnings account you had
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specified for the hierarchy.

Translation Example

Vision: Canada uses Canadian Dollars (CAD) as its functional currency but consolidates
to Vision: North Americas Group which is based in USD. Thus, Financial Consolidation
Hub translates from CAD to USD during the consolidation process.

Vision: Canada is assigned a currency type of Translation, which uses an ending rate
type called Ending, an average rate type called Average, PTD mode for income
statements, and YTD mode for equity. It posts translation adjustments against the
Cumulative Translation Adjustment line item. The following table shows Vision:
Canada's trial balance for January 2005.

Vision: Canada's Trial Balance for January 2005

Entity Line Item Dr (CAD) Cr (CAD)
Vision: Canada Cash 1000 400
Vision: Canada Accounts Receivable 1200 500
Vision: Canada Accounts Payable 500 700
Vision: Canada Paid-in Capital 0 400
Vision: Canada Retained Earnings 0 300
Vision: Canada Revenue 0 2000
Vision: Canada Cost of Goods Sold 1100 0

Vision: Canada Salaries 400 0

The ending rate in January is 0.8. The average rate is 0.7. Since the translation method
uses YTD mode for equity accounts and PTD mode for income statement accounts,
Financial Consolidation Hub uses the ending rate for the balance sheet and the average
rate for the income statement. However, there is an historical rate of 0.84 for Retained
Earnings and Paid-in Capital, and this overrides the ending rate for those accounts. The
following table shows the rates used by translation for Vision: Canada.
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Rates Used by Translation for Vision: Canada

Entity Line ltem Dr (CAD) Cr (CAD) Rate
Vision: Canada Cash 1000 400 0.8
Vision: Canada Accounts Receivable 1200 500 0.8
Vision: Canada Accounts Payable 500 700 0.8
Vision: Canada Paid-in Capital 0 400 0.84
Vision: Canada Retained Earnings 0 300 0.84
Vision: Canada Revenue 0 2000 0.7
Vision: Canada Cost of Goods Sold 1100 0 0.7
Vision: Canada Salaries 400 0 0.7

Since the balance sheet was multiplied by the ending rate and the income statement by
the average rate (and equities by an historical rate), the ending USD balances require a

credit of 58 posted to Cumulative Translation Adjustment to ensure proper balancing as
shown in the following table.

Translated Results for Vision: Canada

Entity Line Item Dr (CAD) Cr (CAD) Rate Dr (USD) Cr (USD)
Vision: Cash 1000 400 0.8 800 320
Canada

Vision: Accounts 1200 500 0.8 960 400
Canada Receivable

Vision: Accounts 500 700 0.8 400 560
Canada Payable

Vision: Paid-in 0 400 0.84 0 336
Canada Capital
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Entity Line Item Dr (CAD) Cr (CAD) Rate Dr (USD) Cr (USD)
Vision: Retained 0 300 0.84 0 252
Canada Earnings
Vision: Revenue 0 2000 0.7 0 1400
Canada
Vision: Cost of 1100 0 0.7 770 0
Canada Goods Sold
Vision: Salaries 400 0 0.7 280 0
Canada
Vision: Cumulative 0 0 N/A 0 58
Canada Translation

Adjustment

In February, there is some activity, so you now look at both the PTD and YTD balances.

The following table shows the February trial balance for Vision: Canada.

Vision: Canada Trial Balance for February

Entity Line Item PTD Dr PTD Cr YTD Dr YTD Cr
(CAD) (CAD) (CAD) (CAD)

Vision: Canada  Cash 0 0 1000 400

Vision: Canada  Accounts 200 0 1400 500
Receivable

Vision: Canada  Accounts 0 0 500 700
Payable

Vision: Canada  Paid-in Capital 0 0 0 400

Vision: Canada  Retained 0 0 0 300
Earnings

Vision: Canada  Revenue 50 400 50 2400
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Entity Line Item PTD Dr PTD Cr YTD Dr YTD Cr

(CAD) (CAD) (CAD) (CAD)
Vision: Canada  Cost of Goods 100 0 1200 0
Sold
Vision: Canada  Salaries 50 0 450 0

The January balances plus the February PTD balances equal the February YTD balances.
You can now translate the February balances at the appropriate rates for February. Note
the historical rate for equities has not changed, but the ending and average rates have.

The following table shows the translation rates for February.

Translation Rates for February

Entity Line Item PTD Dr PTD Cr YTD Dr YTD Cr Rate
(CAD) (CAD) (CAD) (CAD)

Vision: Cash 0 0 1000 400 0.81

Canada

Vision: Accounts 200 0 1400 500 0.81

Canada Receivable

Vision: Accounts 0 0 500 700 0.81

Canada Payable

Vision: Paid-in 0 0 0 400 0.84

Canada Capital

Vision: Retained 0 0 0 300 0.84

Canada Earnings

Vision: Revenue 50 400 50 2400 0.72

Canada

Vision: Cost of 100 0 1200 0 0.72

Canada Goods Sold

Vision: Salaries 50 0 450 0 0.72

Canada

Since the translation method uses YTD mode for balance sheet accounts and PTD mode
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for income statement accounts, you multiply the YTD balances by the ending rate for
balance sheet accounts and the PTD balances by the average rate for income statement
accounts.

The following table shows intermediate translation results for February.

Intermediate Translation Results for February

Entity Line Item PTDDr PTDCr YTDDr YTD Rate PTD PTD YTD YTD
(CAD) (CAD) (CAD) Cr Dr Cr Dr Cr

(CAD (USD) (USD) (USD) (USD)
)

Vision: Cash 0 0 1000 400 0.81 810 324

Canada

Vision: Accounts 200 0 1400 500 0.81 1134 405

Canada Receivable

Vision: Accounts 0 0 500 700 0.81 405 567

Canada Payable

Vision: Paid-in Capital 0 0 0 400 0.84 0 336

Canada

Vision: Retained 0 0 0 300 0.84 0 252

Canada Earnings

Vision: Revenue 50 400 50 2400 0.72 36 288

Canada

Vision: Cost of Goods 100 0 1200 0 0.72 72 0

Canada Sold

Vision: Salaries 50 0 450 0 0.72 36 0

Canada

Financial Consolidation Hub then calculates the PTD debits and credits for balance
sheet accounts by subtracting the prior period's YID debits and credits from the current
period's YTD debits and credits.

The YTD debits and credits for income statement accounts are calculated by adding the
current period's PTD debits and credits to the prior period's YTD debits and credits.

The following table shows final translation results for February.

12-10 Oracle Financial Consolidation Hub User's Guide



Final Translation Results for February

Entity Line Item PTDDr PTD YTDDr YTD Rate PTD PTD YTD YTD Cr
(CAD) Cr (CAD) Cr Dr Cr Dr (USD)
(CAD) (CAD) (USD) (USD) (USD)
Vision: Cash 0 0 1000 400 0.81 10 4 810 324
Canada
Vision: Accounts 200 0 1400 500 0.81 174 5 1134 405
Canada Receivable
Vision: Accounts 0 0 500 700 0.81 5 7 405 567
Canada Payable
Vision: Paid-in 0 0 0 400 0.84 0 0 0 336
Canada Capital
Vision: Retained 0 0 0 300 0.84 0 0 0 252
Canada Earnings
Vision: Revenue 50 400 50 2400 0.72 36 288 36 1688
Canada
Vision: Cost of 100 0 1200 0 0.72 72 0 842 0
Canada Goods
Sold
Vision: Salaries 50 0 450 0 0.72 36 0 316 0
Canada

Again, since different rates are used for different accounts, there is a remainder which
must be posted as Cumulative Translation Adjustment as shown in the following table.
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Final Translation Results for February

Entity Line PTD PTD YTDDr YTD Rat PTD PTD YTD YTD

Item Dr Cr (CAD) Cr e Dr Cr Dr Cr
(CAD) (CAD (CAD) (USD (US (UsSD (UsD)
) D) )

Vision Cash 0 0 1000 400 0.81 10 4 810 324

Canad

a

Vision Account 200 0 1400 500 081 174 5 1134 405

: S

Canad Receivab

a le

Vision Account 0 0 500 700 0.81 5 7 405 567

: S

Canad Payable

a

Vision Paid-in 0 0 0 400 084 0 0 0 336

: Capital

Canad

a

Vision Retained 0 0 0 300 084 0 0 0 252

: Earnings

Canad

a

Vision Revenue 50 400 50 2400 0.72 36 288 36 1688

Canad

a

Vision Cost of 100 0 1200 0 072 72 0 842 0

: Goods

Canad Sold

a

Vision Salaries 50 0 450 0 0.72 36 0 316 0

Canad

a
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Entity Line PTD PTD YTDDr YTD Rat PTD PTD YTD YTD

Item Dr Cr (CAD) Cr e Dr Cr Dr Cr
(CAD) (CAD (CAD) (USD (US (UsSD (UsD)
) D) )

Vision Cumulat N/A 0 29 29 0
: ive
Canad Translati
a on
Adjustm
ent
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Overview

Setting Up Consolidation Hierarchies

A consolidation hierarchy is a user-defined, date-effective structure that represents the
parent/child relationships of entities that are processed during consolidation. When
submitting a consolidation hierarchy for processing, the hierarchy relationship structure
used is that effective on the last day of the period being processed.

You can define multiple consolidation hierarchies to meet a variety of consolidation
needs, including hierarchies for statutory, U.S. GAAP, local GAAP, taxation, what-if,
and other reporting purposes. You can use the same entity in multiple consolidation
hierarchies. Data submitted for an entity is available across all hierarchies in which the
entity is used.

Consolidation Hierarchy Structure

A consolidation hierarchy structure comprises consolidation entities, elimination
entities, and operating entities. Each entity, other than the top entity, has relationship
attributes that define the nature of its association with its parent or parents.

Consolidation Hierarchy in Enterprise Performance Foundation

When you create a consolidation hierarchy in Financial Consolidation Hub,
corresponding Enterprise Performance Foundation structures are automatically created.

A consolidation hierarchy in Financial Consolidation Hub corresponds to a dimension
hierarchy in the default value set for the Entity dimension. The hierarchy is named
<consolidation hierarchy> effective since <start date of hierarchy>.

Note: A consolidation hierarchy created in Financial Consolidation Hub
has specific parameters attached to it. Thus, you can view a
consolidation hierarchy created in Financial Consolidation Hub in
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Enterprise Performance Foundation, but not vice versa.

A ledger is also created for the consolidation hierarchy, with the name in the format
<hierarchy name>ledger.

When you are pulling consolidation results into Analytical Reporting, select this ledger.

Four data sets are also created for the hierarchy.

Data Set Description

<Hierarchy Name>: Actual Holds consolidated actual results for the
consolidation hierarchy

<Hierarchy Name>: Average Holds the consolidated average results for the
consolidation hierarchy

<Number>: Actual Used for backend processing

<Number>: Average Used for backend processing

When you are pulling consolidation results into Analytical Reporting, select the data set
<Hierarchy Name>: Actual. . If you will be reporting on average balances, also select the
data set <Hierarchy Name>: Average.

In addition, two data sets are created for each additional data type that you have

created:

<Hierarchy Name>: <Data Type Name> Holds the consolidated results for the
consolidation hierarchy and data type

<Number>: <Data Type Name> Used for backend processing

When you are pulling consolidation results into Analytical Reporting and if you are
reporting on an additional data type, select the data set <Hierarchy Name> : <Data Type
Name>.

To view the Ledger and Data Sets of a consolidation hierarchy, view or update the
consolidation hierarchy and click on Information for Analytical Reporting.

See: Setting Up Analytical Reports, page 19-1

Setting Up Consolidation Hierarchies

The setup for a hierarchy consists of two parts.
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Consolidation hierarchy attributes, which apply to the entire hierarchy.

Consolidation hierarchy structure, which defines the entities and parent-child
relationships between them.

Note: When you create a consolidation hierarchy, Financial
Consolidation Hub launches the FCH: Hierarchy Initialization
concurrent program. Monitor the request and verify that it completes
successfully.

Consolidation Hierarchy Attributes

The first step in setting up a consolidation hierarchy is to define the consolidation
hierarchy attributes that apply to the entire hierarchy. Defining consolidation hierarchy
attributes includes specifying the following:

General Attributes

General attributes
Security options
Intercompany options
Balancing options
Retained earnings

Suspense handling

Note: To view the retained earnings and suspense handling options for
an existing hierarchy, view the hierarchy and click Details for the
topmost entity.

In the top region of the attributes page, define the general attributes of the consolidation
hierarchy.

Name - The name of the consolidation hierarchy you are creating.
Description - An optional description for the hierarchy you are creating.

Start Date - This is the earliest date for which you can run consolidation for the
hierarchy.

Top Level Entity - The topmost consolidation entity that is not owned by any other
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entities.

e Currency - The currency for the consolidation results for the hierarchy. All of the
entities' currencies are converted to this currency.

¢ Consolidation Calendar - The calendar for the consolidation results for the
hierarchy. All of the entities' calendars are converted to this calendar.

® Calendar Group - The level of granularity for the consolidation calendar such as
month, quarter, or year.

® Use for Certification - If you use Oracle Internal Controls Manager, you can
integrate Financial Consolidation Hub with that product. Select yes to enable
certification for the hierarchy.

See: Integrating with Internal Controls Manager, page 22-1

Note: Only one consolidation hierarchy can have certification enabled.

Security Options
In the Security Options region of the attributes page, set the security for the
consolidation hierarchy.

e Secure by Role - Select No to allow all users access to the consolidation hierarchy.
Select Yes to specify which users have access to the hierarchy.

See: Securing Consolidation Hierarchies, page 21-2

Intercompany Options

In the Intercompany Options region of the attributes page, specify how intercompany
balances are identified and matched.

Match Intercompany By - Select to match intercompany by Company or Organization.

Perform Line of Business Eliminations - If you select Match Intercompany by
Organization and your consolidation chart of accounts was defined in Oracle General
Ledger, then the Perform Line of Business Eliminations option would show up.

Line of Business Hierarchy - If you select Yes in Perform Line of Business Eliminations,
then you must select your Line of Business Hierarchy that contains your Elimination
Business Lines.

Note: This functionality requires your consolidation chart to be sourced
from Oracle General Ledger. In addition, the cost center segment must

be included in your organization dimension, and mapped individually
to User Dimension 1.
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See: Example of How an Intercompany Rule Works, page 10-3

Balancing Options

In the Balancing Options region of the attributes page, select additional balancing
options and specify retained earnings and suspense handling accounts.

You can select a dimension, in addition to entity, to balance results. Balancing is
enforced during consolidation. The following examples are a few ways that
consolidation can get out of balance:

® The companies assigned to an entity are modified. When you run consolidation,
data preparation pulls balances for the assigned companies, resulting in an out of
balance.

* A consolidation rule might produce an entry that is not balanced.

In addition to balancing by entity, you can also balance by Organization and/or one
additional dimension.

¢ Balance by Organization - Select Yes to balance by organization.

* Balance by an Additional Dimension - Select a dimension to balance by that
dimension.

Note: Balancing options do not apply to intracompany and
intercompany elimination entries, since they balance by entity only.

Note: If you are consolidating a user-defined data type, balancing may
or may not be enforced, depending on the definition of the data type.

See: Task 3: Data Types, page 5-6

Retained Earnings
In the Retained Earning region of the Balancing Options, specify the account to be used

for retained earnings.

The retained earnings account is used to close profit and loss activity into retained
earnings accounts at year-end. This occurs in the Translation category, and for recurring
entries and adjustments that cross the year-end boundary. In addition, user-defined
categories, with the exception of Intercompany and Intracompany, may also be set up to
close entries to retained earnings.

See: Net to Retained Earnings at Year-End, page 7-5

Suspense Handling

In the Suspense Handling region of the Balancing Options, specify the account to be
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used for suspense handling.

During consolidation, when results are out of balance, Financial Consolidation Hub will
write to the suspense account to balance the results.

You also specify a threshold amount and currency for suspense handling notifications
and warnings. If the suspense amount is greater than the threshold amount or currency,
a warning will be raised in the consolidation process and a notification sent to the
appropriate contacts.

Note: A threshold violation warning will not stop consolidation
processing.

Consolidation Hierarchy Structures

A consolidation hierarchy structure is constructed by defining parent-child
relationships between entities using the following attributes:

*  Ownership percentage
e Consolidation method
e Translation method

When you are creating or duplicating a hierarchy, you can define the consolidation
hierarchy structure manually in the user interface, or by uploading the information
from a spreadsheet.

Ownership Percentage

The ownership percentage specifies how much the entity is owned by its parent. The
ownership percentage cannot exceed 100%. In the case of an entity having multiple
parents, the total ownership percentage of the entity cannot exceed 100%.

See: Multiple Parents , page 13-9

Consolidation Method

Specify a consolidation method for the entity. The consolidation method determines
which balances of the entity is aggregated to its parent, and which consolidation rules
are applied.

See: Setting Up Consolidation Methods, page 8-1

In the case of an entity having multiple parents, at most one of the relationships may be
assigned a consolidation method of type Full. All of the other relationships must be
assigned a method of type None.

See: Multiple Parents, page 13-9
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Translation Method

If an entity has a different local currency than its parent, specify a translation method.

See: Translation Method, page 12-1

Uploading Hierarchy Structures

When you create or duplicate a hierarchy, you can create the hierarchy structure using a
spreadsheet loader.

Note: The spreadsheet loader is not a WebADI spreadsheet loader.

The following rules apply to the hierarchy loader:

e [If default translation or consolidation methods are defined, these columns are
optional.

¢ If a child entity's currency is the same as that of its parent, a translation method is
not required.

* A consolidation entity, elimination entity, and its controlling entity are treated as
one entity, under the name of the consolidation entity.

* After you upload the spreadsheet to Financial Consolidation Hub, you can further
modify and add to the hierarchy using the Create Consolidation Hierarchy: Define
Structure page.

Warning: The existing structure for the hierarchy you are creating will
be replaced by a spreadsheet upload.

After you upload a hierarchy, the hierarchy structure is validated before it is accepted
and made available. If there are any errors, an error message is displayed and the entire
structure is not accepted. You can view the upload errors by downloading the
spreadsheet. Invalid spreadsheet cells are marked with red and the descriptions of the
errors are written in the error message column of the spreadsheet. After you fix the
errors, you can resubmit the spreadsheet. The successfully uploaded hierarchy appears
in the Create Consolidation Hierarchy: Define Structure page.

Updating Consolidation Hierarchies

You can make date-effective changes to the structure of a consolidation hierarchy. This
includes additions and deletions of entities as well as updates to relationship attributes.
The Effective Date field in the Update Consolidation Hierarchy Page enables you to
view the hierarchy as of any date specified. It also determines the date upon which
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changes entered will become effective.

Caution: When entering changes to a hierarchy, specify the correct
effective date at the top of the page.

When you update a consolidation hierarchy, Financial Consolidation Hub will show an
Impact Analysis page. This page will show the following;:

¢ The change history of the relationship that was updated.
¢ Impacts to existing consolidation runs.
® The Acquisition and Disposal Transaction created to track the update.

Updates to consolidation hierarchies generate impacts that are visible on the
Consolidation Process page. Notifications are also sent to the contacts of impacted
consolidation entities.

See: Process Status, page 15-2

Hierarchy changes are tracked to provide an audit trail accessible using the Acquisition
and Disposal tab. When you update, you have the option to create an acquisition or
disposal accounting entry to associate with the change.

¢ Remove an entity - To create an accounting entry, select Yes for Create Accounting

and specify a To Consolidation Method.

® Add an entity - To create an accounting entry, select Yes for Create Accounting and
specify a From Consolidation Method.

* Update an entity - To create an accounting entry, select in the Create Accounting list
Acquisition, Disposal, Share Issue with Acquisition or Share Issue with Disposal.

Note: If you increase the ownership, you cannot select Disposal. If you
decrease the ownership, you cannot select Acquisition.

See Create Accounting for Consolidation Hierarchy Changes , page 17-2

Note: You cannot update hierarchies using the hierarchy loader.

You can view all of the updates made to a consolidation hierarchy
using the Acquisition and Disposal tab.

Viewing Consolidation Hierarchies

You can view a consolidation hierarchy for a specific date. Fill in the Effective Date field
with the desired date. To view Retained Earnings and Suspense Handling attributes,
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click on Details for the topmost entity.

You can also view the consolidation hierarchy in PDF and Excel form by clicking on the
respective icons.

See: Hierarchy Listing Report, page 18-5

Duplicate Hierarchies for Restatements and What-if Analysis

The Consolidation Hierarchy page enables you to duplicate hierarchies. You can
duplicate hierarchies for a variety of purposes, including restatements and creation of
what-if scenarios. Duplicating a hierarchy creates a snapshot of the hierarchy as of the
date specified in the Copy Hierarchy as of field of the Duplicate Consolidation
Hierarchy page. The change history of the source hierarchy is not copied into the
duplicate.

The Duplicate Consolidation Hierarchy - Define Attributes page enables hierarchy
attributes to be modified before the duplicate is created. As part of this process, you can
move the hierarchy snapshot forward or backwards in time by changing the Start Date
field. Duplicated hierarchies share no linkage to the source hierarchies from which they
are created. A change to one does not impact the other. Therefore, you can create as
many duplicate hierarchies as you need and modify them in different ways to reflect
various what-if scenarios.

Restatements are an example of when duplicate hierarchies may be useful. For example,
you may need to restate financials after a significant year-end merger to provide a view
of consolidated results, as if the two companies operated as a single enterprise for the
entire year. Therefore, you can create a duplicate as of the end of the year and move the
structure back in time to the beginning of the year. Processing consolidation for this
hierarchy over the entire 12 months provides consolidated results for all periods in the
year using the hierarchy structure as of the end of the year.

Multiple Parents

Consolidation hierarchies support entities owned by multiple parents.

Note: Financial Consolidation Hub does not support the case of
reciprocal parents. For example, USA owning Canada and Canada
owning USA.

To add additional parents to an entity, update the relationship for the entity. In the
Multiple Parent region, you will see the existing parents and ownership percentages for
the entity. You can add additional parents here.

For multiple parent scenarios, these are the following constraints:

* The total ownership percentage of the entity cannot exceed 100%.
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* At most one relationship for the entity may be set to a consolidation method of type
Full. All other relationships for the entity must be set to consolidation methods of
type None. This constraint forces the entity to be consolidated up just one branch of
the consolidation hierarchy.

You can also have consolidation rules to handle multiple parent scenarios. Set the
Reprocess for Multiple Parents to yes in the category assigned to the rule. As the entity
is consolidated up each consolidation entity, Financial Consolidation Hub checks to see
if the entity is owned through another path. If it is, the additional ownership is
calculated. An additional consolidation entry is written based on the consolidation rule
and the additional ownership, in the currency of the consolidation entity.

Note: Multiple Parent reprocessing only affects consolidation rules
which use the %OWN and %MI tokens.

Multiple Parents Example

In the following hierarchy, Mexico has multiple parents: Americas Group, North
Americas Group, South Americas Group and Colombia.

Assume the consolidation method Vision Consolidation Full is type Full and Vision Not
Consolidated is type none.

- -
Eniti Entity Type Ownership (%)  Currency Code  Consolidation Method — Translation Miethod
| AlwRBricas Group Consolidation Entity =)
Ieicg Ciper ating Entity 10 i Vision Mot Consolidatad
=1 Morth Americss Grous Consolidation Ertity B0 LIsD Vision Consolidation Full
USa Ciperating Entity Controlling usD
Mexioo Ciper ating Entity i) MxP Vision Consolidation Full Standard Translation
MNoarth Americas Elim Elimnation Entity LD
™ = South Americas Group Consolidation Entty 60 BRL Vision Consolidation Full Stardard Trarslation -
Brazi Oiperating Entity Contralling BRL
Mex oo Dperating Ertity 7 MYF Vizion Mot Consolidated
= Colombla Consolidation Entity 100 COP Vizlon Consolidation Full Standard Trarelation
Mexico Cipér ating Ertity ] MxP Vision Mot Consolidated
Colnribia Elifme Elirmination Entity CoP
Soul ericas Elin Elirmirnation Ertity BRL
Americas Elims Eliminaton Ertity _uso 1]

Following the multiple parents constraint, Mexico has a consolidation method of type
Full in only one relationship, with the parent North Americas Group. In addition, the
total ownership percentage of Mexico is 95%, which is below the 100% constraint.

The consolidation method Vision Consolidation Full contains a minority interest
consolidation rule. Assume the Minority Interest category has Reprocess for Multiple
Parents set to Yes.
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Mexico has the following balances in Mexican Peso. Assume the conversion rate fro
Mexican Peso to US dollars is 0.09.

Organization Line Item Debits Credits
15.100 4000 - Revenue 10000
15.100 1100 - Cash 10000

First, Mexico is consolidated to North Americas Group. Its balances are converted to US
dollars.

Organization Line Item Debits Credits
15.100 4000 - Revenue 900
15.100 1100 - Cash 900

The minority interest consolidation rule produces the following entry in US dollars.

Organization Line Item Debits Credits
15.100 3650 — Minority Interest B/S 270
15.100 5450 — Minority Interest P/L 270
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North Americas Group does not own Mexico through any other branches, so no
multiple parent calculations are performed.

Next, North Americas Group is consolidated to Americas Group. At this point, Mexico
is owned through additional branches: Americas Group > Mexico, Americas Group >
South Americas Group > Mexico and Americas Group > South Americas Group >
Colombia > Mexico.

Americas Group >Mexico

Americas Group owns 10% of Mexico. The minority interest consolidation rule will
produce the following consolidation entry in the currency of Americas Group, US

dollars.

Organization Line Item Debits Credits
15.100 3650 — Minority Interest B/S 90

15.100 5450 — Minority Interest P/L 90

The consolidation rule will calculate the balance as the change in minority ownership
times the trial balance: (-0.10) * 900 = -90. This balance is added back.

Americas Group > South Americas Group > Mexico

Americas Group owns 60% of South Americas Group, which owns 7% of Mexico. Thus,
Americas Group owns 60% * 7% = 4.2% of Mexico through this branch. The minority
interest consolidation rule will produce the following consolidation entry in the
currency of Americas Group, US dollars.

Organization Line Item Debits Credits
15.100 3650 — Minority Interest B/S 37.8
15.100 5450 — Minority Interest P/L 37.8

The consolidation rule will calculate the balance as the change in minority ownership
times the trial balance: (-0.042) * 900 = -37.8. This balance is added back.

Americas Group > South Americas Group > Colombia > Mexico

Americas Group owns 60% of South Americas Group, which owns 100% of Colombia,
which owns 8% of Mexico. Thus, Americas Group owns 60% * 100% * 8% = 4.8% of
Mexico through this branch. The minority interest consolidation rule will produce the
following consolidation entry in the currency of Americas Group, US dollars.
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Organization Line Item Debits Credits

15.100 3650 — Minority Interest B/S 43.2

15.100 5450 — Minority Interest P/L 43.2

The consolidation rule will calculate the balance as the change in minority ownership
times the trial balance: (-0.048) * 900 = -43.2. This balance is added back.
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Submitting Data

Overview

Data Submission enables you to submit trial balances for operating entities. Depending
on the source system, the methods for submitting balances are as follows:

®  Oracle Source - To source from Oracle General Ledger, you can automatically
submit financial data from General Ledger to Financial Consolidation Hub.

¢ External Source - These are all source systems other than Oracle General Ledger.
You can copy and paste the trial balance from these systems into a spreadsheet
loader provided by Financial Consolidation Hub. You can optionally apply
transformation rules as needed to convert data from the external source system into
the format you use in Financial Consolidation Hub.

¢ Open Interface Tables - You can push data from your source system into open
interface tables, and then push the data into Financial Consolidation Hub.

This chapter will cover Oracle and external sources.

See: Open Interface Tables, page B-1.

Additional Data Types

If you have additional data types assigned to the entity, you can run data submission
for those data types. For an entity, each balance type can have a different designated
source system.

Data Submission and the Enterprise Performance Foundation

When you submit balances in Financial Consolidation Hub, the balances are written to
the FEM_BALANCES table in the Enterprise Performance Foundation. Financial
Consolidation Hub provides all of the necessary tools to monitor and maintain the
balances. For information on how to monitor the balances using the EPF user interface,
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see the Oracle Enterprise Performance Foundation User Guide.

Related Topics

Setting Up Data Submission for Oracle Entities, page 14-4

Submitting Data for Oracle Sources, page 14-6

Setting Up Data Submission for External Entities, page 14-10

Submitting Data for External Entities, page 14-11

Monitoring Data Submission

A data submission online interface allows you to execute and monitor data

submissions.

View Status

You can view the status icon of a data submission to see if it completes successfully or
with warnings or errors.

Data submissions can have the following statuses:

In Progress - The data submission is currently being processed. For external source
submissions, the status is set to in progress when the spreadsheet is uploaded.

Impacted - This status applies only to data submissions that source from Oracle
General Ledger. The status is impacted if the balances in Oracle General Ledger
have changed after the data submission was performed.

Completed - The data submission completed successfully. The balances have been
loaded into Financial Consolidation Hub.

Warning - The data submission completed but there is a warning. The balances may
or may not have been loaded into Financial Consolidation Hub depending on the
warning,.

Error - The data submission has resulted in an error. No balances were loaded into
Financial Consolidation Hub.

Undone - This status applies only to data submissions that source from Oracle
General Ledger. The status is undone if the balances rule corresponding to the data
submission was undone in Enterprise Performance Foundation. If a data
submission is undone, all of the data submission balances for that entity, period,
and balance type are removed.

If a data submission has warnings or errors, you can go to the Status Page to diagnose
the problem.
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Status Page

You can click on the status icon to see the all of the parameters of the data submission.
The status page also links to the concurrent request launched by the data submission
and the view data loaded report. If you are diagnosing a problem, it may be listed on
the concurrent request log and/or the view data loaded report.

View Data Loaded

For a data submission with an External source, you can view the balances that were
loaded by that particular data submission. From the status page, you can access the
Data Submission Data Loaded Report. If the data submission did not complete
successfully, errors in the balances you submitted may be marked in this report.

See: Data Submission Data Loaded Report, page 18-4
View Impacted Balances

If a data submission has the Impacted status, you can view the balances in Oracle
General Ledger that are impacting the data submission. From the status page, you can
access the Data Submission Impacted Balances Report.

See: Impacted Trial Balances Report, page 18-4
View Trial Balance

Click Acrobat/Excel icons to view the Data Submission Trial Balance Report. The trial
balance is the accumulation of all the data submission performed for that entity, period,
currency and balance type. In addition, you can click on the eyeglasses icon to go to a
searchable online interface.

See: Data Submission Trial Balance Report, page 18-4
Regenerate XML

In the event that a Data Submission Trial Balance Report is not generated correctly, you
can regenerate the data submission report. Common errors are as follows:

* The concurrent request to generate the data submission reports fail, so no balances

show up in the report.

*  You made a change to the EPF dimensionality. The columns in the report now are
not synchronized with the dimensions.

From the status page, you can regenerate the report for a given data submission that has
a status of completed or warning.
Drilldown into Oracle General Ledger

If a data submission is an Oracle source, you can drill from the data submission down
into Oracle General Ledger down to the subledger level. Drilldown is available in the
Data Submission Trial Balance Report and the searchable online interface.

Lock Data Submission

When the upload status is Complete for a data submission, you can lock the data for
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that entity, period, currency, and balance type. After you lock an entity's data, no one
else can upload data for that entity, period, currency, and balance type combination
unless you unlock it.

Note: You can only lock data submissions from External Sources.

Setting Up Data Submission for Oracle Sources

An entity and balance type that has an Oracle source is assigned a balances rule.
Balances rules manage the flow of information between Oracle General Ledger and the
Enterprise Performance Foundation. A balances rule works in conjunction with
dimension rules to synchronize balances from Oracle General Ledger.

See: Oracle Enterprise Performance Foundation User’s Guide
See: Using Oracle General Ledger with Enterprise Performance Foundation, page 5-17

The following information presents the recommended setup of balances rules for
Financial Consolidation Hub.

Note: You may run the balances rule in either the Enterprise
Performance Foundation user interface or the Financial Consolidation
Hub Data Submission user interface. Running the rule will cause the
results to show up in both user interfaces. However, rules run in the
Enterprise Performance Foundation user interface that result in a
warning or error will not show up in the Financial Consolidation Hub
user interface.

Selected User Interface Elements for Setting Up Balances Rules

To set up balances rules, use the Enterprise Performance Foundation Administrator
responsibility and navigate as follows: Data Rules > Oracle Data Sources.

Ledger

Select the ledger from which to pull balances. It is recommended that one balances rule
be created per ledger.

Balance Type
Select the balance type you wish to pull.

Include Average Balances

If your ledger contains average balances, you are given the option to include average
balances that can be consolidated.
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Maintain Quarterly Balances

It is recommended that you do not maintain quarterly balances. You can still report on
quarter-to-date balances within Financial Consolidation Hub analytical reporting.

Output Dataset

If you select Actual balances type, you need to select an Output Dataset. Select Default
as the output dataset.

Note: Other Enterprise Performance Foundation applications, for
example Enterprise Planning and Budgeting, may use different output
datasets. However, for use with Financial Consolidation Hub, you must
select the Default dataset..

Execution Mode

Note: It is recommended that you use the incremental execution mode
for data submissions.

The incremental mode allows you to perform more than one data submission for a
given period. The snapshot mode is intended for one data submission for a given
period and currency.

See: Snapshot Mode, page 14-7

See: Incremental Mode, page 14-7

Include Balancing Segment Values

Include all of the balancing segment values that you want to consolidate.

Budgets
If you selected Budget for Balance Type, specify which budgets in Oracle General
Ledger you wish to bring over. When you run the balances rule, datasets are created in
Enterprise Performance Foundation with the same names as the Oracle General Ledger
budget names. In Financial Consolidation Hub, you must create a data type for each
data set, and assign the data types to the appropriate entity.

See: Task 3: Data Types, page 5-6
See: Additional Data Types, page 6-6

Note: If you select multiple budgets, ensure that they always have
balances for the same periods. If any of the budgets do not have
balances for a period, the Financial Consolidation Hub data submission
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will result in a warning. Otherwise, you can create multiple balances
rules for each budget.

Encumbrances

If you selected Encumbrance for Balance Type, specify which encumbrances in Oracle
General Ledger you wish to bring over. When you run the balances rule, datasets will
be created in Enterprise Performance Foundation with the same names as the Oracle
General Ledger encumbrance names. In Financial Consolidation Hub, you need to
create a data type for each data set, and assign the data types to the appropriate entity.

See: Task 3: Data Types, page 5-6
See: Additional Data Types, page 6-6

Note: If you select multiple encumbrances, ensure that they always
have balances for the same periods. If any of the encumbrances do not
have balances for a period, the Financial Consolidation Hub data

submission will result in a warning. Otherwise, you can create multiple
balances rules for each encumbrance.

Currency Type

Select the type of balances to synchronize:

e Cumulative Functional - The total balance for the account, summed across all
currencies, represented in the functional currency.

* Entered and Functional Equivalent - The balances for the account are separated by
currency. For each currency, it includes the amount in that currency and the
amount converted to the functional currency.

¢ Translated only - Optionally you can synchronize translated currencies only.

Note: Financial Consolidation Hub only consolidates functional
amounts.

Include Translated Balances

If you selected Translated Only, select the translated balances that you want to
synchronize.

Submitting Data for Oracle Sources

For entities with Oracle sources, you perform a data submission for a given entity,
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period, and balance type. When you perform the data submission, the assigned
balances rule is used to access the appropriate balances in Oracle General Ledger.

Note: The FCH Data Submission user interface keeps track of the
concurrent request id of the data submission. However, in the case of
data submissions that source from Oracle General Ledger, different
concurrent request IDs are used to track the executed balances rule for
each entity. These IDs tends to be small increments (+1 or +2) of the
data submission ID.

Note: You may run the balances rule in either the Enterprise
Performance Foundation user interface or the Financial Consolidation
Hub Data Submission user interface. Running the rule will cause the
results to show up in both user interfaces. However, rules run in the
Enterprise Performance Foundation user interface that result in a
warning or error will not show up in the Financial Consolidation Hub
user interface.

Note: Users running data submission for Oracle sources must be added
to the Default and Data Integration folders.

Snapshot Mode

Note: It is recommended that you not use the snapshot mode for data
submissions.

When you perform a data submission for an entity whose balances rule uses snapshot
mode, data submissions for all entities which source from that same ledger are
automatically performed. If you need to run another data submission for a given period
and currency, you must first undo the previous data submission.

See: Undo a Data Submission, page 14-7.

Incremental Mode

The first time you submit data for a given entity, period, and balance type, the balances
rule runs in snapshot mode, regardless of the execution mode specified. You can make
additional submissions to the entity, period, and balance , which result in only that
entity being synchronized with Oracle General Ledger.

Undo a Data Submission

You may undo data submission for any given period. This will remove all of the
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balances for the entity, period and balance type. If you need to resubmit a data
submission and your balances rule only supports snapshots, you must undo your
current set of synchronized data. Additionally, if you want to modify a balances rule,
you must first undo all your data submissions for that rule and make the appropriate
changes. To undo data, navigate to the Enterprise Performance Administrator
responsibility: Process Management > Executed Rules. Search for the balances rule,
select it and click Undo.

You can track the status of the undone Data Submission in the Data Submission user
interface

Oracle Source Example

Entities with Oracle sources can source from any combination of balancing segment
values in a ledger in Oracle General Ledger. For example, looking at the following
sample hierarchy, suppose that Corporation and Distribution are both Oracle entities
that use balances from the Corporation ledger.
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Sample Consolidation Hierarchy
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Assume that the Corporation ledger has the following balancing segment values:

16: Corporate East

17: Corporate West

18: Distribution

19: Reporting Adjustments

You create an incremental balances rule that includes the balancing segment values 16,
17, and 18. You do not want reporting adjustments in your consolidation results, so you

do not include 19. You assign Corporation companies 16 and 17, and assign
Distribution company 18. Additionally, you assign the incremental balances rule to both
entities.

Suppose you then want to synchronize the balances for Corporation and Distribution

for the first time in the month of February. Through the Data Submission page, you

execute a data submission for Corporation. Since this is the first submission for the
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period, the balances rule runs in snapshot mode and synchronizes both Corporation
and Distribution.

After the above submission, new journals are posted to company 16 in February. The
Data Submission page indicates an Impacted status for Corporation. Distribution's
status remains unchanged. To integrate this new data into consolidation, you perform
data submission for Corporation. This time the balances rule runs in incremental mode
and accesses changes in companies 16 and 17. This synchronizes the changes in
company 16 into Corporation.

Setting Up Data Submission for External Sources

Data is submitted for external sources using a spreadsheet loader. You can define rules
to transform and check this data by assigning transformation and validation rule sets to
entities.

See: Transformation Rule Set, page 6-6

See: Validation Rule Sets, page 14-10

Transformation Rule Sets

You can use a transformation rule set to convert submitted data to a standardized chart
of accounts.

See: Setting Up Interface Data Transformer, Oracle General Ledger User Guide

Before you can use a lookup table or PL/SQL function for data transformation, you
must create and register it.

See: Task 10: Data Transformation and Validation, page 5-15

Validation Rule Sets

Condition Rule

Validation rule sets enable you to validate submitted data before upload. Validation
rule sets run after transformation rule sets. A validation rule set comprises validation
rules, which are applied to each row of loaded data.

Validation rules are comprised of the following types:

e Conditions
e Lookup tables
e PL/SQL functions

If any row of data is invalid, the entire data is not submitted.

A condition rule defines a set of conditions that indicate that a trial balance is invalid.
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Lookup Table Rule
A lookup table rule defines a table of valid dimension member values for specified
dimensions. You can select multiple columns in the lookup table to compare against
and specify whether these columns match a column in the data loaded or match a fixed
value. If a trial balance does not have a dimension member value that is in the lookup
table, then the data submission fails.

Before you can use a lookup table rule for data validation, you must create and register
it.

See: Task 10: Data Transformation and Validation, page 5-15

PL/SQL Function Rule

A PL/SQL function rule evaluates the validity of each row in the trial balance. The
PL/SQL function takes ROWID as the input parameter, and must return SUCCESS for
each row so data submission can proceed.

Before you can use a PL/SQL function rule for data validation, you must create and
register it.

See: Task 10: Data Transformation and Validation, page 5-15

Submitting Data for External Sources

For entities with external sources, you can submit data for a given entity, period,
currency, and balance type. You submit data for external entities using a spreadsheet
loader, which can be accessed from the Data Submission page.

Each data submission is for a period, entity, currency, and balance type and you can
perform multiple data submissions for the same parameters.

Each external data submission must be balanced.

Note: If you are submitting data for a user defined data type, the data
submission may or may not be required to be balanced, according to
the parameters set for the data type.

Spreadsheet Loader

The spreadsheet loader is a Web ADI spreadsheet that you can use to enter balances
data for an entity. If you submit data for an entity with an assigned transformation rule
set, the spreadsheet is in the pre-transformation format. Otherwise, the spreadsheet is in
the standard format. For both formats, enter a unique combination of dimension
members on each row of the spreadsheet. Each format performs different checks on the
data submission.

Once you generate a spreadsheet uploader using the Web interface, you can reuse it for
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a different Entity, Period, Balance Type, Currency (if Functional Currency Load),
Execution Mode, and Amount Type. You cannot update the Currency Type and
Measure options as those options affect the spreadsheet layout.

Note: Ensure that the load identifier is unique prior to performing any
loads. You can enter any unique value to the load identifier.

After you submit a load, it will be visible in the Data Submission Monitor.

Note: After you upload the WebADI spreadsheet, Financial
Consolidation Hub must load the balances into Enterprise Performance
Foundation. Thus, although the WebADI spreadsheet may upload
successfully, you must verify that the data submission completes
successfully in the Financial Consolidation Hub Data Submission User
Interface.

See: Appendix B: WebADI Spreadsheets, page A-1

Standard Spreadsheet Format
The standard spreadsheet format is used when no transformation rule set is assigned to
the entity. You can use this format if your trial balance corresponds to your
consolidation dimensions and you therefore do not need to apply transformation rules.
Before the spreadsheet is uploaded, the system verifies that each dimension member is
valid and that the spreadsheet is balanced.

Note: Input the dimension member names in the spreadsheet.

Note: Double click a cell to see a list of valid values.

Pre-Transformation Spreadsheet Format
The pre-transformation spreadsheet format is used when a transformation rule set has
been assigned to an entity. You can use this format if your trial balance does not match
your consolidation dimensions and you therefore need to apply transformation rules.
Before the spreadsheet is uploaded, the system verifies that the spreadsheet is balanced.

The spreadsheet exposes all dimensions in Enterprise Performance Foundation,
including inactive ones.

Since the data submission will be transformed, Financial Consolidation Hub does not
know the list of valid dimension members when you upload them in the spreadsheet.
Therefore, it cannot provide you with a list of available members, or verify that all the
values the designated are valid at the time of upload. After the data submission has

been uploaded into Financial Consolidation Hub, it is transformed and then its values
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are checked.

Note: Input the dimension member codes in the spreadsheet.

Selected User Interface Elements for Submitting Data for External Sources

Selected user interface elements for submitting data for entities with External sources
are described in the following sections.

Balance Type

You can submit actual or average balances for the data submission. You can also submit
data for any additional data types that you have defined and assigned to the entity.

Measure

For external entities, you can submit balances using Debits and Credits or Net. If your
source system outputs a trial balance with separate columns for debits and credits,
select the Debits and Credits option. If your trial balance includes only a single net
balance number for each combination of dimension members, select Net. In this case,
Financial Consolidation Hub expects debit balances to be entered as positive numbers
and credit balances to be entered as negative.

Currency Type

If you select the Functional Currency Only option, you must specify a functional
currency in the Currency field. In the spreadsheet loader, fill in the trial balances in that
currency.

If you select the Transactional Currency option, in the spreadsheet loader you must
enter the transactional currency, transactional amount, and the functional amount of
each account.

Execution Mode

Data is submitted to the system in one of the following modes:

e Initial Load - This will be the first data submission performed for the entity, period,
currency, and balance type.

* Incremental - The loaded balances are aggregated to previously uploaded balances
data for that entity, period, currency, and balance type.

® Replace - The system replaces rows where an existing dimension combination is
also part of the latest upload, inserts new rows where the two sets do not overlap,
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but does not remove any rows from previous uploads that do not appear in the
latest set.

Amount Type

For the Amount Type drop-down list, you specify whether you are loading period
activity or ending balances. If you select ending balances, the corresponding period
activity is automatically calculated, and vice versa.

Note: A data submission for the first period of the year will always
have the amount type of ending balances.

Add Comment

Before submitting data, you can enter applicable comments in the Submit Data >
Parameters page. After submitting data, entered comments appear on the Data
Submission Status page.

Related Topics

Submitting Data for External Sources, page 14-11
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15

Overview

Running Consolidations

Financial Consolidation Hub enables you to perform statutory and management
consolidations with the click of a button. The Consolidation Monitor enables you to
monitor your current consolidations, review historical results, submit consolidations,

and prepare your results for analytical reporting.

Monitoring Consolidation Status

Data Status

The consolidation monitor provides you a view of the consolidation points within your
hierarchy for a specific period and balance type. The monitor enables you to quickly see
the data status of trial balance loads by the subsidiaries, as well as the consolidation
process status.

The data status is updated automatically whenever a subsidiary loads data or a
structural change is made to the consolidation hierarchy. The data status can be the
following:

Not Started - Applies when none of the subsidiaries have loaded their trial balance.

Incomplete - Applies when some, but not all of the subsidiaries have loaded their
trial balance.

Warning - Applies when some of the subsidiaries have data submissions with
Warning status. Warning status overrides all other statuses except Error.

Error - Applies when some of the subsidiaries have data submissions that have
Error status. Errors status overrides all other statuses.

Completed - Applies when all trial balances have been uploaded.
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Impacted - Applies when some of the subsidiaries have Impacted data submissions
status.

Within the monitor, you can drill-down on the data status to see which entities have
submitted data or are in the process of submitting data.

Note: If data submission is undone, that is equivalent to the data
submission being not started.

See: View Status, page 14-2

Process Status

The process status is updated automatically whenever you run a consolidation. The
process status can be the following:

Impacted Status

The Not Started status is applicable when you have not run a consolidation.
In Progress is applicable when you run a consolidation.

Completed is applicable when the consolidation finishes successfully without any
suspense violations or setup errors.

Warning implies there are missing setup components, such as missing rates or a
suspense threshold violation when performing intercompany eliminations.

Error occurs when a key setup component of Financial Consolidation Hub or
Enterprise Performance Foundation has not been set properly.

The Impacted status enables the consolidation manager to quickly see the changes
that have occurred that impacts the most recent set of results. Impacts also result in
notifications being sent to the appropriate contacts.

Financial Consolidation Hub monitors the following changes. These changes will result
in the impacted status for relevant consolidation results.

Making changes to hierarchy relationships, such as acquiring a new entity,
disposing of an entity, or modifying the consolidation method or ownership of an
existing relationship.

Creating a manual adjustment for a consolidation hierarchy.

Updating a manual adjustment that has already been processed.

Creating an acquisition or disposal elimination.
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Status Drilldown

Updating an acquisition or disposal elimination, which has already been processed.
Changing The Translation Rates, Which Have Already Been Used By Translation.
Changing historical rates.

Updating trial balances for operational entities.

Reconsolidating a prior period for which the current period's results have been
altered.

Running consolidation for one subsidiary, and not across the entire hierarchy.

Updating the value set map.

Note: Changes to consolidation rules or intercompany rules will not
impact consolidation results.

You can drill-down to the consolidation details for each level of the hierarchy by
clicking the appropriate Process Status icon. This will take you to a page where you can
see any impacts and where you can see the seven seeded categories provided by
Financial Consolidation Hub. Each category has a status associated with it as follows:

N/A - Consolidation entries are not generated by the category.

Not Started - The category was not processed by a consolidation run.

In Progress - The category is currently being processed by a consolidation run.
Completed - The category was successfully processed by a consolidation run.

Warning - The category was processed by a consolidation run, and has resulted in a
warning. This is often caused by threshold violations.

Error - The category was processed by a consolidation run, and has resulted in an
error. This is often caused by missing balances or missing/improper setup
components.

You can drill-down into the individual category status even further. Depending on the
status of the category, you may see the following:

Reports of consolidation entries produced by the category. The Consolidation
Entries Report can be viewed in Excel or Acrobat format. If the category produces
warnings, the warnings are listed in the reports.

See: Consolidation Entries Report, page 18-2
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® In the Data Preparation category, you can view which dimension members of an
operating entity have not been mapped to the consolidation chart of accounts.

See: Value Set Map Validation Report, page 18-6

¢ Useful error messages if the category results in an error.

Viewing Results

After the consolidation process completes, you can review the results at each level of
the consolidation hierarchy by clicking the appropriate View Results icon. This opens
the Consolidation Trial Balance report in Excel or Acrobat format which shows the
results for each child at that level, the elimination results, and the consolidated totals, all
broken out by line item. More flexible reporting capabilities are offered through
Financial Consolidation Hub's analytical reporting, but this is offered as a quick way to
spot-check results.

See: Consolidation Trial Balance Report, page 18-1

Locking Results

If the consolidation process completes with no warnings or errors, then the results may
be locked. This prevents any re-runs of the consolidation. If you need to reconsolidate
locked results, you must unlock them first. Unlocking results is a function that can be
secured to a select group of users.

Process History

Consolidation is typically an iterative process. You can run consolidations every day or
multiple times per day during the month-end close. Within the Consolidation Monitor,
you can access the results of all previous consolidations.

Submitting Consolidations

Consolidations can be submitted in two ways: using the Consolidation Monitor or by
submitting a concurrent request.

Before submitting a consolidation, you can select one of two consolidation execution
modes: Full or Incremental. For the first run in a period, you can only run in Full mode.
For subsequent runs within a period, this option determines whether to reconsolidate
the entire hierarchy, or only those parts of the hierarchy that have changed since the last
run.

See: Impacted Status, page 15-2

Note: If you change intercompany or consolidation rules between runs,
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you should run consolidation in Full mode to ensure the new rules are
applied uniformly across the hierarchy.

When you submit a consolidation, you can select an EPB business process to
automatically run after consolidation is complete. You can use this parameter to
automatically show the latest consolidation results into Analytical Reporting.

Note: You may only select business processes that are set to run by
procedural call and are made effective.

For more information on setting a business process to run by procedural call, see
Schedule, page 19-9.

The concurrent program, FCH: Submit Consolidation, enables you to schedule
consolidation runs for a specific hierarchy, business process, balance type, and period
combination. The parameters for the concurrent program are identical to the online
interface.

When you run consolidation, it launches the following concurrent requests. You can
monitor these requests.

e XML Generator
¢ Notification Utility

¢ (Consolidation Data Transfer

Preparing Data for Analytical Reporting

After a consolidation has been run to the top-most level, results are available for
analytical reporting. For information on analytical reporting, see Creating and Sharing
Reports, page 19-11.
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Adjustments

Overview

Adjustments are one time or recurring entries that are entered manually. Examples of
adjustments include the following:

Example 1

You work in corporate headquarters on the consolidation team. It is quarter end and
you have obtained trial balances from all the subsidiaries and started running
consolidation. You discover that slight changes need to be made to a subsidiary trial
balance, yet the subsidiary controller is unavailable. You use an adjustment to
temporarily make the change so it can be reflected in the consolidated results.

Example 2

You need to eliminate intercompany profit or loss in inventories between two
subsidiaries. The elimination needs to reflect inventory not yet sold to third parties. The
subsidiary's general ledger systems do not capture this information. Therefore, an
intercompany rule cannot be executed during consolidation processing to produce the
required eliminations. Consequently, you enter an adjustment to eliminate an estimate
of these intercompany balances from the parent's results.

Uploading Adjustments

Adjustments are uploaded into Financial Consolidation Hub using either XML files or
the WebADI spreadsheet loader for a consolidation hierarchy, period, entity, and
balance type.

Uploading Adjustments using WebADI Spreadsheet Loader
You can also upload adjustments using the WebADI spreadsheet loader. Before the
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spreadsheet is uploaded, the system verifies that each dimension member is valid and
that the entry is balanced. Balancing is only enforced depending on the data type
options. Unlike the data submission spreadsheet loader, the dimension member
combinations on each row of the adjustment spreadsheet loader do not need to be
unique.

See: WebADI Spreadsheets, page A-1

Note: Although the WebADI spreadsheet may upload successfully, you
should verify that the adjustment is completed successfully in the
Financial Consolidation Hub Adjustment window.

Uploading Adjustments using XML files

You can upload multiple adjustments into Financial Consolidation Hub at the same
time through a zip file of XML files. Financial Consolidation Hub will perform the same
validation it does for uploading adjustments via WebAD]I, and each adjustment will be
tracked on the Adjustment Main Page user interface just like WebADI adjustments.

1. Navigate to the Consolidation > Adjustment page.

2. Click Upload via XML.

To view the XML format, click Preview XML Format. The following tables describe
the valid values for the XML file.

Values for Header Region (UPLOAD_ENTRY_HEADERS_API)

XML Tag Value

p_entry_name Free form text field

p_description Free form text field

p_hierarchy_id Consolidation Hierarchy name

p_category_code Category name

p_entity_id Operating Entity name

p_balance_type_code Any data type name specified in the Foundation user
interface

p_start_cal_period_id Calendar Period name
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XML Tag

Value

p_end_cal_period_id

p_currency_code

p_process_code

Calendar Period name, you can leave this blank for
adjustments that will go on forever

Currency name

"All runs for period" or "Next run only"

Values for Lines Region (gcs_entry_lines)

XML Tag

Value

description

company_cost_center_org_i

d

line_item_id

channel_id

customer_id

financial_elem_id

natural_account_id

product_id

project_id

task_id

user_dim1_id

user_dim2_id

user_dim3_id

Free form text field

Company Cost Center Organization name

Line Item name

Channel name

Customer name

Financial Element name

Natural Account name

Product name

Project name

Task name

User Dimension 1 name

User Dimension 2 name

User Dimension 3 name
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XML Tag Value

user_dim4_id User Dimension 4 name
user_dim5_id User Dimension 5 name
user_dimé6_id User Dimesnion 6 name
user_dim?7_id User Dimension 7 name
user_dim8_id User Dimension 8 name
user_dim9_id User Dimension 9 name
user_dim10_id User Dimension 10 name
intercompany_id Intercompany name
ytd_debit_balance_e Debit balance
ytd_credit_balance_e Credit balance

Note: Some tags may not be visible based on your particular FCH
configuration.

3. You can either upload from your local desktop or by specifying a URL accessible
from the Web Server supporting your E-Business Suite installation.

Note: The file you upload must be a zip file containing one or many
XML files. Each XML file corresponds to an adjustment.

4. Click Process to run the FCH: XML Uploader concurrent program. FCH will
perform the same validations on each adjustment as it does for WebADI
adjustments. Any invalid adjustments are blocked, while valid adjustments are
uploaded. Upon completion of the program, click on the output to view a PDF
report displaying any adjustments that did not conform to the validation rules, and
successfully uploaded adjustments. All successfully loaded adjustments can be
queried and edited through the manual adjustments user interface.
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Updating Adjustments

You can update adjustment entries either through WebADI spreadsheets or XML files.
After the update, if the original entry has been processed it will be renamed for auditing
purposes.

If you update adjustments in a period where consolidations have been run, the
consolidation results are impacted. To incorporate the adjustment impact, you must run
the Consolidation Process. The adjustments are then incorporated into consolidated
balances.

Disabling Adjustments

You can disable an adjustment. Disabled adjustments are not included in succeeding
consolidation runs.

Note: After you disable an adjustment, you cannot re-enable it.

Selected User Interface Elements

Adjustments are entered using a WebADI spreadsheet loader. Selected user interface
elements for adjustments are described as follows:

Line Description

Hierarchy

Category

Entity

When you are entering balances into the adjustment spreadsheet, you may optionally
add a description for each row.

Adjustments are hierarchy-specific and are not propagated across hierarchies.

All user-defined categories, as well as the seeded Minority Interest category, are
available for you to enter adjustments. The output entity type specified in the category
that you select will restrict the type of entity you can select for the adjustment.

See: Entity, page 16-5

The Entity field is dependent on the Consolidation Hierarchy value you selected, as
well as on the selected Category value. If the Output Entity of the selected Category is
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Source or Parent, only operating entities are available. If the Output Entity is
Elimination, only elimination entities are available.

You can submit balances for the organizations of all entities that are below the
ownership branch of the selected entity.

Balance Type

Actual and average, as well as all additional data types defined are available.

Start and End Period

You can specify the period range in which you want to apply the adjustment. If you do
not specify an end date, the adjustment will be applied to all periods after the start date.

Apply
You can specify whether an adjustment should be included in the next consolidation
run only or in every run for the period. Select next run only for temporary adjustments.
For example, if you enter an adjustment in an entity's operational system and then load
it into Financial Consolidation Hub, and you want to see the effects of the adjustment
immediately, you can enter it as a temporary adjustment in Financial Consolidation
Hub. It will only be incorporated in the next consolidation run. If you run consolidation
a second time, the adjustment will no longer show up.

Write back to General Ledger

When you upload an adjustment into Financial Consolidation Hub, you are given the
option to have the adjustment be written back to General Ledger. The adjustment will
be written as a journal, which you can then manage in General Ledger.

You can mange Write backs using the Adjustment user interface. For an adjustment,
click Writeback Details to view and perform write backs for the adjustment. The user
interface will indicate if the write back was successfull and if so, will produce a report
of the balances written back.

See: Write back to General Ledger Report, page 18-6

The adjustment can be written back to Oracle General Ledger as the functional
currency, a foreign currency or statistical.

The adjustment is written to the Oracle General Ledger category specified in the
Financial Consolidation Hub category for the adjustment.

To utilize write back to General Ledger, you must create a source system in Oracle
General Ledger named Consolidation.

See: Setting Up Categories, page 7-4
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Selected User Interface Elements

To perform write back, set Do you want to write back entries in GL to Yes in the Upload
window of the adjustment WebADI spreadsheet. Then set the parameters for where the
General Ledger journal is to be written.

Target Ledger

The Ledger to which you add the adjustment. You can select from all ledgers that are
assigned in Enterprise Performance Foundation.

See: Using Oracle General Ledger with Oracle Enterprise Performance Foundation,
page 5-17

Target Period

The period in which you need make the adjustments. It can be an open or future
enterable period of the Target Ledger. The target period will override the start and end
period of the entry for write back purposes.

Conversion Rate Type

If you are writing the adjustment as a foreign currency, select a conversion rate type.
You can select from all valid rate types in Oracle General Ledger except, User. The last
day of the write back period is used as the rate date.

Note: If the adjustment is in the same currency as the Target Ledger
functional currency, Financial Consolidation Hub will ignore the
conversion rate type you select.

Running Write back

If you enable write back, it will be performed when you execute the adjustment upload.
An additional concurrent request will be executed to perform write back, FCH:
Consolidation Entries Writeback. Once the concurrent request completes, you can view
the request output to see the General Ledger write back entry.

Note: It is possible that the adjustment is successfully uploaded into
Financial Consolidation Hub, but the write back fails.

After write back has completed successfully, you can import the journal. To import
write back journals, use the General Ledger Super User responsibility (or the
appropriate General Ledger responsibility for the desired ledger) and navigate to
Journals > Import > Run. Select the following parameters:

e Source - Consolidation

¢ Selection Criteria - No Group ID
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Once the concurrent request completes, the write journal is available to view, edit, and
post. The journal will have a name in the format Consolidation <currency> Reporting
<date>.

If you perform multiple write backs of an adjustment to the same target ledger in
General Ledger, it will first write a reversal entry to eliminate the original write backs to
that ledger.

Updating Write back Adjustment

If you update an adjustment that was submitted for write back, and enable the updated
journal for write back, Financial Consolidation Hub will first write back a reversal entry
to eliminate the original write back entry.
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Accounting for Acquisitions and Disposals

Overview

Accounting for acquisitions and disposals is a way to tie changes in the consolidation
hierarchy to consolidation entries. Each time a consolidation hierarchy structure
changes, you can associate acquisition and disposal entries to the change.

You can manually enter Acquisition and Disposal entries or generate them through
Acquisition and Disposal rules.

When you run consolidation, Acquisition and Disposal entries are generated in the
Acquisition and Disposal category. Acquisition and Disposal is broken up into four
categories, or types:

* Acquisition

¢ Disposal

® Share Issue

® Share Issue with Acquisition

An acquisition and disposal transaction has the following parameters.

* From Consolidation Method - The original consolidation method applied to the
relationship.

* To Consolidation Method - The new consolidation method applied to the
relationship.

e From Percentage - The original ownership percentage of the child entity in the
relationship.

* To Percentage - The new ownership percentage of the child entity in the
relationship. For Share Issue with Acquisition, this is the Post Acquisition
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Ownership.

A transaction of type Share Issue with Acquisition has the following additional
parameters.

® Post Share Issue Ownership (%) - The ownership percentage for the entity after the
share issue and before the acquisition.

e Post Share Issue Consolidation Method - The consolidation method for the entity
after the share issue and before the acquisition.

These parameters are used as inputs for Acquisition and Disposal Rules.

Create Accounting for Consolidation Hierarchy Changes

Acquisition and Disposal entries can be generated for each change to a consolidation
hierarchy's structure. To enable Acquisition and Disposal entries for a particular
change, use the Create Accounting option that appears when you perform the update to
the consolidation hierarchy.

Note: If you perform more than one change to the same hierarchy
relationship on the same effective date, only the last change will be
available to associate Acquisition and Disposal entries.

See: Updating Consolidation Hierarchies, page 13-7

Add Entity

If you add an entity to a consolidation hierarchy, enable Acquisition and Disposal
entries by setting Create Accounting to Yes. The Acquisition and Disposal properties
will be set to the following.

¢ From Consolidation Method - You will specify this method in the From
Consolidation Method field. This field does not impact the structure of the
consolidation hierarchy.

e To Consolidation Method - The consolidation method you specify for the entity,
and the one that is visible when you view the consolidation hierarchy for an

effective date after the change.

¢ Change Type - Adding an entity will have the change type as Acquisition.

Remove Entity

If you remove an entity from a consolidation hierarchy, enable Acquisition and
Disposal entries by setting Create Accounting to Yes. The Acquisition and Disposal
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properties will be set to the following.

From Consolidation Method - The original consolidation method of the entity, and
the one that is visible when you view the consolidation hierarchy for an effective
date before the change.

To Consolidation Method - You will specify this method in the To Consolidation
Method field. This field does not impact the structure of the consolidation
hierarchy.

Change Type - Adding an entity will have the change type as Disposal.

Update Relationship

If you update an entity's relationship in a consolidation hierarchy, enable Acquisition
and Disposal entries by setting Create Accounting to Acquisition, Disposal, Share Issue,
or Share Issue with Acquisition. For the change types Acquisition, Disposal and Share
Issue, the Acquisition and Disposal properties will be set to the following.

From Consolidation Method - The original consolidation method of the entity, and
the one that is visible when you view the consolidation hierarchy for an effective
date before the change.

To Consolidation Method - The consolidation method that you specify for the
entity, and the one that is visible when you view the consolidation hierarchy for an
effective date after the change. If you do not change the consolidation method, the
From Consolidation Method and To Consolidation Method will be the same.

Change Type - Specify the change type in the Create Accounting list.

For the change type Share Issue with Acquisition, the properties will be set differently
and there will be additional properties.

From Consolidation Method - This is the original consolidation method of the
entity, and the one that is visible when you view the consolidation hierarchy for an
effective date before the change.

To Consolidation Method - The consolidation method that you specify in the Post
Acquisition Consolidation Method field, and the one that is visible when you view
the consolidation hierarchy for an effective date after the change.

Change Type - You will have specified the change type Share Issue with
Acquisition in the Create Accounting list.

Post Share Issue Ownership (%) - Specify the ownership percentage for the entity

after the share issue and before the acquisition. This field does not impact the
structure of the consolidation hierarchy.
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® Post Share Issue Consolidation Method - Specify the consolidation method for the
entity after the share issue and before the acquisition. This field does not impact the
structure of the consolidation hierarchy.

¢ Post Acquisition Ownership (%) - Specify the final ownership percentage for the
entity that is visible when you view the consolidation hierarchy for an effective date
after the change.

Manually Entering Acquisition and Disposal Entries

You can manually enter an Acquisition and Disposal entry to associate to a change in
the consolidation hierarchy structure. When you run consolidation for the period that
encapsulates the hierarchy change, the entry is applied.

The Acquisition and Disposal entry is uploaded using a WebADI spreadsheet loader.
To submit the entry, navigate to the Acquisition and Disposal tab and search for the
appropriate hierarchy change. Click the Eliminations: Enter icon. This launches the
WebADI spreadsheet loader. When you upload the spreadsheet, it verifies that the
accounts are valid and that the entry is balanced.

Note: If you generate an Acquisition and Disposal entry through a
calculation, you can manually update the entry. When you generate an
entry through a calculation, it will erase any existing entry.

See: WebADI Spreadsheets, page A-1

Calculating Acquisition and Disposal Entries

You can have Financial Consolidation Hub calculate an Acquisition and Disposal entry
to associate to a change in the consolidation hierarchy structure. When you run
consolidation, Financial Consolidation Hub will apply any existing Acquisition and
Disposal rules to the subsidiary trial balance to generate an Acquisition and Disposal
entry.

Note: If you generate an Acquisition and Disposal entry through a
calculation, you can manually update the entry. When you generate an
entry through a calculation, it will erase any existing entry.

Subsidiary Trial Balance

The subsidiary trial balance represents the trial balance of the child entity whose
parent-child relationship is changed in the consolidation hierarchy. When you run
consolidation, Acquisition and Disposal rules can source from this trial balance.
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Note: The subsidiary trial balance is not the same thing as the data
submission trial balance. The subsidiary trial balance is used solely as a
source for Acquisition and Disposal rules. The data submission trial
balance represents the operating balances of the entity, and is used as
the source of consolidation rules and is aggregated during
consolidation.

The subsidiary trial balance is submitted in the consolidation chart of accounts in the
parent entity's currency. In addition to the trial balance additional information may be
required based on the change type:

* Consideration Amount - For change types Acquisition, Disposal and Share Issue
with Acquisition enter the consideration amount.

® Pre-Share Issue Trial Balance - For change types Share Issue and Share Issue with
Acquisition, mark each account line as Pre-Share Issue or Post-Share Issue.

e Post-Share Issue Trial Balance - For change types Share Issue and Share Issue with
Acquisition, mark each account line as Pre-Share Issue or Post-Share Issue.

The subsidiary trial balance is loaded using a WebADI spreadsheet loader. When the
spreadsheet is uploaded, it verifies that the account values are valid.

Note: The subsidiary trial balance does not need to be balanced. This
allows you to load only the balances relevant to acquisition and
disposal.

Acquisition and Disposal Rules

Acquisition and Disposal Rules are used to automatically create the accounting
associated with changes in your legal structure. During consolidation, the appropriate
rules are run based off of the Acquisition and Disposal transactions of the hierarchy for
that period.

For each Acquisition and Disposal transaction for which you have loaded subsidiary
trial balances, Financial Consolidation Hub will look for any matching Acquisition and
Disposal rules. A rule matches if it has the same change type, from method and to
method as the transaction. The rules source from the Acquisition and Disposal
transactions and the subsidiary trial balance to generate Acquisition and Disposal
Entries.

Acquisition and Disposal Rules are a special type of consolidation rules. They are
associated to the Acquisition and Disposal category, have some additional fields and
use a different set of tokens. This section will only cover the specific differences of
Acquisition and Disposal Rules from consolidation rules in the minority interest and
user defined categories.
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See: Setting Up Consolidation Rules, page 9-1

Selected User Interface Elements for Acquisition and Disposal Rules

Category

To Method

From Method

Tokens

For an Acquisition and Disposal rule, select one of the following change types.

* Acquisition

¢ Disposal

® Share Issue

e Acquisition Linked to a Share Issue

The category of the rule must match the change type of the Acquisition and Disposal
transaction for the rule to be executed for that transaction. In the case of the type Share
Issue with Acquisition, both the categories - Share Issue and Acquisition Linked to a
Share Issue - is executed.

Select a consolidation method - The To Method of the rule must match the To Method
of the Acquisition and Disposal transaction for the rule to be executed for that
transaction.

Select a consolidation method. The From Method of the rule must match the To Method
of the Acquisition and Disposal transaction for the rule to be executed for that
transaction.

Acquisition and Disposal rules may use the following tokens in their formulas.

Variables Used to Define Acquisition and Disposal Elimination Rules

Variable Description Source
COl Cost of investment Entered in Subsidiary Trial
(consideration amount) Balance
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Variable Description Source
NAV Net asset value (assets less Generated from Subsidiary
liabilities) Trial Balance
%TO New ownership percentage Entered when Updating
Consolidation Hierarchy
%FROM Old ownership percentage Entered when Updating
Consolidation Hierarchy
ADTB Acquisition and disposal trial =~ Entered in Subsidiary Trial
balance Balance
PRETB Pre-share issue trial balance Entered in Subsidiary Trial
Balance
POSTTB Post-share issue trial balance ~ Entered in Subsidiary Trial

Balance

The tokens PRETB and POSTB are for use in rules in the Acquisition Linked to a Share
Issue category. The token ADTB is for use in rules in the Acquisition, Disposal and

Share Issue categories.

Accounting for Acquisitions and Disposals
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Viewing Reports

Oracle Financial Consolidation Hub provides various reports to monitor and track the
consolidation process. These reports will allow you to do the following;:

® Report on consolidation results.
e Diagnose issues that may have occurred during the consolidation process.
¢ View the company and accounting setup.

Several reports have drilldown capabilities. If a balance is a hyperlink, you can click on
the balance to drilldown to the preconsolidated data for an entity in its local chart of
accounts, calendar, and currency. If the entity sources from Oracle General Ledger, you
can drill into Oracle General Ledger to the subledger level. For the specific conditions
under which drilldown is enabled in reports, refer to the following sections on each
report.

Consolidation Trial Balance Report

The Consolidation Trial Balance Report shows the consolidation results of a
consolidation run for a consolidation entity broken out by line item.

Note: The report is sorted by line item code.

The Consolidation Trial Balance Report has the following parameters:

¢ Consolidation Hierarchy - The hierarchy for which you run the consolidation.
¢ Period - The period for which you run the consolidation.

* Consolidation Entity - The report will show the selected consolidation entity and its
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direct children.
e Balance Type - Actual, Average, or any user-defined data types.

You can access this report in the Consolidation Monitor or the Reporting User Interface.
See: Viewing Results, page 15-4

You can customize this report by modifying the XML Publisher template.

See:Task 11: XML Publisher Templates, page 5-15.

In the Consolidation Trial Balance Report, you can drill down on balances for operating
entities.

Consolidation Entries Report

The Consolidation Entries Report shows a particular consolidation entry produced for a
consolidation run. When you run consolidation on a hierarchy, each entity is processed
through a sequence of categories. This report will show the consolidation entry
produced for a particular entity and category.

See: Setting Up Categories, page 7-1.
The Consolidation Entries Report has the following parameters:

¢ Consolidation Hierarchy - The hierarchy for which you run the consolidation.

® Period - The period for which you run the consolidation.

* Consolidation Entity- A consolidation entity in the selected consolidation hierarchy.
* Category - The category of the consolidation entry that you want to view.

e Entity - The entity for which the consolidation entry was produced. The entity is
either the selected consolidation entity or one of its direct children.

¢ Balance Type - Actual, Average, or any user-defined data types.

* Counter Entity- The corresponding entity of the selected entity for an intercompany
transaction. This parameter only applies to the Intercompany category.

e Entry Description- This parameter only applies to adjustments. It shows the
description entered for the adjustment.

* Entry Description- This parameter only applies to adjustments. It shows the user
who entered the adjustment.

You can access this report in the Consolidation Monitor or the Reporting User Interface.

See: Process Status, page 15-2
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You can customize this report by modifying the XML Publisher template.
See Task 11: XML Publisher Templates, page 5-15

In the Consolidation Entries Report, you can drill down on balances for any report that
is not in the Minority Interest category or any user defined categories.

Intercompany Matching Report

An intercompany transaction occurs when two companies in the same consolidation
hierarchy have a financial transaction. During consolidation, these intercompany
transactions need to be identified, matched, and eliminated. The Intercompany
Matching report facilitates this function. You can view the intercompany transactions
that occurred within a company. The report shows the intercompany eliminations that
occurred between the two entities, broken out by the intercompany rule. The report is
generated for a given consolidation hierarchy, period, and entity.

See: Setting Up Intercompany Rules, page 10-1.
The Intercompany Matching Report has the following parameters:

e Consolidation Hierarchy - The hierarchy for which you run the consolidation.
® Period - The period for which you run the consolidation.

¢ Entity - An operating entity in the selected consolidation hierarchy. The report will
show the intercompany eliminates between the selected entity and the selected
counter entity.

¢ Counter Entity - You can select a counter entity to only list intercompany
eliminations between the selected entity and the counter entity. If you leave this
parameter blank, the report will list all intercompany eliminations for the selected
entity.

* Intercompany Rule - You can show the eliminations produced by a selected
intercompany rule, or leave blank to show the eliminations produced by all
intercompany rules.

* Balance Type — Select a balance type.

® Exceeds Threshold - Show the eliminations that caused a threshold violation, those
that did not cause a threshold violation, or leave blank to show all.

You can access this report in the Reporting User Interface.

You can customize this report by modifying the XML Publisher template.

See: Task 11: XML Publisher Templates, page 5-15

In the Intercompany Matching Report, you can drill down on any balance except for
suspense.
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Data Submission Trial Balance Report

The Data Submission Trial Balance report shows the pre-consolidated trial balances of
an entity. If multiple data submissions were performed for the same entity, period,
currency and balance type, the Data Submission Trial Balance Report will show the
accumulated result of all the data submissions.

The Data Submission Trial Balance Report has the following parameters:

¢ Entity - An operating entity for which data was submitted.

¢ Load Identifier - A unique string of characters used to identify the data submission.
® Currency - The currency of the data submission.

e Period - The period for which data was submitted.

e Balance Type - Actual, Average, or any user-defined data types.

See: Submitting Data, page 14-1.

You can access this report in the Data Submission User Interface. For more information
on accessing this report View Trial Balance, page 14-3

You can customize the report by modifying the XML Publisher template.
See: Task 11: XML Publisher Templates, page 5-15

In the Data Submission Trial Balance Report, you can drill down on balances for data
submissions that source from Oracle General Ledger.

Note: The Data Submission Trial Balance Report shows the names of
the line items. If you wish to view the descriptions instead of the
names, modify your Data Submission Trial Balance Template to use the
line item description in the XML.

Data Submission Data Loaded Report

The Data Submission Data Loaded Report shows the balances that were loaded in one
particular data submission.

The Data Submission Data Loaded Report has the following parameters:

e Entity - An operating entity for which data was submitted.
* Load Identifier - A unique string of characters used to identify the data submission.

¢ Currency - The currency of the data submission.
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e Period - The period for which data was submitted.
e Balance Type - Actual, Average, or any user-defined data types.

See: Submitting Data, page 14-1

You can access this report in the Data Submission User Interface. For more information
on accessing this report, see View Data Loaded, page 14-3.

You can customize the report by modifying the XML Publisher template.
See: Task 11: XML Publisher Templates, page 5-15.

Data Submission Impacted Balances Report

For a data submission that sources from Oracle General Ledger, when additional
balances are posted to Oracle General Ledger, the data submission is impacted. The
Data Submission Impacted Balances Report shows the balances in Oracle General
Ledger that have impacted the data submission.

The Data Submission Impacted Balances Report has the following parameters:

¢ Entity - An operating entity for which data was submitted.

® Load Identifier - A unique string of characters used to identify the data submission.
® Currency - The currency of the data submission.

® Period - The period for which data was submitted.

e Balance Type - Actual, Average, or any user-defined data types.

See: Submitting Data, page 14-1

You can access this report in the Data Submission User Interface. For more information
on accessing this report, see View Impacted Balances, page 14-3.

You can customize the report by modifying the XML Publisher template.
See: Task 11: XML Publisher Templates, page 5-15.

Hierarchy Listing Report

The Hierarchy Listing Report shows a consolidation hierarchy for a given effective date
and consolidation entity.

The Hierarchy Report has the following parameters:

* Consolidation Hierarchy - The hierarchy you want to view.

¢ Date - The effective date for the hierarchy.
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e Entity - A consolidation entity in the selected hierarchy. The report will show the
consolidation entity and all of its descendents.

You can access this report in the Setup Hierarchy User Interface. You can also run the
report using the concurrent program FCH: Hierarchy Listing Report. For more
information on accessing this report, see Viewing Consolidation Hierarchies, page 13-8.

You can customize the report by modifying the XML Publisher template.
See: Task 11: XML Publisher Templates, page 5-15.

Value Set Map Validation Report

The Value Set Map Validation Report shows which dimension members in an entity's
local chart of accounts are not mapped to the consolidation chart of accounts.

See: Task 8: Value Set Maps, page 5-12
The Value Set Map Validation Report has the following parameters:
¢ Consolidation Hierarchy - The hierarchy for which you run the consolidation.

* Consolidation Entity - A consolidation entity in the selected consolidation
hierarchy.

¢ Entity - An operating entity in the selected consolidation hierarchy that is a
descendent by the selected consolidation entity.

¢ Period - The period for which you run the consolidation.

You can access this report in the Consolidation Monitor. You can also run the report
using the concurrent program FCH: Value Set Map Validation. For more information on
accessing this report, see Process Status, page 15-2.

You can customize the report by modifying the XML Publisher template.
See: Task 11: XML Publisher Templates, page 5-15.

Write Back to General Ledger Report

The Writeback to General Ledger report shows the balances written back to Oracle
General Ledger for a write back submission. This report is generated each time an
adjustment is written back to Oracle General Ledger. The balances are in General
Ledger segment format.

The Writeback to General Ledger Report has the following parameters:

¢ Entry- The name representing the write back entry.

¢ Hierarchy- The consolidation hierarchy of the adjustment written back.
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e Entity- The entity of consolidation hierarchy for the adjustment written back.
e Category- The category of the adjustment in Financial Consolidation Hub.

¢ Target Ledger- The ledger in Oracle General Ledger to which the adjustment is
written back.

e Target Ledger Period- The period in Oracle General Ledger to which the
adjustment is written back.

* Conversion Rate Type- The conversion rate type in Oracle General Ledger used to
convert the adjustment balances into the functional currency of the target ledger.
The rate type may be blank if no conversion is necessary.

e Target Category- The category in Oracle General Ledger to which the adjustment is
written back.

®  Currency- The functional currency of the target ledger. The adjustment balances are
automatically converted to this currency.

You can access this report in the Adjustment Writeback Details user interface. You can
also run the report using the concurrent program FCH: Value Set Map Validation.
See: Write back to General Ledger, page 16-6

You can customize the report by modifying the XML Publisher template.

See: Task 11: XML Publisher Templates, page 5-15
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Setting Up Analytical Reporting

Oracle's Corporate Performance Management Suite uses the analytical capabilities
embedded in Oracle 97 and 10g. Analytical reporting enables you to create ad-hoc
reports, set performance measures, distribute reports, and pivot and drill on
dimensions.

For more information on Analytical Reporting, see the Oracle Enterprise Planning and
Budgeting User’s Guide.

Setting Up Analytical Reporting

Initial Setup

Note: The following setup steps are recommended for consolidation
data only. If you are using analytical reporting for other applications,
please see the appropriate user guides.

To set up analytical reporting, perform the following procedures.

Before you can begin to set up analytical reporting, you must first perform the
following tasks:

1. Complete Foundation Task 12: Analytical Reporting.
See: Task 12: Analytical Reporting, page 5-16

2. Ensure that dimension hierarchies have been defined for all dimensions enabled for
reporting.

See: Task 7: Dimension Hierarchies, page 5-11
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Note: Ensure that each dimension hierarchy contains all the dimension
members of interest. If a dimension member is not included in the
hierarchy, analytical reporting will not report on any balances using
that dimension member.

Creating Functional Dimension Definition Rule for Intercompany

If you selected the Intercompany dimension as Used by Reporting, you must create a
functional dimension definition rule in order to see the dimension in Enterprise
Planning and Budgeting (EPB). The Intercompany dimension uses the same value set as
the Organization dimension, and a functional dimension rule lets EPB view
Intercompany and Organization as separate dimensions. For more information on
selecting the Intercompany dimension as Used by Reporting, seeTask 1: Processing
Keys, page 5-4.

Using the Enterprise Performance Foundation Administrator responsibility, navigate to
Configuration Rules>Functional Dimension Definition. To create a functional
dimension rule:

Note: These steps assume that your organization dimension is
"Company Cost Center Organization" and your intercompany
dimension is "Intercompany". If you have changed the names of the
dimensions, use the names you have selected.

1. Click Create.

2. On the Create Rule: Definition page, specify the following fields as described in

table below:
Field Description
Folder Select Default
Rule Name A name for the rule
Description Description for the rule
Access Select Read or Write

3. On the Create Rule: Functional Dimension Names and Mapping page, specify the
following fields as described in table below:
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Field Description

Dimension Company cost center organization
Functional Dimension Name Company cost center organization
Table Name Select the data table that you had selected in FCH

Foundation Task 12: Analytical Reporting, page 5-16.

Column Name Company Cost Center Organization

4. Click Add.

5. The values you entered disappears, as you will define an additional functional
dimension name. Specify the following fields as described in table below:

Field Description

Dimension Company cost center organization

Functional Dimension Name Intercompany

Table Name Select the data table that you had selected in FCH

Foundation Task 12: Analytical Reporting, page 5-16.

Column Name Intercompany

When you define a business area, assign this functional dimension definition rule to
include the Intercompany dimension for that business area.

Set Up Business Area

The business area pulls in the Ledger setup data from Oracle Enterprise Performance
Foundation into Oracle Enterprise Planning and Budgeting. One business area
represents one chart of accounts. Since Financial Consolidation Hub standardizes all
consolidation results into the Consolidation Global Value Set Combination, you can
create just one business area to hold all of your consolidation results. However, you can
also create separate business areas for each consolidation hierarchy if you wish to keep
the consolidation results more separated.

To create a business area, use the Enterprise Planning and Budgeting Controller
responsibility and navigate to the Business Area tab. When you create a business area,
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you will be presented with the following tabs:
General
* Business Area Name - Enter a unique business area name.

See: Task 1: Processing Keys, page 5-4

* Functional Dimension Rule- If you had enabled the Intercompany dimension as
Used by Reporting, you must create a functional dimension rule to represent the
Intercompany dimension, and select that rule in this parameter.

See: Task 1: Processing Keys, page 5-4

See: Creating Functional Dimension Definition Rule for Intercompany, page 19-2

* Enable Currency Option - The currency option will allow you to perform
translation within Enterprise Planning and Budgeting. Since consolidation results
are already translated to the consolidation currency, this option should not be
selected.

Ledgers

Add the ledgers that corresponds to your consolidation hierarchies. The ledger names
will be in the format <consolidation hierarchy> ledger. To see the ledger created for a
consolidation hierarchy, see Consolidation Hierarchy in Enterprise Performance
Foundation, page 13-1.

Dimensions

Add all of the dimensions that you selected to be Used by Reporting in Foundation
Task 1: Processing Keys. If you do not want to report on one of the reporting
dimensions, you can remove it in the business process.

Note: You do not need to select the dataset dimension. It is
automatically included and handled under the Data Sets tab. You also
do not need to select the Intercompany dimension. This dimension is
handled by a functional dimension rule that you define. For more
information on creating a functional dimension rule for Intercompany,
see Creating Functional Dimension Definition Rule for Intercompany,
page 19-2.

See: Task 1: Processing Keys, page 5-4

For each dimension, click Refine dimension. In Step 1, select any dimension hierarchies
you want to use as reporting hierarchies (see Task 7: Dimension Hierarchies, page 5-11).
In Step 2, set one of the selected hierarchies as the default hierarchy. In Step 3, select any
attributes you want to report against. In typical cases, you will not select any attributes,
as they are too granular for analytical reports and would reduce performance. Two
dimensions are treated differently:
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e Currency - You do not need to refine this dimension.

e Entity - Select the hierarchies that correspond to your consolidation hierarchies. The
hierarchies are named in the format <consolidation hierarchy> effective since <start
date of consolidation hierarchy>.

See: Consolidation Hierarchy in Enterprise Performance Foundation, page 13-1

Note: Ensure that there are no consolidation result balances for parent
values in the dimension hierarchies, with the exception of the entity
dimension. If a parent value has a balance, reports will be blank.

Data Sets

Add the data sets that correspond to your consolidation hierarchies and balance types.
Data Sets are named in the format <consolidation hierarchy>: <data type>. To see the
data sets created for the consolidation hierarchy, see Consolidation Hierarchy in
Enterprise Performance Foundation, page 13-1.

Note: There may be additional data sets with the description
<consolidation hierarchy>: <data type>, but a name of <number>: <data
type>. These data sets are used for backend processing, and should not
be selected.

Delete a Business Area

To delete a business area, use the Enterprise Planning and Budgeting Controller
responsibility, Business Area tab. Select the business area and click delete. The business
area and all related business processes and reports can be deleted.

Run Business Area

After you have set up a Business Area, perform the following steps to run it:

1. Make the Business Area Effective - This sets the current business area setup as the
setup to use when you refresh the business area. Ignore any warnings concerning
the length of hierarchy names.

2. Refresh the Business Area - This will pull all of the ledger setup into Enterprise
Planning and Budgeting. This launches the concurrent request Refresh Business
Area <business area> (ZPB: Refresh Business Area). If you previously had set the
security for the business area, it also launches the concurrent requests Stored
Queries for Business Area <business area> (ZPB: Update Business Area Queries)
and Security Rules for Business Area <business area> (ZPB: Update Business Area
User Scopes).
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If your consolidation chart of accounts changes later on, you have to refresh the
business area to pull the changes into Enterprise Planning and Budgeting. Here are
some common changes:

¢ Create or modify a dimension hierarchy for use in reporting.
¢ Create or modify dimension members in the consolidation chart of accounts.

* Modify your consolidation hierarchy

Note: You do not need to refresh the business area if the changes do not
affect the consolidation chart of accounts.

Set Access to the Business Area

After you run the business area, give the user access to the business area. Use the
Enterprise Planning and Budgeting Security Administrator responsibility, and navigate
to Security > Setup. If multiple business areas exist, you will be prompted to select a
business area. Perform the following steps:

Note: If you need to change business areas, you need to exit the
responsibility and reenter it.

1. Select the dimensions by which you want to enable security. You will be able to
restrict information to users according to this dimension. Typically, this is the entity
dimension. Click Apply and Enterprise Planning and Budgeting will run the
concurrent request ZPB SPL write back (ZPB: SPL Writeback) Monitor the
concurrent request and wait for it to finish.

2. Exit the Enterprise Planning and Budgeting Security Administrator responsibility.

3. Use the Enterprise Planning and Budgeting Security Administrator responsibility
and navigate to Security > New Accounts. Give the user full read access. Enterprise
Planning and Budgeting will run the concurrent request ZPB maintenance write
back (ZPB: SPL Writeback) Monitor the concurrent request and wait for it to finish.

Note: Your user will not show up in the New Accounts tab if the user
already has full read access. Instead, the user will show up only in the
Current Accounts tab.

Set Up Business Process

The business process pulls in balances into Enterprise Planning and Budgeting . One
business process represents one consolidation hierarchy and balance type. If you need
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to pull in multiple balance types, for example actual and budget, or consolidation
results from multiple consolidation hierarchies, you will have to create multiple
business processes.

To create a business process, use the Enterprise Planning and Budgeting Controller
responsibility and navigate to Administration > Business Processes. If you have access
to multiple business areas, you will be prompted to select a business area.

Note: If you need to change business areas, you will have to exit the
responsibility and reenter it.

When you create a business process, you will be presented with the following tabs:
General
Name - Enter a unique business process name under the selected business area.

Data set - Select one of the data sets that was assigned to the business area. Each data set
represents consolidation results for a consolidation hierarchy and balance type.

See: Data Sets, page 19-5

Optimize Storage for Sparse Data- Leave this option selected unless your data is dense
over the Line Item dimension.

Dimensions
Time Dimension - Select the period range for which you want to pull balances.

Additional Dimensions - Select the dimensions that you want to report on. You will be
able to select any dimension you had added to the Business Area under the Dimensions
tab.

See: Dimensions, page 19-4

Note: Calendar Period and Line Item must always be selected, and will
not show up in this chart.

Note: If no additional dimensions show up, make sure the Analytical
Reporting task was complete and the FCH: Consolidation Data Transfer
concurrent request completed successfully after you run consolidation.

See: Setting Up Analytical Reporting, page 19-1

Removed Data Set Dimensions - For dimension that you did not include in the
Additional Dimensions section, the business process will aggregate along those
dimensions. These dimensions will appear in the Removed Data Set Dimensions region.
For each of these dimensions, specify which values you wish to aggregate.

Note: If you do not select a dimension member value for which there
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are balances, the business process will not bring those balances into
EPB.

Solve

You can update how balances are calculated for each line item. The default behavior is
for child values to pull the balances from Enterprise Performance Foundation (Loaded)
and for parent values to sum their children's balances (Hierarchy Total). If you have Net
Profit being the parent of Revenue and Expense, you have to update Net Profit to make
it equal to Revenue minus Expense. To do so, perform the following steps:

1. Click Update for Net Profit.
2. Select Calculated and click Define Calculation.
3. Select Simple Math and click Continue.

4. For Line Item 1, select Revenue. For Operator, select - For Operand, select Line Item
2, Expense.

In addition, you need to stop Enterprise Planning and Budgeting from aggregating
along the entity dimension. Aggregation has already occurred during consolidation
processing.

1. For a line item which has a source of Loaded, click update.
2. Click Next.

3. Update Solve: Dimension Handling.

For the Entity Dimension, select Exclude From Solve. Click Next.

4. Update Solve: Input and Output Selections

For the Entity dimension, select Use Input as Output. Then for the Entity
dimension, click Update Input. Delete the existing step, and create a new step, that
is Select Members, and select all entities in your consolidation hierarchy. Click Next
twice, then Finish.

5. You should be back under the Solve subtab. For the line item that you have just
modified, click Propagate.

6. In the Settings region, select Input Selections, Output Selections, and Dimension
Handling. Select all line items in the Targets region. Click Apply.

Tasks
Add the following tasks in the given order:

1. Load data - This pulls the balances into Enterprise Planning and Budgeting. Leave
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all parameters as default

2. Solve - This calculates the balances for parent values in the dimension hierarchies.
Leave all parameters as default.

3. Set Current Process Run - Each time you run a business process, it creates a new
view. This task will create a view named <business process> - Current Instance,
which will always point to the latest view for the business process. This way, when
you create a report, you can select the current instance view to make sure the report
always reflects the latest data pulled into Enterprise Planning and Budgeting.

There are additional tasks that may be useful to you. Please refer to the Enterprise
Planning and Budgeting Users Guide for a description of the other tasks.

Schedule
Set the following parameters:

1. Frequency - You can have the business process automatically run on a scheduled
interval, or have the business process run just once. You can also set a business
process to be run by procedural call, which allows it to be automatically run after
you run consolidation.

See: Submitting Consolidations, page 15-4.
Note: If you set a business process to be run by procedural call, you

will need to make it effective before it can be automatically run
after consolidation.

2. Number of Process Run Stored - Each time you run the business process, it stores
the balances it pulled in a view. Select the number of views to archive.

Note: It is recommended that you select three. This gives you the ability
to see past runs, but does not produce a space burden.

Run Business Process

After you have set up a business process, you can run it.

Each time you run a business process, it pulls all designated balances into Enterprise
Planning and Budgeting. This set of balances is called a view. Each time you run the
business process, it creates a new view. The views are named <business process>
<number>, where <number> starts at 000 and increments each time you run the business
process.

Note: You can use the business process task, Set Current Process Run,
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to always point at the most current view. See Schedule, page 19-9

If your consolidation results change in Financial Consolidation Hub, you have to run
the business process again to pull in the new balances.

To run a business process, click Draft for the business process, then Make Effective. This
will launch the following concurrent requests one at a time:

1. ZPB:BP Validation CP

2. ZPB: Make Analysis Cycle Instance for Workflow
3. ZPB: Load Data

4. ZPB: Run Solve

5. ZPB SPL write back (ZPB: SPL Writeback)

Note: Additional concurrent request may be launched depending on
any additional tasks you added to the business process.

Monitor the concurrent requests and verify that they complete successfully. In order to
access to the new view, you will have to first exit the Enterprise Planning and
Budgeting Controller responsibility, then reenter it.

Note: If the business process does not launch the concurrent requests
automatically, use the System Administrator responsibility and run the
concurrent request Workflow Background Process with the parameters
Process Deferred and Process Timeout set to Yes.

Note: If you update a business process, then the next time you click
Make Effective, the business process will run with the pre-update
parameters. You will have to run (click Make Effective) the business
process an additional second time to have it run with the new
parameters.

Note: If the business process is set to run by procedural call, when you
make the business process effective, it will not run the business process
and launch any concurrent requests. Instead, when you submit
consolidation, you can select the business process to run directly after
consolidation completes.

See: Submitting Consolidations, page 15-4.
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Creating and Sharing Reports

After successful completion of a business process, you can use the results in analytical
reports and graphs. You can create, save, open, and modify reports. Reports exist in an
online file system of folders that allows other designated users to access your reports.

When you finish adjusting the content and format of the report, click Save. You can
place the report in the Public Folder or any other folder you have access to . All users
have access to the Public Folder, while access to other folders may be restricted.

The Report Properties icon on the Reports page can be used to give other users access to
the report. When accessing the report, the read access restrictions applicable for other
users are automatically applied to the report.

Note: Financial Consolidation Hub uses the signage methodology
Standard GAAP. However, consolidation results in Analytical
Reporting use a different methodology to make report definition easier
and more compliant with published financial statements. No negative
sign is used unless the balance is opposite what would be normally
expected. For example, a liability balance in FCH of ~100 would show
up as a balance of 100 in Analytical Reporting. The signage is converted
to the Analytical Report format when the consolidation results are
move from the FEM_BALANCES table to the data table specified in the
Analytical Reporting task.

See: Setting Up Analytical Reporting, page 19-1

Creating a Report

To create a report, use the Enterprise Planning and Budgeting Controller responsibility
and navigate to Documents > Reports. Perform the following:

1. Navigate to a folder and Click Report.
See: Sharing Reports, page 19-11

2. Select a crosstab report.
3. Click Continue.

4. Select the views you want to use in the report. You can select multiple views for a
report, from any of the views that were created in the business area. This means
that you can compare consolidation results between different consolidation
hierarchies and balance types.

See Run Business Process, page 19-5
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Editing a Report

Select the line items you want to view in the report.
Click Continue.

You will see each reporting dimension you selected in business process under the
Dimensions tab. For each dimension, you can select the values you want to view in
the report.

See: Dimensions, page 19-4

Click Finish. You will have now created an analytical report.

There are many ways to edit an analytical report. Here are a few common ways to
modify reports.

Expand/Collapse Dimension Hierarchy - In the chart region of the report, you will
see triangles next to parent values in the rows and columns. Click on the triangles to
the expand/collapse the parents' children.

Select Values in Each Dimension - You can choose which values are to be shown for
each dimension in a report. To select which values will be shown, click Edit in the
report.

Saved Selections - If you select values in each dimension, and want to reuse that
grouping of values, you can save it as a saved selection. First, select the grouping as
outlined in Select Values in Each Dimension. Click Save As for the dimension.

Layout - Determine which dimensions show up in the rows and columns of the
chart region of the report. All remaining dimensions can either be a page level item
or a hidden item. To change the layout, click the Layout link in the Tools region.

Note: Hidden dimensions are automatically set to the default detail
value.

Select Page Level Item - For dimensions that are page level items, select a value in
that dimension. The chart region will report based on the selected value.

Formatting - You can change the formatting of cells in the chart regions. For
example, setting font to bold or changing the color of the cell. To change formatting,
click the Format link in the Tools region.

Annotations - You can write notes and attach them to cells. The notes will be
archived and can be viewed and sent to other users. To create annotations, click the
Annotations link in the Tools region.
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e Calculations - You can insert calculations on the data in your report. To insert
calculations, click the Calculation link in the Tools region.

For more information on ways to manipulate analytical reports, please refer to the
Enterprise Planning and Budgeting User’s Guide.

Sharing Reports

You can share reports with other users by setting the proper security for reports and
folders. You can control which users can view or overwrite reports, and which ones can
change the security settings.

To set the security privileges for a report or folder, use the Enterprise Planning and
Budgeting Controller responsibility, and navigate to Documents > Reports. Find the
report or folder in the online folder system, and click Properties. Then expand the
Privileges region.

Note: The Public Folder can be viewed and written to by all users.

For more information on the analytical reporting security model, see the Enterprise
Planning and Budgeting User’s Guide.
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Setting Up Excel Add-in

Overview

The Excel Add-in is an Excel-based analytical reporting tool that allows you to access
Analytical Reports via Excel. Using the Excel Add-in, you have access to the core
functionality of Analytical Reporting like creating and modifying reports with
additional features like drilldown to source data and saving to computer. In addition,
you can leverage standard Excel functionality to further modify your reports.

See: Setting Up Analytical Reporting, page 19-1

Note: Financial Consolidation Hub uses the signage methodology
Standard GAAP. However, consolidation results in Analytical
Reporting use a different methodology to make report definition easier
and more compliant with published financial statements. No negative
sign is used unless the balance is opposite what would be normally
expected. For example, a liability balance in Financial Consolidation
Hub of 100 would show up as a balance of 100 in Analytical
Reporting. The signage is converted to the Analytical Report format
when the consolidation results are move from the FEM_BALANCES
table to the data table specified in the Analytical Reporting task.

See: Setting Up Analytical Reporting, page 19-1

Initial Setup

The Excel Add-in is a client side tool that you install onto your computer. When
installed, a new menu Consolidation is created in Excel. You will use this menu to
access the Excel Add-in functionality.

Installing Excel Add-in

In Oracle Financial Consolidation Hub, navigate to Consolidation > Reporting > Excel
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Add-in. Download the setup file and install the Excel Add-in onto your computer.

Note: If you have an earlier version of the Excel Add-in, you must first
uninstall it.

The Excel Add-in has the following system requirements:

e Operating System: Microsoft Windows 2000 or above
*  Microsoft Excel: 2000 or above
* .NET Framework Redistributable Package: 1.1 or above

Once Excel Add-in is installed, an additional menu in Excel called Consolidation gets
added.

Setting the Host Environment

Logging in

Reports

After the Excel Add-in is installed, you may need to configure the host environment. It
defaults to the environment from which you downloaded the Excel Add-in.

To change the host name, navigate to the Excel menu Consolidation > Options.

See: Excel Add-in Configuration Options, page 20-9

The Excel Add-in leverages the same login and security model as the online Analytical
Reporting. Use the same user name and password that you use for Financial
Consolidation Hub and Analytical Reporting, and you will have access to the same
reports you would in the Enterprise Planning and Budgeting user interface.

After you log in, you are prompted to select a business area. Once you select a business
area, you can work with reports and saved selections. If a report is already open in
Excel, you are asked if you want to reconnect that report and its corresponding business
area.

The Excel Add-in allows you to create reports utilizing both the core Analytical
Reporting functionality and Excel functionality. These reports can be saved to the
Enterprise Planning and Budgeting online folder system, or onto your computer.

Note: Only one report can be connected to the environment at a time. If
you have a report connected to the environment, then open or create
another report, the older report is disconnected and you cannot access
the Analytical Reporting functionality.
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Report Types

You can perform two types of modifications to a report in the Excel Add-in:

* Analytical Report modifications, for example which dimension show up in the
columns and rows. These modifications are outlined in Modifying Reports, page 20-
5.

®  Excel modifications such as adding Excel formulas and charts.

The Excel Add-in supports the following two types of reports to capture the different
types of modifications.

Analytical Reports

These reports record only Analytical report modifications and you can create and
modify these reports in the Enterprise Planning and Budgeting user interface. The Excel
Add-in can access and modify any Analytical reports created in the EPB user interface
and vice versa. If you modify an Analytical report using Excel functionality, you can
view the Excel modifications but cannot save it.

Formatted Analytical Reports

Formatted Analytical reports include both Analytical report modifications and Excel
modifications. You can create, open and modify Formatted Analytical reports in the
Excel Add-in only. These reports cannot be opened or created in the Enterprise
Planning and Budgeting user interface. However, an Analytical Report can be modified
and saved as a Formatted Analytical report.

Note: When you save a Formatted Analytical report, the corresponding
base Analytical report is saved in a sub folder of your target folder
named FCH_BASE_REPORTS. If the base Analytical report is modified,
the Formatted Analytical report will no longer be able to be modified
through Analytical Report modifications.

Opening and Saving Reports

You can manager reports both online and on your computer.

Note: You can only connect one report to the environment at a time. If
you have a report connected to the environment and you create or open
another report, the older report is disconnected and cannot access the
Analytical Reporting functionality.

Reports Online

Enterprise Planning and Budgeting provides an online folder system to manage reports.
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The Excel Add-in uses the same online folder system. This allows reports to be shared
between users and between the Enterprise Planning and Budgeting user interface and
the Excel Add-in. The Excel Add-in utilizes the Analytical Reporting security model to
determine which reports you have access to.

To save a report, perform the following steps:

1. Select the Report > Save As function under the Consolidation menu.

2. Select a name and online folder to save the report into. Optionally give the report a
description. You may overwrite any report for which you have write access. You
can also set the security access for the report. The user who creates a new report
will automatically be given full access to it.

See: Security, page 20-9

To open a report, perform the following steps:

1. Select the Report > Open function under the Consolidation menu.

2. Select a report. You can select a different template. The template is an Excel file that
determines the formatting of the report. You can modify an existing template or
create new ones to incorporate different formatting such as fonts, colors, and
images. The Excel Add-in comes with the default template OracleTemplate.xls

3. Click Open.

Reports On Computer

The Excel Add-in allows you to save reports to your computer. To save the report to
your computer, save the Excel spreadsheet using the Save and Save As functions from
the File menu.

To open a report on your computer, open the spreadsheet file. If prompted, enable
macros. Then log in to the environment. You will be asked if you want to reconnect the
report to the environment. If the report on your computer differs from the online
version due to analytical reporting modifications, you will no longer be able to perform
any analytical reporting modifications on the computer-based report. If the report on
your computer differs from the online version due to excel modifications, your
computer-based report will be reconnected with its existing excel modifications.

Note: You must save the report online before you can save it to your
computer.

Creating Reports

To create a report in the Excel Add-in, perform the following steps:
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1. Select the Report > Create function under the Consolidation menu.
2. Select the views you want to use in the report. Click Next.

3. For each reporting dimension, select a saved selection. Click Next. For information
on creating saved selections in the Excel Add-in.

See: Creating Saved Selections, page 20-8

Note: The Enterprise Planning and Budgeting user interface allows
you to select members for each dimension during the process of
report creation. The Excel Add-in, however, requires that you first
create saved selections for each dimension before you create a
report.

4. Determine the layout of the report. Drag and drop the dimensions to determine if
they will be in the rows, columns, page level, or hidden for the report. If there are
multiple dimensions in any of the regions, you can drag and drop to reorder them.
Click OK.

Once a report is created, you can save it to the Enterprise Planning and Budgeting
online folder system.

Note: You must save a created report to the Enterprise Planning and
Budgeting online folder system in order to access it later.

Note: You can only connect one report to the environment at a time. If
you have a report connected to the environment, then create or open
another report, the older report is disconnected and cannot access the
Analytical Reporting functionality.

Modifying Reports using Analytical Report Modifications

The Excel Add-in provides the core analytical reporting functionality available in the
Enterprise Planning and Budgeting user interface and some additional features not
available in the user interface.

This section will describe the Analytical Report modifications available in the Excel
Add-in.

Expand/Collapse Hierarchies

Expand or collapse parent nodes in the rows and columns report to show or hide the
parents' children, respectively.

Select Page Level Item
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For dimensions in the page level of a report, you can select a particular value. If
multiple values are available, the page level value is a list. When you select a value, the
report will refresh to show the balances that correspond to the selected value.

Export to PDF

You can export a report to PDF format. To do so, select the Report > Export to PDF
function under the Consolidation menu.

Note: The Export to PDF functionality currently does not support
images.

Saved Selections

To assign saved selections to a report, select the Report > Saved Selections function from
the Consolidation menu. The window will list all of the reporting dimensions. To select
a saved selection for a dimension, use the list next to the dimension. If you want to set
the values to be the original values when you opened or created the report, change the
current values showing up for a dimension, leave the list on Original Selection.

See: Creating Saved Selections, page 20-8

Note: The Enterprise Planning and Budgeting user interface allows you
to select members for a dimension without saving it as a saved
selection. The Excel Add-in, however, does not allow you to do this.

Layout

To change the layout of the report, select the Report > Layout function under the
Consolidation menu. Drag and drop which dimensions will show up in the rows and
columns of the report, which dimensions will be at the page level and which are
hidden. If there are multiple dimensions in any of the regions, you can drag and drop to
reorder them.

Modifying Reports using Excel Modifications

You can modify a report with any functionality available in Excel, anywhere in the
spreadsheet. Some examples of Excel functionality are:

* Insert Excel formula into the chart region of the report.
¢ Create an Excel chart based off of the report.

* Change the font, colors, and bordering of the report.

¢ Add titles and additional text to the report.

You can create Excel formulas and charts based off of the report. If the balances in the
report are changed due to analytical report modifications, for example selecting a
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different page level item value, the formulas and charts will automatically read the new
balances and get updated.

You can use Excel modifications in conjunction with analytical report modifications.
However, if you perform any analytical report modifications other than expanding and
collapsing hierarchies or changing page level item values, the existing Excel
modifications are removed.

Drilldown
The Excel Add-in allows you to drilldown from the consolidation balances in the report
to the pre-consolidated balances in the entity's local chart of accounts. If the entity
sources from Oracle General Ledger, you can drilldown to the subledger level.
Balances that are available for drilldown are represented as hyperlinks. Drilldown is
available for balances of the following conditions:
e Each page level item is set to either the top parent of the hierarchy or a detail
(non-parent) value. If the entity dimension is a page level item, set it to an operating
entity. If the calendar is a page level item, set it to a detail value.
® The balance corresponds to detail (non-parent) values for all dimensions in the
rows and columns of the report. If the entity dimension is in the rows or columns,
the balance must correspond to an operating entity. If the calendar is in the rows or
columns, the balance must correspond to a detail value.
Note: This feature is specific to the Excel Add-in, and does not exist in
the Enterprise Planning and Budgeting user interface.
Pending Changes

After consolidation results are pulled into Analytical Reporting, the results may become
inaccurate due to impacts. In this case, the Analytical Reports are also inaccurate. If
consolidation results of a report are impacted after you have pulled the consolidation
balances into Analytical Reporting, a Pending Changes subtab appears on the report.
The Pending Changes subtab will list the impacts and the periods affected. The impacts
are those outlined in Impacted Status, page 15-2.

In order to incorporate the impacts, first rerun consolidation, then make effective the
business process, then set the report to the most current view. The Pending Changes
subtab will disappear from the report.

Note: This feature is specific to the Excel Add-in, and does not exist in
the Enterprise Planning and Budgeting user interface.
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Saved Selections

The Excel Add-in allows you to create and manage saved selections independently of

reports.

Note: This feature is specific to the Excel Add-in. Enterprise Planning
and Budgeting only allows you to create and manage saved selections
within the report user interface.

Creating Saved Selections

To create a saved selection, perform the following steps:

1.

Select the Saved Selection > Create function under the Consolidation menu.

Select a dimension. You may either select a dimension hierarchy or select None. If

you select None, you will have available all of the dimension members in a flat
format. Click Next.

Note: As dimension hierarchies can not be created for the View and
Currency dimensions, you will have to select None for these
dimensions.

Select dimension members that you want to include in the saved selection. You can
perform the following functions:

Search for values. You can search for available values within the dimension
hierarchy. Select a search result to see its location in the hierarchy.

Add values. To add a value to the saved selection, drag and drop it from the
Available region to a location in the dimension hierarchy in the Selected region.
It is placed in the selected location of the hierarchy. If the value is a parent
value, its descendants will automatically be added with it. You can select just
the parent value by selecting the Drag Parent Node Only option.

Remove values. To remove a value from the saved selection, drag and drop it
from the Selected region to anywhere in the Available region. To remove all
selected values, click Clear All.

Reorder values. To reorder a value in the saved selection, drag and drop it to
the desired location in the dimension hierarchy. If the value is a parent value,
its descendants will automatically be brought with it.

20-8 Oracle Financial Consolidation Hub User's Guide



Note: The Excel Add-in can only pull values from a selected
dimension hierarchy. It can not pull values from existing saved
selections.

4. Select a name and online folder to save the saved selection into. Optionally enter a
description for the saved selection. You may overwrite any saved selection for
which you have write access. You can also set the security access for the saved
selection. Your user will automatically be given full access.

See: Security, page 20-9

Modifying Saved Selections

To modify a saved selection, perform the following steps:
1. Select the Saved Selection > Modify function under the Consolidation menu.

2. Select a saved selection. You will see all of the saved selections for which you have
access. Click Open.

3. Follow the same steps as in Creating Saved Selections, page 20-8.

Security

The Excel Add-in utilizes the Analytical Reporting security model. Any report or saved
selection that you have access to in the Enterprise Planning and Budgeting user
interface, the same access is also applicable to you in the Excel Add-in as well.

When you save a report or saved selection, your user is given full access. During the
save process, you can set the security access by clicking the Security button. You can
grant eligible users read, write, or full access.

For more information on Analytical Reporting security, see the Enterprise Planning and
Budgeting User Guide..

Excel Add-in Configuration Options

To access the configuration options for the Excel Add-in, select the Options function
under the Consolidation menu. The Excel Add-in has the following options:

* Host Name - Select the host name of the environment. The host name should be
entered in the <host name>:<port> format. The host name defaults to the
environment from which you downloaded the Excel Add-in.

¢ Temporary Directory - Select a directory to which the Excel Add-in may
temporarily write files during its operation.
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® Enable Trace - Select the check box to enable tracing. A trace file will be written that
logs the operations of the Excel Add-in. This trace file can be used to debug any
problems that occur when using the Excel Add-in.

e Trace Level - Select the trace level to be ERROR, DEBUG, or STATEMENT. ERROR
will only record to the trace file errors that occur during the operation of the Excel
Add-in, while STATEMENT will record each individual statement executed.
DEBUG will provide a level of detail between ERROR and STATEMENT.

e Trace File - Select the location and name of the trace file.
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Overview

Security

Security is a feature that enables individuals to access, load, or consolidate data based
on their responsibility within an organization. For example, consolidation managers at
corporate headquarters may need access to the entire corporate hierarchy, whereas
those at a subsidiary may only be allowed access to the data related to their region.
Additionally, consolidation analysts at corporate headquarters may only be allowed to
input consolidation adjustments, but not to launch the consolidation process.

Financial Consolidation Hub enables you to secure data using either or both of the
following security methods:

* Role-based security
¢ Function-based security

Security for Enterprise Planning and Budgeting (EPB) reporting is not discussed in this
chapter. Financial Consolidation Hub security does not transfer to EPB. For information
on security for EPB reporting, see Administering Security, Oracle Enterprise Planning and
Budgeting User’s Guide.

Role-Based Security

Roles represent one or more users. You must perform the following steps to use the role
based security model:

1. Create users, which creates roles automatically.
2. Optionally, group users within roles.

3. Assign roles to entities and/or hierarchies.
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Assigning Roles

You can assign entities and consolidation hierarchies to a role in the Role page.
Alternatively, you can also assign roles in the following pages:

* Operating entities in the create operating entity or the update entity page

* Consolidation hierarchies in the create consolidation hierarchy or the update
consolidation hierarchy: header page

* Consolidation entities in the create consolidation entity or the update entity page

Securing Operating Entities
Securing operating entities enables you to grant the privileges of loading data or

adjustments for an operating entity to a specific set of users for that entity. This also
enables you to grant the privileges of viewing and updating entity attributes.

Securing Consolidation Hierarchies

Securing consolidation hierarchies enables you to grant the privileges of viewing,
modifying, and running consolidations to a specific set of users for that hierarchy.

Securing Consolidation Entities

Securing consolidation entities enables you to grant the privilege of viewing
consolidation results, making adjustments to elimination entities, and executing
consolidations to a specific set of users.

Note: The hierarchy and consolidation entity security may be used
together, allowing you an even finer level of security.

Example

Consider the consolidation hierarchy in the figure below and assume that user Joe
Smith has access to it based on role security. Assume role security has been enabled for
each entity, and that Joe Smith has not been assigned access to an entity unless
otherwise stated.
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If Joe Smith only has access to consolidation entity Corporate and Subsidiaries , then he
has access to the consolidation results for the entire branch under Corporate and

Subsidiaries, including Operations and Subsidiaries.

If Joe Smith only has access to operating entity Corporation, then he can load data and

enter operating adjustments for Corporation only.

If Joe Smith has access to consolidation entity Corporation and Subsidiaries and to
consolidation entity EMEA and Subsidiaries, he has access to the branch under
Corporation and Subsidiaries , as well as to the branch under EMEA and Subsidiaries.

If Joe Smith has access to consolidation entity Global and Subsidiaries, he has access to
the consolidation results for the entire consolidation hierarchy.
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Related Topics
Overview, page 21-1

Function-Based Security

Function-based security is related to the responsibility you select when you log in.
Responsibilities include specific functions, user interface elements, and menus, which
determine the pages to which you have access. If a responsibility you log into does not
include specific functions, user interface elements, or menus, those items are not visible
to you.

The following table indicates the seeded responsibilities with their associated functions:

Seeded Responsibilities with Associated Functions

Seeded Responsibility Functions

Entity Controller submits data for operating entities

Consolidation Manager creates and updates all setup elements
submits data for operating entities

submits consolidations

views consolidation reports

Note: For information on responsibilities relating to analysis of
consolidation results, see the Setting Up Analytical Reporting, page 19-
1.

You can create user-defined responsibilities. For example, you can create a
responsibility for setup that contains only the functionality under the Setup tab. For
information on creating a responsibility, see Defining a Responsibility, Oracle
Applications System Administrator’s Guide.
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Integrating with Oracle Internal Controls
Manager

Overview

As much as Sarbanes-Oxley has helped to restore investor confidence, the law continues
to weigh down public companies. The costs associated with compliance are significant,
and the time and effort required are keeping some finance executives away from more
strategic initiatives. Companies will need to build reliable and repeatable compliance
processes if they want to create a sustainable approach to compliance. Oracle Internal
Controls Manager (ICM) enables companies to document, test, monitor, and certify
ongoing compliance with Sarbanes-Oxley Section 404. Internal Controls Manager
provides the vital link between the business process and the financial statements. The
integration between Internal Controls Manager and Financial Consolidation Hub allows
companies to review and assess the adequacy of controls in their business processes.
For more information on Internal Controls Manager, see the Oracle Internal Controls
Manager Implementation Guide.

Setup for Integration with Internal Controls Manager

The integration between Internal Controls Manger and Financial Consolidation Hub
lets you certify the consolidation results of a consolidation hierarchy. To setup
integration, you must perform the following tasks:

1. Initial setup: This involves setting relevant environment options for communication
between Financial Consolidation Hub and Internal Controls Manager.

2. Create auditable units: Auditable units serve as certification points for your entities.
3. Enable certification for a consolidation hierarchy: You can perform Internal

Controls Manager certification against the hierarchy you select in Financial
Consolidation Hub.

Integrating with Oracle Internal Controls Manager 22-1



Create ICM Business Process and Financial Statement: The previous steps will make
the selected consolidation hierarchy available to these core Internal Control
Manager components.

Note: These setup tasks utilize the Internal Controls Manager Super
User and Signing Officer responsibilities.

Initial Setup Tasks for Internal Controls Manager Integration

Before you can use Internal Controls Manager with Financial Consolidation Hub, you
must perform the following initial setup tasks.

1.

3.

Using the Consolidation Manager responsibility, navigate to
Setup>Foundation>Task 12 Analytical Reporting. In the Line Item Hierarchy field,
select the line item hierarchy you want to use for certification.

Note: Internal Controls Manger performs certification by a line item
hierarchy and/or organization hierarchy. This step determines the
line item hierarchy.

Using the System Administrator responsibility, navigate to Profile>System, set the
following profile options:

Profile Value

AMW: Default Calendar The consolidation calendar of the
consolidation hierarchy you want to certify
with Internal Controls Manager.

AMW: Subsidiary Value Set for Audit Unit ~FCH_ICM_ENTITY_VALUE_SET

Using the Consolidation Manager responsibility, run the FCH: Set Internal Controls
Manager Profile Options Values concurrent request.

Creating Auditable Units

Auditable units are the key building blocks in Internal Controls Manager. In setup, you
can create and attach multiple auditable units to each operating or consolidation entity.

Each auditable unit can only be attached to one entity. You can also create auditable

units in Oracle Human Resources.

For more information on how to create auditable units in Oracle Human Resources, see
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the Oracle Internal Controls Manager Implementation Guide.

Using the Consolidation Manager responsibility, navigate to Setup>Auditable Unit.
This page allowsyou to create, view, and modify auditable units.

Enabling Certification for a Consolidation Hierarchy

To enable a consolidation hierarchy for Internal Controls Manager certification, do the
following:

1. Set the Used for Certification hierarchy option to Yes.

Note: You can only have one consolidation hierarchy enabled for
certification at a time.

Note: Internal Controls Manger performs certification by a line item
hierarchy and/or organization hierarchy. When you enable a
consolidation hierarchy for certification, the organization hierarchy
corresponding to the consolidation hierarchy is created in Internal
Controls Manager.

2. Using the Internal Controls Manager Super User responsibility, run the Import
Natural Accounts concurrent request.

Once a hierarchy has been enabled for certification, additional certification fields will
show up in the consolidation monitor for that hierarchy.
See:Monitoring Financial Statement Certification Status, page 22-4

See: Monitoring Organization Certification Status, page 22-4

Creating Business Process and Financial Statement

By performing the previous tasks, the auditable units, line item hierarchy and
consolidation hierarchy structure will now exist in Internal Controls Manager. When
you set up the ICM business process and financial statements for the consolidation
hierarchy, you can select the correct parameters that correspond to the FCH objects.

1. Create business process: Using the Signing Officer responsibility, navigate to
Business Processes>Certification. Create a business process certification and select
to Include all Organizations and Processes into scope.

2. Create financial statement: Using the Signing Officer responsibility, navigate to
Financial Statements>Certifications. Create a new financial statement using the
following parameters:
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Parameter Value

Financial Statement Name of Consolidation Hierarchy

Included Certifications The business process you created in step 1

Note: You can create as many financial statement certifications for
the financial statement in each period as you want in Internal
Controls Manager, but Financial Consolidation Hub only shows the
status for the latest certification in the consolidation monitor. For
this reason, we recommend you to create one certification in each
period.

Monitoring Financial Statement Certification Status

The consolidation monitor provides you an entry point to view the status of financial
statement certification. If a consolidation hierarchy is enabled for certification, then in
the consolidation monitor the View Financial Statement Certification Status button
appears. Click the View Financial Statement Certification Status button to bring up the
page in Internal Controls Manager where you can view the certification status by
financial line item. This is the same page you would see when you view the Financial
Items sub tab of the underlying financial statement certification in Internal Controls
Manager. You can perform updates while still being able to navigate back to Financial
Consolidation Hub.

For more information, see the Oracle Internal Controls Manager Implementation Guide.

Monitoring Organization Certification Status

The consolidation monitor provides you an alternative view of the certification by
organization. If a consolidation hierarchy is enabled for certification, then in the
consolidation monitor the certification status column appears. The certification status
column shows you the overall status for the consolidation entity. The percentages and
the icons show the status of the certification and keep track of the progress.

Click the Certification Status icon to bring up the next page where you can see more
details for the consolidation entity and each operating entity underneath it. The
percentages and the icons help you keep track of the progress.

Click any of the links for a particular operating or consolidation entity to bring up the
page in Internal Controls Manager where you can view the certification status for each
auditable unit associated with the entity. This is the same page you would see when
you view the My Organizations sub tab of the underlying business process certification
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in Internal Controls Manager. From this page, you can perform updates while still being
able to navigate back to Financial Consolidation Hub.

For more information, see the Oracle Internal Controls Manager Implementation Guide.

Note: Percentages shown in the pages are derived from the percentages
of organization-process pairs that were certified with no issues. For
example, entity Vision Corporate Operations has two auditable units -
Finance and HR. Finance has two processes associated with it, one of
which has been certified with no issues. Human Resource has three
processes associated with it, two of which have been certified with no
issues. The percentage of completion shown for Vision Corporate
Operations would be 60%.
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WebADI Spreadsheets

WebADI Spreadsheets

Financial Consolidation Hub utilizes WebADI spreadsheets to allow you to upload and
manage moderate amounts data. WebADI spreadsheets give Excel a live connection to
your instance, allowing you to both pull information from the environment and upload
it within Excel. This chapter provides in detail how Financial Consolidation Hub uses
WebADI spreadsheets.

Financial Consolidation Hub uses WebADI spreadsheet loaders for the following tasks:

® Create and Update Dimension Members

® Create and Update Dimension Hierarchies

* Create and Update Value Set Maps

¢ Create and Update Historical Rates

® Create and Update Line Item Intercompany Maps

* Create and Update Adjustments

® Create and Update Acquisition and Disposal Entries

e Perform Data Submission for External Sources

Requirements

You must set the proper security options in Excel to enable WebADI.
Excel 2000

Navigate to Tools > Macro > Security
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1. Set Security Level to Medium on the Security Level tab.
2. Select, Trust all installed add-ins and templates, on the Trusted Sources tab.

Excel 2003
Navigate to Tools > Macro > Security

1. Set Security Level to Medium on the Security Level tab.
2. Select, Trust all installed add-ins and templates, on the Trusted Publishers tab.
3. Select, Trust access to Visual Basic Project, on the Trusted Publishers tab.

For more information on setting Excel security, refer to your Microsoft Excel
documentation.

Downloading WebADI Spreadsheets

There is no installation for WebADI spreadsheets. Whenever you initiate the WebADI
spreadsheet loader in the Financial Consolidation Hub window (for example, clicking
the Data Submission icon), Excel opens on your computer. The WebADI tool is
automatically downloaded into your excel and a connection to your environment is
established. Furthermore, instead of opening Excel, you can choose to save an excel file
to your computer. You can then open the file at your leisure with the same effect.

Note: When you open a WebADI spreadsheet, Excel may prompt you
that the file contains macros. If this happens, click Enable Macros.

Note: It is recommended that you close all Excel spreadsheets on your
computer before opening a WebADI spreadsheet. If other spreadsheets
are open, especially other WebADI spreadsheets, your WebADI
spreadsheet may not download properly.

Note: If you experience problems opening the WebADI spreadsheet
directly from the Financial Consolidation Hub window, try to first save
the Excel file to your computer, then open it from there.

Uploading WebADI Spreadsheets

After you have entered all the data into a WebADI spreadsheet, upload it into the
environment. In the Oracle menu, click Upload to upload the spreadsheet. WebADI will
first validate the following:
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® Selected values are in the list of valid values pulled from the environment.
e All required fields have been filled.

¢ There are no duplicate rows.

¢ Any other requirement based on the task being performed.

If WebADI finds any errors in the spreadsheet, it stops the upload and mark the errors
in the spreadsheet. If it does not find any errors, it begins to upload the data. Once the
data is uploaded, you receive a confirmation message and all uploaded rows are
marked with a green smiley face.

Note: The confirmation message and green smiley faces do not
necessarily mean that the data has successfully been uploaded into
Financial Consolidation Hub. Once data has been uploaded from
WebAD], a concurrent request is launched to pull the data in Financial
Consolidation Hub. The concurrent request performs additional checks
and may block the upload process.

Uploading WebADI Spreadsheets Selected User Interface Elements
Rows to Upload

You can choose to upload all rows that exist in the spreadsheet, or to upload only rows
that are flagged in the Upl column.

Duplicate Resolution Profile

The WebADI spreadsheet does not allow you to upload two identical rows.

Note: In the case of uploading balances, it ignores the balance amount
and does not let you upload identical account combinations.

If duplicate rows are found, you can choose to either stop the upload of the entire
spreadsheet, or to upload all of the spreadsheet except for the duplicate rows. If you
choose the latter, it will also upload the first instance of each group of duplicate rows.

Note: Other options may appear in the Upload Parameters window. If
options do appear, they will be discussed in the relevant sections.

WebADI Selected User Interface Elements

WebADI spreadsheets modify the normal Excel functionality in two ways. First, it adds
an Oracle menu. This menu manages the top level upload and download process of the
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spreadsheet. Second, in some cells you may now select from a list of values.
Dropdown Box Cells

When you need to select a value from a list of values for a cell, you may be presented
with a list of valid values in the form of a dropdown box.

Double Click Cells

If a cell requires you to select a value from a list of values and there is no dropdown
box, you can see a list of valid values by double clicking the cell. The list of values is
pulled directly from the environment.

List of Values

If a cell requires you to select a value from a list of values and there is no dropdown
box, you can see a list of valid values by highlighting the cell, then clicking List of
Values from the Oracle menu. The list of values is pulled directly from the environment.

Upload

From the Oracle menu, select Upload to upload all of the data you have entered.
See: Uploading WebADI Spreadsheets, page A-2

Monitor

From the Oracle menu, select Monitor to monitor concurrent programs.
Download

From the Oracle menu, select Download to connect to the environment. However, this
function is not needed as Financial Consolidation Hub has the WebADI spreadsheet
automatically connect to the environment once it is opened.

About

From the Oracle menu, select About to see the version information for your Oracle
WebADI and the environment.
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Concurrent Programs

Concurrent Programs

Financial Consolidation Hub leverages the concurrent manager for high volume and
background processes. The following details are on the concurrent programs used
within Financial Consolidation Hub:

Note: All Financial Consolidation Hub concurrent programs are
prefixed with "Financial Consolidation Hub: ".

Acquisition and Disposal Entry Import

The A&D Entry Import program is called automatically when a manual adjustment is
uploaded for an A&D transaction. You should not call this program manually using the
Submit Request window.

See: Manually Entering Acquisition and Disposal Entries, page 17-4

Acquisition and Disposal Trial Balance Import

The A&D Trial Balance Import program is called automatically when a trial balance is
uploaded for an A&D transaction. The concurrent program takes the data from the
spreadsheet and calls the Rules Processor to generate an elimination entry. You should
not call this program manually using the Submit Request window.

See: Calculating Acquisition and Disposal Entries, page 17-4

Consolidation Data Transfer

The Consolidation Data Transfer program is used to move data from FEM_BALANCES
to the data table specified in the Analytical Reporting Task in Foundation. This program
is called automatically if consolidation was run for the topmost node, and the Analytical
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Reporting step has been completed. You can run this program manually using the
Submit Request window for a specific consolidation hierarchy, period, and balance

type.
See: Task 12: Analytical Reporting, page 5-16

Consolidation Entries Write back

The Consolidation Entries Write back program is called automatically when uploading
an adjustment that was selected to be written back to Oracle GL. The consolidation
entry will be converted to the chart of accounts format and written to GL_INTERFACE.
You should not call this program manually using the Submit Request window.

See: Write back to General Ledger, page 16-6

Data Submission

The Data Submission program is launched during data submission for an entity and
performs differently depending on the entity's source system.

After the spreadsheet is loaded for an external entity, the program is launched. The
program then launches a FCH: Data Submission workflow. The workflow process will
take the data from GCS_BAL_INTERFACE_T and push it to FEM_BAL_INTERFACE_T
after performing the appropriate data checks and calculations. After completion of the
workflow, the core Foundation program is called to move the data from
FEM_BAL_INTERFACE_T to FEM_BALANCES. If the load is successful, calls are made
to check if any consolidation runs are impacted, update the data status, and run the
XML Generator concurrent program.

If the entity is an Oracle entity, the core Balances Rule Engine is called to move the data
from GL_BALANCES to FEM_BALANCES. If the load is successful, calls are made to
check if any consolidation runs are impacted, update the data status, and run the XML
Generator concurrent program.

For either scenario, this program can be called manually using the Submit Request
window.

See: Submitting Data, page 14-1

Dimension Hierarchy Loader

The Dimension Hierarchy Loader program is executed when a dimension hierarchy or
value set map is uploaded using the Foundation user interface. The data is taken from
the spreadsheet into the Enterprise Performance Foundation interface tables for loading
hierarchies. The Enterprise Performance Foundation program to move the hierarchies
from the interface tables to the core tables is then executed. You should not call this
program manually using the Submit Request window.

See: Task 7: Dimension Hierarchies, page 5-11

B-2 Oracle Financial Consolidation Hub User's Guide



See: Task 8: Value Set Maps, page 5-12

Dimension Transfer

The Analytical Reporting chapter mentions that if you need to report on the created by
object dimension, it must mapped to a user dimension in the Analytical Reporting Task
of Foundation. In this case, the Dimension Transfer program pushes the dimension
members from the created by object dimension to the user dimension. It is called
automatically by the Consolidation Data Transfer program. You should not call this
program manually using the Submit Request window.

See Task 12: Analytical Reporting, page 5-16

Hierarchy Initialization

The Hierarchy Initialization program is called after you create a new consolidation
hierarchy. The program initializes the data status for the hierarchy, and creates a copy
of the hierarchy from the Consolidation tables to the Enterprise Performance
Foundation tables to allow it to be used in our Analytical Reporting tool. You should
not call this program manually using the Submit Request window.

See: Setting Up Consolidation Hierarchies, page 13-2

Hierarchy Listing Report

The Hierarchy Listing Report program is available to generate a Hierarchy Listing
Report of a consolidation hierarchy as of a specific date. It is called automatically when
you click on the PDF or Excel icon for a hierarchy. You can call this program manually
using the Submit Request window.

See: Hierarchy Listing Report, page 18-5

Intercompany Matching Report

Load Entities

The Intercompany Matching Report can be launched from the Reporting user interface
or manually using Submit Request window. The report generates a PDF report of all the
intercompany transactions for a specific hierarchy, period, and entity. Optional
parameters can be specified for counter entity, rule, and whether or not only
transactions that exceed the threshold should be included.

See: Intercompany Matching Report, page 18-3

The Load Entities program is executed after a spreadsheet upload for entity creation is
successfully validated. After you upload a spreadsheet, and receive a confirmation
message that the spreadsheet upload was successful, monitor this concurrent request
prior to using the entities defined in the spreadsheet. You should not call this program
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manually using the Submit Request window.

See: Spreadsheet Loader, page 14-11

Maintain Entity Value Set

The Maintain Entity Value Set program takes entities defined in the Consolidation
Entity User Interface and propagates them back to the
FCH_ICM_ENTITY_VALUE_SET value set in the Oracle Application Object Library
(AOL). This program is called immediately after an entity or set of entities is created. It
will propagate all the entities: a) consolidation, b) elimination, and c) operating to the
value set. The value set can be leveraged in the FCH/ICM integration. You should not
call this program manually using the Submit Request window.

See: Setting Up Entities, page 6-1

Module Initialization

Financial Consolidation Hub has several code components, indices, and metadata that
are dynamically generated based off of the configuration of the system for optimal
performance. The Module Initialization program is called automatically when the
Consolidation Global Value Set Combination Task in Foundation is completed and
again when the Analytical Reporting Task in Foundation is completed. If you make any
changes in a non-standard manner, this program must be called manually to regenerate
the Financial Consolidation Hub packages and indices.

See: Task 5: Consolidation Global Value Set Combination, page 5-9
See: Task 12: Analytical Reporting, page 5-16

PDF Generation

The PDF Generation program is called using Oracle Workflow. The program is
launched whenever a notification requires a PDF attachment. For example, when an
intercompany suspense violation notification is sent, this program is launched to
generate a PDF version of the entry to be included in the e-mail attachment. You should
not call this program manually using the Submit Request window.

Publishing Utility
The Publishing Utility program is available to support asynchronous delivery of the
Data Submission and Consolidation Trial Balances. The program is launched
automatically when you try to access a trial balance that is larger than the max file size
specified in the XML Publisher Templates Task in Foundation, and will generate the
requested report. You cannot call this program manually using the Submit Request
window.

See: Task 11: XML Publisher Templates, page 5-15
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Set Internal Controls Manager Profile Option Values

The Set Internal Controls Manager Profile Option Values program is used to set key
profiles in Internal Controls Manager to facilitate the integration between the structures
in Financial Consolidation Hub and Internal Controls Manager. You must call this
program manually using the Submit Request window. It should be executed before you
start configuring Internal Controls Manager.

See : Integrating with Internal Controls Manager, page 22-1

Submit Consolidation

The Submit Consolidation program allows you to schedule the consolidation process
using the concurrent manager scheduler. You can run consolidation for a specific
hierarchy, consolidation entity, period, and balance type. The program is also launched
when you submit consolidation using the Consolidation Monitor user interface. The
consolidation process submits workflow processes which become dependent upon each
other. The consolidation entities are associated to a workflow named Financial
Consolidation Hub: Consolidation Entity and each operating entity is associated to a
workflow named Financial Consolidation Hub: Operating Entity. The Item key for each
of the workflows is the entity name followed by the request id in parenthesis.

See: Running Consolidations, page 15-1

Update Entity Organizations

The Update Entity Organizations program is called to assign the organization
dimension members correctly to an entity. Each entity is assigned company values in
the entity user interface. After you create or update an entity or set of entities, this
program is launched to determine which organizations are attributed with specific
company values and assigns them to the appropriate entities.

You can run this program manually if you are adding new organization members after
initial entity setup.

See: Selected User Interface Elements for Setting Up Entities, page 6-4

Value Set Map Validation

The Value Set Map Validation program generates the Value Set Map Validation Report
for entities that are based on a different chart of accounts from the consolidation chart of
accounts. This program can be launched by clicking on the PDF and Excel Icons
corresponding to the Value Set Map Validation Report from the Data Preparation status
screen in the Consolidation Monitor. It can also be launched manually using Submit
Request window for a specific entity and date.

See: Value Set Map Validation Report, page 18-6
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XML Generator

The XML Generator program is used to pre-generate the data submission and
consolidation trial balance in XML format for optimal performance to render the PDF or
Excel document. The program is immediately launched after Data Submission
completes, and whenever consolidation completes for a specific consolidation entity.
The program can be re-run for Data Submission by clicking on the Renegerate XML
button. You should not call this program manually using the Submit Request window.

For more information on data submission, see: Submitting Data, page 14-1.

For more information on running consolidation, see: Running Consolidations, page 15-1
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Business Events

Business Events

Financial Consolidation Hub leverages business events raised by General Ledger and
Enterprise Performance Foundation for inter-product communication and internally to
allow customers to subscribe to activities of interest during the consolidation close
process.

Financial Consolidation Hub Events
Pristine Data Loaded or Altered
oracle.apps.gcs.pristinedata.altered

The Prinstine Data Loaded or Altered Event is raised whenever data submission occurs
using the Data Submission concurrent program. Financial Consolidation Hub ships a
subscription to this event to check if any consolidation runs are impacted by the new or
incremental data load.

Consolidation Hierarchy Altered
oracle.apps.gcs.setup.hierarchy.update

The Hierarchy Altered event is raised whenever the consolidation hierarchy is updated.
Financial Consolidation Hub ships a subscription to this event to check if any
consolidation runs are impacted by an ownership, consolidation method, or translation
method change.

Historical Rates Created or Altered
oracle.apps.gcs.setup.historicalrates.update

The Historical Rates Altered event is raised whenever a new set of historical rates are
created or updated. Financial Consolidation Hub ships a subscription to this event to
check if any consolidation runs are impacted by a change in historical rates for a period
that has already been consolidated.
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Acquisition and Disposal Created or Altered
oracle.apps.gcs.transaction.acqdisp.update

The A&D Created or Altered event is raised whenever the rules engine automatically
generates an elimination entry or a manual elimination is created. Financial
Consolidation Hub ships a subscription to this event to check if any consolidation runs
are impacted by a new elimination entry.

Manual Adjustment Created or Altered
oracle.apps.gcs.transaction.adjustment.update

The Manual Adjustment Created or Altered event is raised whenever a manual
adjustment is uploaded. Financial Consolidation Hub ships a subscription attached to
this event to check if any consolidation runs are impacted by the uploaded adjustment.

General Ledger Events
Posting Completed
oracle.apps.gl.journals.journal.post

General Ledger raises this business event whenever a journal has been posted. Financial
Consolidation Hub subscribes to this event to support the functionality to track
whenever balances have changed in Oracle General Ledger that have not been
synchronized with the Enterprise Performance Foundation. This business event must be
enabled after installation as it is shipped disabled by default.

Daily Conversion Rates Specified
oracle.apps.gl.CurrencyConversionRates.dailyRate.specify

General Ledger raises this business event whenever daily rates are created or altered.
Financial Consolidation Hub subscribes to this event to support checking if any
translation entries are invalidated by the rate change. Thus business event must be
enabled after installation as it is shipped disabled by default.
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Profile Options

Profile Options

Financial Consolidation Hub leverages several profile options shipped by Enterprise
Performance Foundation, Enterprise Planning and Budgeting, and Application Object
Library. The profile options can be accessed using the System Administrator
responsibility, Profile > System.

Application Object Library Profile Options

For more detailed information on Application Object Library profile options, please
refer to the Oracle Applications System Administrator's Guide - Maintenance.

FND Function Validation Level

This option must be to set to None in order to support the drilldown capabilities within
Financial Consolidation Hub.

FND Validation Level

This option must be to set to None in order to support the drilldown capabilities within
Financial Consolidation Hub.

FND: Debug Log Enabled

If an error occurs in Financial Consolidation Hub and you need to send development
the debug log, you must set this profile option to Yes. It can be set at any level.

If the debugging is occurring on a back-end engine running on the concurrent manager
tier, you can do the following in your jserv.properties to minimize the performance
impact on your middle-tier:

wrapper.bin.parameters=-DAFLOG_ENABLED=false
FND: Debug Log Module

If an error occurs in Financial Consolidation Hub, ensure this profile is set to %.
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FND: Debug Log Level

If an error occurs in Financial Consolidation Hub and debugging must be performed,
this profile must be set to STATEMENT.

Enterprise Performance Foundation Profile Options

For more detailed information on Enterprise Performance Foundation profile options,
please refer to the Enterprise Performance Foundation User's Guide.

FEM: Signage Methodology

For Financial Consolidation Hub, the Signage Methodology must be set to Standard
General Accounting Principals. After the profile is set, you must run the concurrent
program named "Sign Extended Account Types."

FEM: Ledger

This profile dictates which value sets you can see in the Enterprise Performance
Foundation Administrator under Configuration Rules. You can also set this profile at
the user level using the Application Preferences option in the Enterprise Performance
Foundation user interface.

FEM: FEM Top

To run the Enterprise Performance Foundation Refresh Engine, this profile must map to
the location of the FEM_TOP. The Refresh Engine will delete all user created data in
both the Consolidation and Enterprise Performance Foundation Schemas.

Enterprise Planning and Budgeting Profile Options

For more detailed information on Enterprise Planning and Budgeting profile options,
please refer to the Enterprise Planning and Budgeting User's Guide.

ZPB: SQL Trace Level

The ZPB: SQL Trace Level is used to diagnose issues that occur when operating with
our Analytical Reporting tools. To run the process in debug mode, you should set the
profile as follows: 1: AWLOG:directory_alias/file_name.

The directory alias must be created in the database and map to a directory specified in
the utl_file_dir parameter.

Web-ADI Profile Options

For more detailed information on Web-AD], please refer to the Oracle Web
Applications Desktop Integrator User Guide.

BNE Server Log Level

If you are running into errors when attempting to upload the spreadsheet, this profile
should be set to Trace.
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BNE Server Log Filename

This is a free-form text value to enter the file name that contains the logging
information.

BNE Server Log Path

This must be a directory accessible from the Web Server tier. Ensure that the Apache
and Jserv processes have write permissions to this directory.
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